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Introduction 
This program directory is intended for the system programmer responsible for program installation and maintenance.  

It contains information concerning the material and procedures associated with the installation of VPM 1.5.  

You should read all of this program directory before installing the program and then keep it for future reference.  

Program Materials 

Basic Machine-Readable Material 

The distribution medium for this release is one CDROM per Operating System. The media contain all the programs and data needed for 
installation. It also includes online documentation. 
These distribution media are stacked media. Please keep these media for future use. You will have to use them if you order new products. 
See Installation Instructions for more information about how to install the program. 
The table below describes the media.  

Basic Material: 
Physical - External Label Identification 
CD-ROM - ENOVIAVPM Version 1 Release 5 for AIX 
CD-ROM - ENOVIAVPM Version 1 Release 5 for HP-UX 
CD-ROM - ENOVIAVPM Version 1 Release 5 for IRIX 
CD-ROM - ENOVIAVPM Version 1 Release 5 for SOLARIS  

Optional Machine-Readable Material 

PTF13 UPDATE
PTF14 UPDATE
PTF15 UPDATE
PTF16 UPDATE
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There are no optional machine-readable materials for ENOVIAVPM.  

Program Publications 

Note: On-line documentation is accessible from within or outside ENOVIAVPM. This provides quick access to documentation, without the 
need for large paper manuals. Two formats are available: Acrobat (PDF) and HTML.  

ENOVIAVPM online documentation can be accessed either from an interactive session or through direct use of a browser. The software 
prerequisites are the same as those required for an ENOVIAVPM interactive session. 
  

  

Accessing Online Documentation 

z Inside VPM: You just have to click on the " Help " Icon in the VPM Access panel. 
The documentation is available if a GA level configuration has been built.  

z Outside VPM: the documentation is located in $CATIA/vpm/doc where you will find the two formats are available: Acrobat (PDF) and 
HTML.  

Basic Program Publications 

The following online documentation provided with the code, in both Acrobat (PDF) and html formats have been updated by this Release: 

z ENOVIAVPM User Guide  
z ENOVIAVPM Installation and Administration Guide  
z ENOVIAVPM Generative Technical Publications User Guide  
z ENOVIAVPM PM Interoperability User Guide  
z ENOVIAVPM SAP Interoperability User Guide.  

WARNING! The online documentation is the best so far level, and serves as the only reference for problem reporting.  

DOCUMENTATION CD SK21-0292-04
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Optional Program Publications 

There are no optional publications for ENOVIAVPM.  

Microfiche Support 

There is no microfiche for ENOVIAVPM.  

Publications Useful During Installation 

z ENOVIAVPM Installation and Administration Guide  
z CATIA Solutions Installation Guide UNIX Workstation (SH52-1189)  
z CATIA Solutions Software Administration Guide UNIX Workstation (SH52-0601)  

The reader should also have some knowledge of the basic UNIX file environment and at least one editor.  

Documentation List 

The following online documentation provided with the code, in both Acrobat (PDF) and html formats have been updated by this Release:  

z ENOVIAVPM User Guide  
z ENOVIAVPM Installation and Administration Guide  
z ENOVIAVPM Generative Technical Publications User Guide  
z ENOVIAVPM PM Interoperability User Guide  
z ENOVIAVPM SAP Interoperability User Guide.  

WARNING! The online documentation is the best so far level, and serves as the only reference for problem reporting.  

Program Support 
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The code for ENOVIAVPM Version 1 Release 5 will be maintained as follows:   

Problem Reporting 

Customers should report defects through their standard support structures who will then open PMRs in RETAIN using the standard 
procedures (including the relevant ENOVIAVPM V1R3 COMPID). These PMRs will be processed by the L1/L2/L3 organizations and APARs 
will be opened for valid defects.  

RETAIN Call Priority is assigned by the support organization raising the call. Priority assigned to a call cannot be higher than the PMR 
severity.  

APARs 

An APAR will be created for valid defects after the IBM General Availability.  

Preventive Service 

Preventive Service will be available via Modification Levels distributed by the IBM Program Distribution channel. 
It is highly recommended to apply the refresh levels released in order to stay current.  

Corrective Service 

Fixes for valid showstoppers can be provided upon request by PTFs (Program Temporary Fix) available through the standard 

Operating System Compid VRM FESN

AIX 5691-01900 1.5.0 0905495

HP-UX 5691-02900 1.5.0 0905496

SGI 5691-03900 1.5.0 0905497

SOLARIS 5691-04900 1.5.0 0905498
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IBM/RETAIN and Corrective Service Distribution processes.  

A showstopper is:  

z A problem blocking production: this means that the customer is already using the level on which he requests a PTF in production 
environment  

z a problem preventing migration: in this case, we must know what the migration plan is and check if the switch date is prior to the 
next refresh availability  

z a problem blocking tests on a given level: in this case, maybe a development load can fix the situation and allow the customer to 
continue the tests  

z Installation problem: a problem which prevents the customer from installing or using a CATIA product  
z Regression: Quite often, what is seen as a regression by a customer is in fact due to an operation which could either be performed 

erroneously or create incorrect data with a previous level and has been fixed.  

In any case, valid defects are fixed in the refresh level that is current for development in the change team.  

  

VPM Prerequisites 
There are several levels of prerequisites that are necessary before you install the product.  

VPM runs on UNIX workstations. There are four different parameters, the combination of which define the possible configurations:  

z supported hardware  
z supported operating system levels  
z recommended software levels  
z supported relational databases.  

Supported Operating System and Database Levels 
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Operating 
System

OS Runtime 
Levels 

DB2 
Server/Client 

Oracle 
Server/Client 

IBM AIX AIX 4.3.3 z from 6.1 FP4  
z 7.2 recommended  

z from 8.0.6  
z VPM Multisite: from 8.1.6  

HP-UX

z 10.20 ACE 4 
z 10.20 ACE 5 

z from 6.1 FP4  
z 7 not supported 1  

z from 8.0.6  
z Oracle 8.i not supported 2  

z VPM Multisite: not supported 

11.0
z from 6.1 FP4  
z 7 not supported 3  

z from 8.0.6  
z VPM Multisite: from 8.1.6  

SGI IRIX from IRIX 6.5.2m z Server: N/A  
z Client: from 6.1 FP4 

z from 8.0.6  
z Oracle 8.i not supported 4  

z VPM Multisite: not supported 

SUN Solaris
z Solaris 2.6  
z Solaris 7  
z Solaris 8 5  

z from 6.1 FP4  
z 7.2 recommended  

z from 8.0.6  
z VPM Multisite: from 8.1.6  

Key
1 =DB2 V7 with HP 10.20 is not supported.
2 =Oracle 8i with HP 10.20 is not supported.
3 =DB2V7 with HP 11 is not yet supported by Dassault Systemes 

(ENOVIAVPM technical constraint). Only DB2V6 with HP 11 is 
supported. However, a DB2V6 client HP11 can access a DB2V7 
server (AIX, SUN). To use the DB2V7 server with HP11, it is therefore 
mandatory to access a DB2V7 server from a DB2V6 client HP 11. This 
is a temporary restriction. To manage an ENOVIAVPM installation with 
HP 11 and HP 10.20, check the specific procedure.

4 =Oracle 8i is not supported by IRIX for ENOVIAVPM.

Solaris 8 is supported by ENOVIAVPM with a temporary procedure. 
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Also note that:  

z ORACLE 8i is a prerequisite for VPM multisite use on any UNIX platform. Multisite is not supported on IRIX.   
z Oracle 9i is not yet supported by ENOVIAVPM 1.5  
z 64 bit is not yet supported by ENOVIAVPM 1.5  

VPM on AIX Solutions 

Hardware Requirements 

Processor Requirements 

ENOVIAVPM 1.5 may be used on any IBM RS/6000 supported under AIX Version 4.3.3 or 5.1 provided that the following requirements are 
met.  

Required Processor Components and Features 

z Real Memory 
A minimum of 256MB of real memory are required.  

z CD-ROM drive for program installation 
Installation of ENOVIAVPM Release 5 for IBM RS/6000 requires an internal or external CD-ROM drive. This drive requires a SCSI 
High-Performance Input/Output (I/O) Controller, which is either standard or an optional feature (depending on the RS/6000 model). 
A CD-ROM drive is required to view the on-line documentation in HTML format. 
Product documentation explains installation on other network-connected RS/6000 machines after the initial installation with the drive. 

z Direct Access Storage 
ENOVIAVPM Release 5 licensed programs and configurations, user data and user programs may be stored on any internal or 
external Direct Access Storage Devices (DASD) supported by the RS/6000.  

z The following DASD requirements are approximate: 
{ All installed products of ENOVIAVPM Release 5: 700MB + usage environment.  
{ Minimum Paging Space: 256MB.  

Optional Components and Features 

5 =This procedure is explained below, in Solaris 8 Support for VPM / 
CATIAV4 / CATIAV5.
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Configuration Requirements 

(*) For installation only  

Required Processor Components and Features 

Graphics Devices (one of the following):  

z POWER GXT150, GXT150L, GXT150M and GXT150P (feature number 2767, 2660, 2650 and 2648)  
z POWER GXT250P and GXT255P (feature numbers 2851 and 2852) For a better graphic performance level on GXT255P, the use of 

AIX mode "ONLY8BIT=TRUE" is recommended.  
z POWER GXT500 and GXT500D (feature numbers 2644 and 2646)  
z POWER GXT500P 12-Bit and GXT550P 24-Bit (feature numbers 2854 and 2855)  
z POWER GXT800P 24-Bit and GXT800M 24-Bit (feature number 2853 or 2859 and 2850)  
z POWER GXT1000 Model 001 or 002 (machine type 7250-001 or 7250-002)  
z POWER GXT2000P  
z POWER GXT3000P (feature number 2825)  
z POWER GXT4000P  
z POWER GXT6000P. 

Note: Other adapters are not supported by ENOVIAVPM Release 5. Although this product might run with other adapters, incidents 
encountered which are specific to other adapters will not be accepted for analysis or correction.  

Peripheral Requirements 

Required Components and Features:  

z Three-button mouse (feature number 6041)  

RS/6000 Required
Graphics device adapter Required
Color graphics display Required
Keyboard Required
3-button mouse Required
CD-ROM drive Required*
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z An alphanumeric keyboard  
z Display: 

One display compatible with the graphics devices listed above (for example, an IBM 6091 19-inch color display).  

Software Requirements 

AIX Version 4 Release 3.3, or Release 5 Version 1 with:  

z C Set ++ for AIX Application Runtime: 
{ at minimum level 4.0.2 for AIX 4.3.3 (xlC.rte 5.0.2.4, 5.0.2.5 and 5.0.2.6 are not supported) with IBM C and C++ for AIX 

compilers and associated corequisites; note that C and C++ for AIX compilers 3.6 (no runtime update) and 5.0.2 (runtime 
update at level 5.0.2x) are interoperable with the above runtime environments. Install the proper PTF if the runtime level is 
5.0.2.4, 5.0.2.5 or 5.0.2.6 .  

{ at minimum level 5.0.2 for AIX 5.1 (xlC.rte 5.0.2.4, 5.0.2.5 and 5.0.2.6 are not supported) with IBM C and C++ for AIX 
compilers and associated corequisites; note that C and C++ for the AIX compiler 5.0.2.x. are interoperable with the above 
runtime environments. Install the proper PTF if the runtime level is 5.0.2.4, 5.0.2.5 or 5.0.2.6 .  

z IBM XL Fortran Runtime Environment (xlfrte): 
{ for AIX 4.3.3: xlfrte level 5.1.0, 5.1.1 (5765-C11 or 5801-AAR-7070, Part No. 04L2123, depending on the geographic area), or 

7.1.0 (5765-E03) and associated co-requisites  
{ for AIX 5.1: xlfrte level 7.1.0 (5765-E03) and associated co-requisites  

z Common Desktop Environment (CDE, delivered with the Operating System)  
z IBM PEX and PHIGS, Open GL and GL 3.2 (delivered with the Operating System)  
z FrameMaker 5.1  

Notes:  

z Refer to RETAIN (R) for the appropriate PTF to be applied.  
z For installation purposes, the following compilers are required: 

{ FORTRAN: XL FORTRAN Compiler Version 5.1.0 (5765-C10 or 5801-AAR-7069, Part No. 04L2110 depending on the 
geographic area), Version 5.1.1, or Version 7.1.0 (5765-E02)  

{ C/C++: IBM C and C++ for AIX Compiler Version 3.6.4 or Version 3.6.6. C++ Compiler 3.6 is shipped as the batch compiler 
with VisualAge C++ Professional for AIX V4 (5765-D52 or part number 30L8178, product 5765-D52 feature 0001, depending 
on the geographic area)  

{ for AIX V5.1: XL FORTRAN Compiler Version 7.1.0 (5765-E02)  
{ for AIX V5.1 : C/C++: IBM C and C++ for AIX Compiler Version 5.0.2. Install the proper PTF if the runtime level is 5.0.2.4, 

Page 14 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



5.0.2.5 or 5.0.2.6 .  

With the following PTF requirements when applicable:  

z AIX 4.3.3 (includes graPHIGS, OpenGL and GL3.2 for AIX runtime), with: 
{ CSet++ for AIX Application Runtime, at level 4.0.2 (delivered with the operating system)  
{ IBM C and C++ for AIX Compilers at level 3.6.4 or 3.6.6, when C or C++ compilers are required  
{ XL Fortran Runtime Environment (xlfrte), at level 5.1.0 or 5.1.1 (for US: part number 04L2123 or product 5801-AAR feature 

7070; please contact your IBM representative for part number identification in other geographical areas), or at level 7.1.0 
(5765-E03, with PTF for APAR IY16351), and associated corequisites when XL Fortran development environment is required  

{ PTF delivered for APAR IY08270  
{ PTF delivered for APAR IY13940 (may be obtained by the RS/6000 Operating Environment for CATIA, V2.3.1 (5765-E52) 

AIX/CATIA installation tool since it is included in this product)  
{ PTF for APAR IY14697  
{ PTF for APAR IY16115  

WARNING! With Release 5, ENOVIAVPM no longer supports Release 3.0 or 3.1 of AIX Version 4.  

Supported Relational Databases 

z IBM DB/2 Version 6.1 FP4, Version 7.2  
z Oracle Server Version 8.0.4, 8.0.5, 8.0.6, 8.1.5, 8.1.6, 8.1.7  

Multisite support using Oracle requires use of Oracle 8.1.6.  

VPM on Hewlett-Packard Solutions 

Hardware Requirements 

Processor Requirements 

Any HP9000 Series 700 including B-Class, C-Class or J-Class workstations, supported under HP-UX 10.20 A.C.E. 4 (June 99) or 10.20 
A.C.E.5 (December 99) or 11 A.C.E. (November 99), provided that the following requirements are met. 
Note: Because of binary differences between HP-UX 10.20 and HP-UX 11.0, support of HP-UX 11.0 is limited to a strict runtime 
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environment. Operations that involve compiling and linking objects should be conducted on HP-UX 10.20 and copied on HP-UX 11.0 
systems for execution.  

Required processor components and features 

z Real Memory 
A minimum of 256MB of real memory is required.  

z An internal or external CD-ROM drive is required for program installation. 
This equipment is required to perform an initial installation. Product documentation explains installation on other network-connected 
HP workstations after the initial installation with the drive. 
A CD-ROM drive is required to view the on-line documentation in HTML format.  

z Disk space 
ENOVIAVPM Release 5 licensed programs and configurations, user data and user programs may be stored on any internal or 
external disk by the HP workstation. 
Approximate disk space requirements are as follows: 

{ All installed products of ENOVIAVPM Release 5: 700MB + usage environment.  
{ Minimum Swap Space: 256 MB.  

Configuration Requirements 

(*) For installation only  

Required processor components and features 

Graphics cards  

z VISUALIZE 8  

HP Workstation Processor Required
Graphics card Required
Color graphics display Required
Keyboard Required
3-button mouse Required
CD-ROM Required*
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z VISUALIZE 24  
z VISUALIZE 48  
z VISUALIZE 48XP  
z VISUALIZE FXE  
z VISUALIZE FX2  
z VISUALIZE FX4  
z VISUALIZE FX5  
z VISUALIZE FX6  
z VISUALIZE FX10  

Peripheral Requirements 

Two types of connectors can be used for a peripheral component:  

z HP-HIL connector  
z Serial connector.  

Required Components and Features:  

z Three-button mouse (A2839B or A2838A)  
z An alphanumeric keyboard.  
z One display compatible with the graphics cards listed above.  

Software Requirements 

HP-UX 10.20 ACE 4 (*), with following required products:  

z HP-UX 10.20 A.C.E. 4, (June 99), HP-UX 10.20 A.C.E.5, (December 99) or HP-UX 11.0 A.C.E. (November 99)  
z HP-PEX and HP-PHIGS Runtime Environment (delivered with the Operating System)  
z Fortran Runtime (delivered and installed with the Core Operating System)  
z ANSI C++ (aC++) Runtime Environment at minimum level 1.21 (delivered with the Operating System)  
z Common Desktop Environment (CDE)  
z X11R6 / Motif1.2_R6 Runtime Environment  
z Powershade (included with HP-UX when the Graphics Adapter is ordered).  
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CATIA 4D Navigator and CATIA Assembly Modeling also require the OpenGL 3D Graphics Runtime environment(**).  

Notes:  

z (*) HP 10.20 ACE is delivered by the bundle B6193DA .  
z (**) OpenGL 1.1 is delivered by the bundle B619AA_APZ  
z For installation purposes, the following compilers are required: 

{ FORTRAN: HP-UX FORTRAN/9000 (B3907AA)  
{ C: HP-UX C/ANSI C (B3899BA)  
{ C++: HP-UX ANSI C++, Version 1.21 (aC++, B3911DB)  

Note: Because of binary differences between HP-UX 10.20 and HP-UX 11.0, support of HP-UX 11.0 is limited to a strict runtime 
environment. Operations that involve compiling and linking 
objects should be conducted on HP-UX 10.20 and copied on HP-UX 11.0 systems for execution.  

With the following PTF requirements when applicable:  

z HP-UX 10.20 A.C.E. 4 (June 1999), plus following patches 
{ PHSS_15731 HP DCE/9000 1.5 cumulative patch  
{ PHSS_17159 Xserver cumulative patch  
{ PHSS_17160 3D Common Runtime patch  
{ PHSS_17161 PEX5/Starbase/Hardcopy runtime patch  
{ PHSS_17164 PHIGS Runtime Patch  
{ PHSS_17166 OpenGL 1.1 Runtime patch  
{ PHSS_17225 dld.sl(5) cumulative patch  
{ PHSS_17872 HP aC++ Runtime libraries (aCC A.01.21)  
{ PHSS_18012 X/Motif Runtime Apr99 Cumulative  

z HP-UX 10.20 A.C.E. 5 (December, 1999), plus following patches 
{ Workstation Quality Pack for HP-UX 10.20 (December 1999)  
{ PHSS_19269 Xserver cumulative patch  
{ PHSS_20278 3D Common runtime patch  
{ PHSS_20279 PEX5/Starbase/Hardcopy runtime patch  
{ PHSS_20282 PHIGS Runtime  
{ PHSS_20284 OpenGL runtime patch, when needed  

z On HP-UX 10.20 ACE 4 or 10.20 ACE 5, Visualize-FX5 and FX10 graphic adapters require the following patches:  
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{ PHSS_21453 3D Common runtime patch  
{ PHSS_21454 PEX 5.1/Starbase/Hardcopy runtime patch  
{ PHSS_21457 PHIGS Runtime patch  
{ PHSS_21459 OpenGL 1.1 Runtime patch  
{ PHSS_21461 Xserver cumulative patch  

z HP-UX 11.ACE (Additional Core Enhancements, November 1999), with: 
{ QPK1100 0600: Quality Pack for HP-UX 11.00 (June 2000)  
{ PHCO_22035: sysdef/ioctl patch  
{ PHSS_21462: 3D Common Runtime Patch  
{ PHSS_21463: PEX5.1/Starbase/Hardcopy Runtime Patch  
{ PHSS_21464: DDA Runtime Patch  
{ PHSS_21465: PEX5.1 Runtime Patch  
{ PHSS_21468: PHIGS Runtime Patch  
{ PHSS_21470: OpenGL 1.1 Runtime Patch  
{ PHSS_21472: Xserver Cumulative Patch  
{ PHSS_22320: CDE patch  

Supported Relational Databases 

z IBM DB/2 Version 6.1 FP4, Version 7.2  
z Oracle Server Version 8.0.4, 8.0.5, 8.0.6 (HP-UX 10.20), 8.1.6, 8.1.7 (HP-UX 11)  

Multisite support using Oracle requires use of Oracle 8.1.6.  

VPM on SGI Solutions 

Hardware Requirements 

Processor Requirements 

Any O2, Indigo2, Octane, Octane2, Onyx or Onyx2 workstations based on any R4000, R4400, R4600, R5000, R8000, R10000 and 
R12000 processor supported under IRIX 6.5, provided that the requirements described below are met.  

Required Processor Components and Features 

Page 19 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



z Real Memory 
A minimum of 256MB of real memory is required.  

z An internal or external CD-ROM drive is required for program installation. 
This equipment is required to perform an initial installation; product documentation explains installation on other network-connected 
SGI workstations after the initial installation with the drive. 
A CD-ROM drive is required to view the on-line documentation in HTML format.  

z Disk space 
ENOVIAVPM Release 5 licensed programs and configurations, user data and user programs may be stored on any internal or 
external disk by the SGI workstation.  

z Approximate disk space requirements are as follows: 
{ All installed products of ENOVIAVPM Release 5 Solutions: 700MB + usage environment.  
{ Minimum Swap Space: 256 MB.  

Configuration Requirements 

(*) For installation only  

Required processor components and features 

Graphics device adapter (one of the following):  

z XZ  
z Extreme  
z Integrated graphic adapter on O2 workstations  
z Solid Impact or SI/SE  
z High Impact  
z Super Solid Impact or SSI/SSE  

SGI Workstation Processor Required
Graphics card Required
Color graphics display Required
Keyboard Required
3-button mouse Required
CD-ROM Drive Required*
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z Maximum Impact or MXI/MXE  
z VPro V6  
z VPro V8  
z RE (Reality Engine)  
z RE2 (Reality Engine)  
z InfiniteReality  

Peripheral Requirements 

Required Components and Features:  

z SGI three-button mouse  
z an alphanumeric keyboard  
z one display compatible with the listed graphics cards.  

Software Requirements 

z IRIX 6.5.2m  
z IRIX Interactive Desktop (delivered with the operating system)  

Notes:  

z IRIX system software delivers the C++ Runtime and Fortran Runtime required by ENOVIAVPM Version 1 Release 5.  
z Refer to RETAIN (R) or the ENOVIAVPM Version 1 Release 5 Program Directory for the appropriate PTF to be applied.  
z For installation purposes, the following compilers are required: 

{ FORTRAN 77  
{ C/C++  
{ SGI MIPSpro Compilers Version 7.2.1 (ABI o32 is the only supported ABI) 

� Fortran 77  
� C/C++  

With the following PTF requirements when applicable:  

z IRIX 6.5.2m plus the following patches 
{ C, C++ and Fortran runtime environments, at level 7.2.1, are delivered with the operating system  
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{ patch 3458 rld rollup  

z Octane2 with VPro graphics V6 and V8 are supported with IRIX 6.5.8m plus following patch:  
{ patch 4010 Octane2 VPro documentation and bug fixes for IRIX 6.5.8m  

z Octane2 with VPro graphics V8 and V10 are supported with IRIX 6.5.10m plus following patch:  
{ patch 4130 Octane2 VPro bug fixes for 6.5.10m  

z Onyx3000 with Infinite Reality 3 are supported with IRIX 6.5.10m plus following patches:  
{ patch 4158 Origin3000 fixes for 6.5.10m  
{ patch 4135 Onyx3000 - 6.5.10 graphics crash fixes  

Supported Relational Databases 

z IBM DB/2 Version 6.1 FP4  
z Oracle Server Version 8.0.4, 8.0.5, 8.0.6  

Multisite support is not available in the SGI Oracle environment.  

VPM on SUN Microsystems Solutions 

Supported Hardware Requirements 

Processor Requirements 

Any SparcStation 20 Model 71, Ultra1, Ultra2, Ultra10, Ultra30, Ultra60 or SUN Blade 1000 workstation based on UltraSPARC processor, 
supported under Solaris 2.6.0., Solaris 7 or Solaris 8, provided that requirements described below are met.  

Required processor components and features 

z Real Memory 
A minimum of 256MB of real memory is required.  

z A CD-ROM drive is required for program installation; this drive must be compatible with the following SUN models: 
{ For UltraSPARC Creator3D workstations, internal CD ROM (ref X6153A) or external CD ROM (ref X6151A)  
{ For Sparc Station 20, internal CD ROM (ref X578A) or external CD ROM (ref X6152A). 

Page 22 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



Product documentation explains installation on other network-connected SUN machines after the initial installation with CD 
drive. 
A CD-ROM drive is required to view the on-line documentation in HTML format.  

z Disk space: 
ENOVIAVPM Release 5 licensed programs and configurations, user data and user programs may be stored on any internal or 
external disk by the SUN machines. 
Approximate disk space requirements are as follows: 

{ All installed products of ENOVIAVPM Version 1 Release 5 solutions: 700MB + usage environment. 
Please refer to the Program Directory to estimate disk space requirements for specific products and configurations.  

{ Minimum Swap Space: 256MB.  

Configuration Requirements 

(*) For installation only  

Required processor components and features 

Graphic device adapter (one of the following):  

z ZX  
z Creator3D  
z Creator Series III  
z Elite3D for Ultra10 440 Mhz, Ultra60 or SUN Blade 1000 workstations  
z Expert3D.  

Peripheral Requirements 

SUN workstation Required
Graphics card Required
Color graphics display Required
Keyboard Required
3-button mouse Required
CD-ROM drive Required*
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z SUN three-button mouse  
z an alphanumeric keyboard  
z one display compatible with the graphics card listed above.  

Compatibility 

ENOVIAVPM provides a consistent user interface, database and application programming interfaces. Data is compatible among the 
supported operating systems: AIX, HP-UX, IRIX, and Solaris, and ENOVIAVPM is able to use and exchange data in industry-standard 
formats including STEP AP203, PDM SCHEMA and AP214.  

Performance Considerations 

Performance and response time are influenced by several factors including processor and operating system, amount of system memory, 
channel speeds, the number, type, and organization of terminals, and the size of the data elements being used. ENOVIAVPM is designed 
for optimum benefit under all supported operating systems.  

Software Requirements 

z Solaris 2.6.0, Solaris 7 or Solaris 8  
z CDE 1.2 (Common Desktop Environment)  
z Fortran 4.2 runtime required by ENOVIAVPM is delivered with ENOVIAVPM  
z OpenGL  

Notes:  

z For installation purposes, the following compilers are required: 
{ SUN Workshop Compilers Version 4.2 

� FORTRAN  
� C/C++  

z Refer to RETAIN ® for the appropriate PTF to be applied.  

With the following PTF requirements when applicable:  

z Solaris 2.6.0, Solaris 7 and Solaris 8 (includes C and C++ runtime environments; Fortran runtime environment is delivered with 
CATIA), with OpenGL 1.2.1 and following recommended packages and patches. 
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{ Recommended packages 
� SUNWlibC SPARCompilers Bundled libC  
� SUNWglrt OpenGL for Solaris Runtime Libraries  
� SUNWbtool CCS tools bundled with SunOS  
� SUNWxwoft X Window system optional fonts  

{ Solaris 2.6 Recommended patches  
� 105181-23 Patch Kernel Update  
� 105210-27, 105926-01 and 105720-03 : required patches to share data between SUN and SGI Workstations  
� 105284-36 Runtime Motif 1.2.7  
� 105568-17 Libthread patch  
� 105633-48 Xsun patch  
� 105669-10 CDE 1.2  
� 105591-09 Shared Library patch for C++  
� 106029-01 Solaris 2.6 make  
� 106040-15 X Input & Output Method patch  
� 106125-09 Patch for patchadd and patchrm  
� 106179-01 ja_JP.PCK locale support (Japanese environment only)  
� 106841-01 euro support  
� 106842-09 euro support  
� 107733-08 Linker patch  
� 108091-03 JDK 1.2 with ISO8859-01 Locales  
� 109543-08 OpenGL 1.2.1  
� Creator 3D graphic adapters: 

� 105360-10 FFB Graphics patches  
� 105361-05 VIS/XIL Graphics patches  

� Elite 3D graphic adapters: 
� 105361-11 VIS/XIL Graphics patches  
� 105363-24 AFB Graphics patches  

� Expert3D graphics adapter: 
� 108788-07 Expert3D driver patch for Solaris 2.6  

� Y2K patches: 
� 105464-02 Multiple xterm fixes  
� 105621-19 libbsm and cron patch  
� 105800-05 /usr/bin/admintool y2000 patch  
� 106193-03 y2000 sysid unzip patch  
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� 106828-01 /usr/bin/date patch  

{ Solaris 7 recommended patches:  
� 106327-08 Shared Library patch for C++  
� 106541-11 Kernel update patch  
� 106950-09 Linker patch  
� 106980-11 Libthread patch  
� 107081-20 Runtime Library patch for Solaris 7  
� 107544-03 fsck patch  
� 107607-01 Motif 2.1 patch  
� 107636-03 X Input & Output Method patch  
� 108376-07 Xsun patch  
� 109104-02 sockfs patch  
� 109543-08 OpenGL 1.2.1 patch  
� Creator3D graphic adapters: 

� 106145-09 FFB Graphics Patch  
� 106148-04 XFB Graphics Patch  
� 107351-01 XGL patch  

� Elite3D graphic adapters: 
� 106144-20 Elite3D Graphics Patch  
� 106148-12 XFB Graphics Patch  
� 106147-06 VIS/XIL Graphics patch  

� Expert3D graphics adapter: 
� 108787-07 Expert3D driver patch for Solaris 7  

{ Solaris 8 recommended patches:  
� 108652-06 Xsun patch  
� 108940-07 Motif 2.1.1 patch  
� 109543-11 OpenGL 1.2.1 patch  
� Expert3D and Expert3D Lite graphics adapters: 

� 108576-13 Expert3D driver patch for Solaris 8  

Note: The Elite3D M3 graphic adapter is not supported on Ultra10 except on Ultra10/440 MHz. This last-mentioned configuration requires 
Solaris 2.6 5/98 as the minimum OS level, with the same recommended patches as listed above, when applicable.  

Solaris 8 Support for VPM / CATIAV4 / CATIAV5 
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WARNING! The installation path of the compiler MUST be /opt/SUNWspro  

During VPMInstall.sh -db2 or -oracle the following is done:  

The FORTRAN library libF77.so.4 is copied to $CAT_CUST/code/steplib/SunOS:  

cp /opt/SUNWspro/lib/libF77.so.4 $CAT_CUST/code/steplib/SunOS  
cd $CAT_CUST/code/steplib/SunOS  
ln -s libF77.so.4 libF77.so.3  

The VPM environment points to the right FORTRAN library. 
Before running VPMInstall.sh -nocheck, type the command:  

catpath LD_LIBRARY_PATH libF77.so.3 

This command should return $CAT_CUST/code/steplib/SunOS .  

Supported Relational Databases 

A relational database is required for the proper operation of ENOVIAVPM Release 5. A minimum of 700MB of hard disk space is necessary 
for system installation. 150 MB should be available 
for database application and data files. Refer to the section on Software Requirements for supported database products.  

z IBM DB/2 Version 6.1 FP4, Version 7.2  
z Oracle Server Version 8.0.4, 8.0.5, 8.0.6, 8.1.5, 8.1.6, 8.1.7  

Multisite support using Oracle requires use of Oracle 8.1.6.  

User and File System Prerequisites 

To perform all the following operations, the system administrator must have root authority.  

z A UNIX system administrator must create a file system on which to unload the VPM product (the file system must be dedicated to 
VPM). This file system must be cataloged on an NFS server or exported. The minimum size of this file system must be 365 
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megabytes (unload and configuration). A minimum of 22 Mega-Bytes is also required for the vpmadm administrator.  
z A system administrator must install a CD ROM device, export the mount point of the CDROMPath and verify that the /cdrom 

directory is mounted  
z If you want to install Technical-Publishing (TechPub),  a UNIX system administrator must create a file system dedicated to TechPub. 

This file must be mounted on all client machines which will use TechPub. The system administrator must also create a directory 
having read+write+execute privileges for himself and all users. The path to this directory is the unique parameter required for the 
TechPub installation.  

Licensing Prerequisites 

You must set the VPM License to perform VPM Installation.  

There are two licensing modes:  

z named licensing (previous to 1.4)  
z concurrent licensing (starting with 1.4)  

Named Licensing 

This is a role-based license mechanism. When you start ENOVIAVPM, an Infrastructure Product license is taken until you identify yourself 
and choose a role (through the VPM login panel). As soon as this is done, the system will take as many licenses as attached to the roles. 
As an example, if you get a role based on Engineer Solution, and one based on Generative Technical Publication Solution, the system will 
require three licenses: VPM, VTP, VP0. The sequence will be: a VPM Infrastructure Product license taken when launching VPM; VPx, 
VPy taken after identification of the roles.  

CodeName
VP0 ENOVIAVPM Engineer Product
VP1 ENOVIAVPM Manager Product
VP2 ENOVIAVPM Casual User Product
VP3 ENOVIAVPM Administration Product
VP4 ENOVIAVPM PDM Integration
VP5 ENOVIAVPM Product Engineer Solution
VP6 ENOVIAVPM SAP Interoperability Solution
CDE ENOVIAVPM CDM Engineer Solution
VTP ENOVIAVPM Generative Technical Publications Product

Page 28 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



Important 
As of VPM 1.4, all new users must use "concurrent" licensing described below. Users of VPM versions prior to 1.4, i.e. those who used 
"named" licensing prior to VPM 1.4 will continue to be supported.  

Concurrent Licensing 

This is a role-based license mechanism and is the only licensing available for all new users as of VPM 1.4.  

You must first do the following export in post-installation:  

export CATVpmLicenceType=CONCURRENT  

When you start ENOVIAVPM, an Infrastructure Product license is taken until you identify yourself and choose a role (through the VPM login 
panel). As soon as this is done, the system will take only those licenses attached to the selected role.  

For VPM and CATIA V5 only: 

z Licenses such as COM, CDR, etc. are not required.  
z The declaration parameter catcdma.VPM.CATIA_MODELS.MNGT must be set to INTERNAL.  

For VPM and CATIA V4 (with CATIA V5 or not): 

z Licenses such as COM, CDR and CDA are required.  
z The declaration parameter catcdma.VPM.CATIA_MODELS.MNGT must be set to BATCH. 

Remember that parts cannot be created in BATCH mode without CATIA V4 and the appropriate licenses.  

CodeName
CDX ENOVIAVPM CDM Engineer Configuration
DEX ENOVIAVPM Engineer Configuration
MSX ENOVIAVPM Manager Configuration
REX ENOVIAVPM Casual User Configuration
ADX ENOVIAVPM Administrator Configuration
VPX ENOVIAVPM Product Engineer Configuration
VSX ENOVIAVPM SAP Interoperability Configuration
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For more information about licensing, see the Planning & Administration Guide for CATIA V4 products.  

Database Prerequisites 

For all database vendors: You have to provide for 150 megabytes for the VPM tablespace datafiles.  

Prerequisites for Oracle Databases 

Before launching the VPM installation process on Oracle the following operations must be performed:  

1. The database administrator must have access to the Net8, SQLPLUS and Pro*C products. The VPM installation will use this 
product during processing.  

2. Verify that the library named "libclntsh" is created (if it does not exist, you must build it). This library can be invoked from a VPM 
process, so it must be known in the current environment.  

3. Verify that the database and the listener are started.  

For more information about Oracle administration, see the Oracle8 Server Administrator’s Guide.  

Prerequisites for a DB2 Database (Universal Database) 

The administrator must be sure that the DB2 SDK product or ADT (Application Development Tool) is installed because it is used at 
VPM installation time.  

1. Create the file system XXX in which the VPM database will be created.  
2. Under the Unix DB2 manager account, type the db2 command to obtain the prompt db2>.  
3. Create VPM database as follows: 

{ "create database VPM on XXX_filesystem"  
4. Verify that the VPM database is cataloged as follows: 

{ "list database directory". A list appears with all cataloged databases.  
5. Verify the connect as follows: 

{ "connect to VPM". The database will be connected if the creation has terminated successfully in the above step.  
6. Verify that the library "libdb2" is created. This library can be invoked from a VPM process so it must be known on the current 

environment.  

For more information about DB2 administration, see the IBM Universal Database Administration Guide for Common Servers, Version 5.  
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VPM Authentication Modes 

Authentication is the operation of verifying whether a user is indeed the person he or she claims to be, based on their user name and 
password. Every time users try to connect to a local or remote database, they are authenticated.  

VPM allows two authentication modes:  

z Client Authentication: This relies on the UNIX Operating System authentication mechanism.  
z Server Authentication: The user identifies him or herself by means of a VPM userid/password window.  

If you use a DB2 database, your users must be defined as UNIX users.  

Database Customization Related to a VPM Authentication Mode 

You may have to customize the database configuration in order to enable each authentication mode.  

Customization for the ORACLE Database 

Client Authentication 

You must customize the initXXX.ora file (where XXX is the ORACLE_SID value).  

To do this, the Database Administrator should do the following as the ORACLE user:  

In the file initXXX.ora associated with the ORACLE instance dedicated to VPM, where XXX is the name of your ORACLE instance, add 
the following parameters:  

os_authent_prefix = "" (Make sure there is no space between the quotes.) 
remote_os_authent = TRUE  

If your database is already started stop the database as follows:  

1. Verify that the environment variables ORACLE_SID and ORACLE_HOME are correctly defined.  
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2. Verify that you use the UNIX account which has the system privilege on the database.  

3. Go to the Oracle Home directory.  

4. Type svrmgrl and press Enter.  

5. When the prompt appears, type > connect internal  

6. When the prompt appears, type > shutdown  

Start the database as follows:  

1. Verify that the environment variables ORACLE_SID and ORACLE_HOME are correctly defined.  

2. Go to the Oracle Home directory.  

3. Type svrmgrl and press Enter.  

4. When the prompt appears, type > connect internal  

5. Type > startup  

Verify the completeness of the modification as follows:  

1. Create a UNIX user called myuser (for example).  

2. As administrator (system/manager), activate SQLPLUS.  

3. Identify the UNIX user myuser as an ORACLE user through SQLPLUS:  

SQL > create user myuser identified externally;  
SQL > grant connect to myuser  

4. Exit from SQLPLUS.  
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5. Connect using the UNIX account myuser created above.  

6. Type sqlplus / to obtain the prompt SQL>.  

Server Authentication 

During VPM installation, all required users will be created in the ORACLE database.  

Customization for DB2 Database: 

Nothing has to be done to enable Client or Server VPM Authentication Mode, but you can specify if the database authenticates the user 
on the DB2 database server or on the DB2 client. In order to do that the following DB2 commands can help you:  

GET DATABASE MANAGER CONFIGURATION: show all DB2 instance parameters  

UPDATE DATABASE MANAGER CONFIGURATION USING AUTHENTICATION {CLIENT | SERVER}: change the DB2 authentication 
mode (authentication on the client or on the server)  

For more information about DB2 administration, see the IBM Database 2 Administration Guide for Common Servers, Version 2.  

Switching VPM from Server Authentication to Client Authentication 

DB2 

z On DB2 
1. Perform a db2 connect to the [database_name] .  

2. Launch the following command: 
update dbm cfg using AUTHENTICATION CLIENT  

3. To check the update, do as follows:  
get dbm cfg  

z On VPM 
1. Initialize your VPM environment as follows:  

cd env 
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. VPMWsUser.sh  
2. Launch CATDBENV as follows:  

CATDBENV  
3. Double-click on each domain (VPMADMIN, VPMPEOPLE, etc.)  

4. Change the Server button to System.  

5. Use the Save work icon to save your settings.  

6. Set the declaration parameter CATCDM.DBCONNECTION_PROMPT to NO.  

ORACLE 

z On ORACLE 
1. Each user has to be changed from server to client. Connect as dba (system/manager) in sqlplus on your ORACLE instance.  

2. Change the user [user] identified externally:  
SQL> alter [name_of_externally_identified_user];  

z On VPM 
1. Initialize your VPM environment as follows:  

cd env 
. VPMWsUser.sh  

2. Launch CATDBENV as follows:  
CATDBENV  

3. Double-click on each domain (VPMADMIN, VPMPEOPLE, etc.)  

4. Change the Server button to System.  

5. Use the Save work icon to save your settings.  

6. Set the declaration parameter CATCDM.DBCONNECTION_PROMPT to NO.  

Switching VPM from Client Authentication to Server Authentication 

DB2 
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z On DB2 
1. Perform a db2 connect to the [database_name] .  

2. Update dbm cfg using server authentication.  

3. To check the update, do as follows:  
get dbm cfg  

z On UNIX 
1. Check that each VPM user/password exists from a UNIX point of view. This entails checking in /etc/passwd for each user. 

If a user does not exist, add it in /etc/passwd.  

2. Check to make sure that the password corresponds to the VPM password. If it does not, change it using the following 
command:  

passwd user (with root id)  

z On VPM 
1. Initialize your VPM environment as follows:  

cd env 
. VPMWsUser.sh  

2. Launch CATDBENV as follows:  
CATDBENV  

3. Double-click on each domain (VPMADMIN, VPMPEOPLE, etc.)  

4. Change the System button to Server.  

5. Use the Save work icon to save your settings.  

6. Set the declaration parameter CATCDM.DBCONNECTION_PROMPT to YES. 
If it does not exist, add it to $CAT_CUST/site/dec/CATCDM.dcls .  

ORACLE 

z On ORACLE 
1. Each user has to be changed from client to server. Connect as dba (system/manager) in sqlplus on your ORACLE instance.  
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2. Change the user [user_name] identified externally:  
SQL> alter [name_of_user_identified_by_password];  

z On VPM 
1. Initialize your VPM environment as follows:  

cd env 
. VPMWsUser.sh  

2. Launch CATDBENV as follows:  
CATDBENV  

3. Double-click on each domain (VPMADMIN, VPMPEOPLE, etc.)  

4. Change the System button to Server.  

5. Use the Save work icon to save your settings.  

6. Set the declaration parameter CATCDM.DBCONNECTION_PROMPT to YES. 
If it does not exist, add it to $CAT_CUST/site/dec/CATCDM.dcls .  

Installation Instructions 

Installation Overview 

The following is a summary of the different stages of a VPM installation.  

Phase 0: Prerequisites 

1. Logon to the central server and verify all VPM prerequisites with root authority.  
2. Install a CD ROM reader and export its mount point directory, hereafter referred to as CDROMPath.  
3. Create the specific file system in which VPM will be unloaded, independent from the CATIA V4 and ENOVIAVPM installations 

possibly available on your site.  
4. Verify that your database is started.  
5. Verify that all database environment variables are valuated and exported.  

Phase 1: Software Initialization 
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As the phase 1 of the installation uses a CATIA utility called catinst, the entire phase is based on procedures which are inherited from 
CATIA V4 products. In the following steps, the references to CATIA or catinst refer to theses inherited procedures.  

6. Logon as the user root and launch CDROMpath/START. 
This starts the installation. You are prompted to answer a number of questions until the following panel is displayed. 
Perform the catinst installation, generating successively: RIF, configuration, administrator.  

7. Verify that you have set the VPM license keys (The second phase of the VPM Installation process needs VPM license keys to 
perform successfully). 
For the detailed procedure, see the ENOVIAVPM Installation & Administration Guide. 
For further information, see nodelocked licensing or concurrent access licensing in the CATIA.V4 Installation Guide for UNIX 
workstations. There you will find helpful information regarding software maintenance and advanced installation capabilities.  

Phase 2: Installation of Data Structures in the Database 

The database must be created prior to this phase. 
For this second phase, you must be logged onto the server machine (the machine on which the Database has been created) with the 
Administrator authorization.  

8. In order to create data structures in the database see VPMInstall.sh Utilities below. 

  

9. In order to check the installation, launch the VPM Application and log on as VPM Data Administrator.  

The only user known by the VPM Application security mechanism at this point is the VPM Data Administrator.  

For the detailed procedure, see the ENOVIAVPM Installation & Administration Guide.  

VPMInstall.sh Utilities 

You can test your environment (connection with database) before actually installing the data structure using VPMInstall.sh –oracle or 
VPMInstall.sh –db2. During this test phase, we suggest you confirm the parameter addition in YOUR.env. You have to log off then log on 
for these parameters to be taken into account. 
Note that the Create connection modules option can only be used if you already have a VPM database.  
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If you already have connection modules (JD060SGB/JD061SGB/OB071USX for Oracle OR JD060DB2/JD061DB2/OB071USX) installed 
in the STEPLIB path you may install VPM with these modules without building new ones. The UNIX variable 
NO_CONNECTION_MODULES must be set (to anything) in order to avoid connection module generation during installation.  

Then launch VPMInstall.sh –nocheck in order to create the contents of the VPM database.  

Oracle 8.0.4 and 8.0.6: You normally do not have to rebuild the library libORAGLUE.a or .so. 
Oracle 8.0.5: This library must be rebuilt. See the appropriate error below.  

WARNING! If you launch VPMInstall.sh more than once make sure you erase the directory tmp/tmpVPMInst if it still exists. 

WARNING! When running VPMInstall.sh -oracle, the UNIX variable TNS_ADMIN is set to the $CAT_ENV file. This is necessary for 
this particular installation step. When VPM is installed by means of VPMInstall.sh -nocheck, TNS_ADMIN is set to 
$CAT_CUST/code/bin/VPMDBEnv.sh (just like DB2INSTANCE for DB2 installation). The VPM administrator will have to remember that if 
TNS_ADMIN needs to be modified, it MUST be done in VPMDBEnv.sh. 
This modification has been made for VPM/CATIA V5 interoperability purposes. 

Specific for Solaris 8 

See Solaris 8 Support for VPM / CATIAV4 /CATIAV5.  

Specific for HP-UX 11 

The creation of the connection modules must be performed under HP-UX 10.20 to ensure compatibility with the rest of the VPM binaries. 
See Installation Instructions to get the complete procedure on HP-UX 11.00.  

Supported Relational Databases 

z IBM DB/2 Version 6.1 FP3, Version 7.2  
z Oracle Server Version 8.0.4, 8.0.5, 8.0.6, 8.1.5, 8.1.6, 8.1.7  

Installation Instructions 

On HP-UX the following configurations are supported:  
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z DB server on HP-UX 10.20 - VPM client on HP-UX 10.20 or HP-UX 11.00  
z DB server on HP-UX 11.00 - VPM client on HP-UX 10.20 or HP-UX 11.00  

Perform the normal procedure if you are installing VPM on HP-UX 10.20 i.e. VPMInstall.sh -oracle or -db2 to start the checker and 
VPMInstall.sh -nocheck to complete the installation.  

If you decide to install VPM on a HP-UX 11.00 system, please follow the steps indicated below:  

Step 1. Creation of the connection modules  

This has to be done on a HP-UX 10.20 system to ensure compatibility with the rest of the application. 
Use the ’file’ or ’chatr’ command to get the level of the library. Usage: chatr <executable>  

The output of a module built on HP-UX 10.20 is as follows:  

<executable name> : 
shared library dynamic path search: 
SHLIB_PATH enabled first 
embedded path disabled second Not Defined 
shared library list: 
dynamic /usr/lib/libc.1  

The output of a module built on HP-UX 11.00 is as follows:  

<executable name> : 
shared library dynamic path search: 
SHLIB_PATH disabled second 
embedded path disabled first Not Defined 
shared library list: 
dynamic /usr/lib/libc.2  

1. Before starting the process, make sure that you can access the database (ORACLE or DB2). 
The database can be located on a remote server. However, the RDBMS binaries must be installed on the 10.20 system.  

2. Start the VPM installation procedure using the -oracle or -db2 option to access the installation "checker". This allows you to create 
the connection modules (2), the user exit (1) and the libORAGLUE.sl library (8.1.x) if ORACLE is used or binding process if DB2 is 
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used.  
3. Once created, copy the files ( with the -p option for DB2) to the HP-UX 11.00 system. (The default directory is <VPM Admin 

directory>/code/steplib/HP-UX).  
4. Make sure that the access rights on the libraries are set to r-x for all (chmod 555).  
5. Run the chatr command on the connection modules to get all the dependencies. One of these is libclntsh.sl (for ORACLE) and 

libdb2.sl (for DB2). In other words, you have to copy these libraries from the 10.20 system to a directory located on the HP11.00 
system. The second phase of the installation will integrate this directory into the SHLIB_PATH definition.  

Note that during the execution of VPM, if the HP-UX 11.00 library is accessed first, the system will return a message saying that the 
executable cannot be loaded.  

Step 2. Initialization of the Database on the HP-UX 11.00 System  

1. Before executing the VPMInstall.sh procedure on the HP-UX 11.00 system make sure that the database can be accessed and check 
the connection modules and dependencies (libclntsh.sl or libdb2.sl) availability (chatr and catpath commands).  

2. Execute VPMInstall.sh -oracle or -db2 to initialize your environment. If you try to generate the connection modules, the procedure 
will return an error message saying this option cannot be run on HP 11.00. You may set the UNIX variable 
NO_CONNECTION_MODULES to avoid connection module generation.  

3. Specify the location of the 10.20 libraries (ORACLE or DB2) that you copied in step 1.  
4. Execute VPMInstall.sh -nocheck to start the GUI used to create the objects into the database.  

Step 3. Generation of the PSN library (libLV0XCDMA.sl)  

This step consists in the creation of the shared library called by the PSN application. This must be performed under HP-UX 10.20.  

Use the catpsninst.sh procedure to do so or the VPMInstall.sh checker.  

Note that this process applies to all the libraries (user exits) that can be used to customize VPM. If you decide to run a HP-UX 11.00 
configuration to support VPM, you have to keep a HP-UX 10.20 system to compile and build your customization.  

In the event of a communication problem 

If, when VPMStart.sh is run, the following message appears: 
CATDbConnection Table not Found in database error 3106 
you must valuate the variable ORA_NLS33.  
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If, when the connection test is carried out (on AIX and SunOS: $CAT_CUST/code/bin/contest pour AIX et SunOS), the following message 
appears: 
OPEN:sqlca.sqlcode=-3113 
you must valuate the variable ORA_NLS33.  

Phase 3: Implementation of VPM Interoperability 

For this third phase, you must be logged on as the administrator in order to customize the environment (Interoperability with CATIA V4 
Versioning and Revisioning...)  

For the detailed procedure, see the ENOVIAVPM Installation & Administration Guide.  

ENOVIAVPM Version 1 Release 5 is able to communicate with:  

z CATIA V4 (from 422R1 at least; 424R1 is recommended) 
A CATIA V4 PTF might be necessary to improve CATIA V4 behavior toward ENOVIAVPM. Check this point with your PTF provider.  

z CATIA V5 (from V5R6 at least; V5R7 SP5 or higher is recommended) 
V5R7 SP4 is recommended, especially for Relational Design scenarios (storage of V5 technological links in VPM) and for significant 
performance improvements on the scenario involving the launching of the VPM Product Structure (PSN) in V5.  

z ENOVIA DMU (from V5R6 at least; V5R7 SP5 or higher is recommended)  
V5R7 SP5 is recommended, especially for performance improvements on the scenario involving the launching of the VPM Product 
Structure in V5.  

z ENOVIA Portal 3DCOM (from V5R6 at least, V5R7 SP5 or higher is recommended) 
V5R7 SP5 is recommended, especially for VPM NT (via 3d com) versus V5 NT interoperability scenarios.  

z ENOVIA Product Manager (from 3.2. B2 at least)  
z DELMIA Products (Igrip 5.11 at least)  
z DELMIA DPM (from V5R6 at least)  
z DELMIA PPR Hub (from V5R7 SP4 at least).  

Contact your provider to get more information about specific maintenance required for these products.  

ENOVIAVPM Maintenance Levels, PTFs 

A new VPM PTF is cumulative. In other words, it contains many different corrections. Potentially, it includes corrections to:  
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z code (libraries, load modules)  
z shells  
z declaration parameters  
z APIs  

A PTF migration therefore needs to be exhaustive to ensure optimum VPM behavior.  

Installing a PTF n+1 on top of a PTF n (or on top of GA code) 

A few steps are necessary to manage correctly the transition between PTF n and ptfn+1:  

A - Installing the PTF using catinst (CATIA V4-like procedure) 
B - Updating the administrator environment with new PTF content 
C - Checking potential data structure migration  

A - Installing the PTF Using catinst 

For more information on this step you can follow the scenario described in the CATIA Installation Reference Guide (CATIA V4). 
ENOVIAVPM inherits CATIA installation tools which is why there are still some references to CATIA in this tool. The PTF installation 
procedure is more or less the same for ENOVIAVPM as for CATIA V4.  

For information: 
$CAT_UNLOAD refers to the official unload environment. 
$CATIA refers to the official configuration environment. 
$CAT_CUST refers to the administration environment.  

  

1. Launch with root id: 
$CAT_UNLOAD/code/bin/catinst  

where CAT_UNLOAD is set with the appropriate VPM unload directory.  
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2. Unload the software 
-> Unload all the PTF’s UB: 

{ In the first field, provide the path.  
{ In the second field, click on the combo box. 

A new window appears with the list of PTFs.  
{ Click on Select All then OK.  

  

3. Configure the installation 
-> Configure Step by Step: 

{ a - Build the RIF (choose a new rif) 
Example: rif_ptf4  

{ b - Create the runtime environment: 
Change the name of the configuration directory  
Example: cfg_ptf4 
Enter the rif previously created in b/ (rif_ptf4)  

{ c - Create/update the administrator environment: 
Update the existing administrator 
Warning! This step will add some new or updated contents in the following directories: 

� $CAT_CUST/adm/cdmbatch  
� $CAT_CUST/code/src  
� $CAT_CUST/code/bin  
� $CAT_CUST/env  
� $CAT_CUST/dec  

Check in each of these directories to see what has been added with the update of the administrator for PTFn+1 versus the 
PTFn.  
All the objects added in the step "Create/update the administrator environment" above are created with a date extension 
(example: .update_xx:yy:zz). If you want them to be active, you have to rename them.  

How to proceed 
Example: When updating vpm admin from VPM1.5 GA to VPM1.5 PTF3, note the following:  

� Some new objects are added to $CAT_CUST/code/src: 
� orchmod.c  
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� OB071USX  
� Some objects are duplicated in $CAT_CUST/code/src 

� dbsysi.c.update_xx:yy:zz  
� DBEXP6.f .updatex_xx:yy:zz  

So the procedure for these objects is: 
cd $CAT_CUST/code/src 
cp dbsysi.c dbsysi.c.save 
cp dbsysi.c.update_xx:yy:zz dbsysi.c 
and the same for the others  

� Some objects have been duplicated in $CAT_CUST/env: 
YOUR.env 
So the procedure for YOUR.env is: 
cp YOUR.env YOUR.env.ptfn 
cp YOUR.xx:yy:zz.env YOUR.env 
Warning! This operation will result in the loss of your old YOUR.env customized with the DB2 and ORACLE parameters. 
To recover them, follow the step "Updating YOUR.env for activating DB2/ORACLE parameters in the new YOUR.env" 
below.  

� Some new objects have been duplicated in $CAT_CUST/dec: 
CATCDM.dcls .save_xx:yy:zz 
CATCDMA.dcls .save_xx:yy:zz 
CATLIC.dcls.update_xx:yy:zz 
So the procedure for these declaration parameters is: 
cd $CAT_CUST/dec 
diff CATCDMA.dcls.save_xx:yy:zz CATCDMA.dcls 
diff CATCDM.dcls.save_xx:yy:zz CATCDM.dcls 
diff CATLIC.dcls.save_xx:yy:zz CATLIC.dcls 

There are two ways to proceed:  
� Add the new declaration rows (delivered in the PTFn+1) to the old declaration parameters (CATCDM.dcls, 

CATCDMA.dcls, etc.) (recommended)  
or 

� Add the old declaration rows (company-customized rows) to the new declaration (CATCDMA.dcls.save_xx:yy:zz, 
CATCDM.dcls.save_xx:yy:zz, etc.) 
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Example: 
mv CATCDMA.dcls CATCDMA.dcls.ptfn 
mv CATCDM.dcls CATCDM.dcls.ptfn 
cp CATCDMA.dcls.save_xx:yy:zz CATCDMA.dcls 
cp CATCDM.dcls.save_xx:yy:zz CATCDM.dcls  

{ d - Update YOUR.env to activate the DB2/ORACLE parameters in the new YOUR.env. 

Launch:  

$CATIA/vpm/code/command/VPMInstall.sh -db2 for DB2 
or 
$CATIA/vpm/code/command/VPMInstall.sh -oracle for ORACLE  

This shell option will allow you to update YOUR.env (already upgraded in step 3 c "Create/update administrator environment" 
above) by adding DB2 or ORACLE parameters in YOUR.env file.  

B - Updating the Administrator Environment with New PTF Content 

The first VPM installation (using VPMInstall.sh -nocheck) creates certain data (shells, etc.). Some of this data, created by the original VPM 
installation (from scratch) should have changed between the original VPM complete installation date and the PTF date. This step exists to 
refresh certain VPM data (shells, etc.).  

Example: 
When launching the first VPM installation (using VPMInstall.sh -nocheck), all the shells existing in $CATIA/vpm/code/command are 
copied to $CAT_CUST/code/bin. 
Of course, you must not execute VPMInstall.sh -nocheck for each PTF ( this operation should be done one time for data structure 
creation). It means that all the shells in $CAT_CUST/code/bin should not be up to date toward the ptfn+1 
It is the reason why you have to check that all the shells created in $CAT_CUST/code/bin are still correct toward with PTFn+1.  

How to proceed 

1. Save your previous ptfx settings  
cd $CAT_CUST/code/bin 
mkdir save_ptfn 
cp * save_ptfn/. 
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Example : CustoVpmToCatia.sh  
VPMDBEnv.sh  
should be saved because they have been already customized. 

  

2. Run the shell CpInstFiles.sh: 
cd $CATIA/vpm/code/command 
CpInstFiles.sh $CATIA $CAT_CUST UPDATE 

Warning! This shell will upgrade all the VPM administrator environments by copying all contents  
needed for the VPM installation PTF upgrade. This is why you were asked to backup some of your data 
before (in step 1).  

Note that this shell takes into account the following files:  
{ $CAT_CUST/code/bin 

The administrator shell scripts unloaded from the new PTF (PTFn+1) are located, after the PTF installation, under 
$CATIA/vpm/code/command 
The administrator shell scripts will now be copied to $CAT_CUST/code/bin  

{ $CAT_CUST/ORA_MULTISITE or $CAT_CUST/DB2/MULTISITE  
{ $CAT_SITE/multisite  

  

3. Retrieve your previous settings: 
cd $CAT_CUST/code/bin 
cp save_ptfn/ VPMDBEnv.sh . 
 
cp save_ptfn/ CustoVpmToCatia.sh . 
or 
launch (recommended procedure) 
VPMPostInstall.sh 
(option 1: CATIA V4 interoperability Customization) 
This shell will create a new shell CustoVpmToCatia.sh in $CAT_CUST/code/bin 
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cp save_ptfn/CustoVpmToV5.sh . 
or 
launch (recommended procedure): 
VPMPostInstall.sh 
(option 2: CATIA V5 Interoperability Customization) 
This shell will create a new shell called CustoVpmToV5.sh in $CAT_CUST/code/bin  

C - Checking Potential Data Structure Migration 

(Refer also to VPM MIGRATION.)  

Some PTFs may require minor data structure migrations. This is why you are asked to launch this shell in such a case. 
This shell has several options. Just follow the help.  

cd $CAT_CUST/code/bin 
./VPMPostInstall.sh  

z option 4 for checking parameters 
Follow the menu  

z option 5 for managing Database Structure Migration  

Option 1 or 2 for getting information about scripts which will be launched depending on each VPM level and PTF 
Option 4 or 5 for preparing scripts/command streams depending on the customization 
These options will create the correct scripts for migration to a shell. 
For these options, the following declaration parameter is needed:  

catcdm.c_stream =’$CAT_CUST/MIGRATION’; 
in $CATMSTR  

You will be asked to answer certain questions in order to customize your files. Two shells will be created in $CAT_CUST/MIGRATION  

z Run_dbcdmb.sh  
z Run_sql_script_files.sh  

Depending on the migration you need to apply, remove or comment the lines you do not need.  
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VPM MIGRATION 

This part of the Program Directory contains the following sections:  

Migration of Old Databases 
Migrating from a Previous Level 
Oracle and DB2 Replication Tools 
Generic Process: Example from VPM 1.2 to 1.5 
Connecting the VPM 1.5 Administrator to the Database 
Declaring the VPM 1.5 Administrator in the Database 
CATDBENV Checkup 
Generating the Connection Modules 
CATDBENV Test 
Database Migration 
Updating P&O Processes 
Generating the Shared Library libLV0XCDMA (Mandatory after Structure Update) 
Migration Check  

Migration of Old Databases 

Migrating from a Previous Level 

SQL/CLP 
Scripts  Check if they are really obsolete  Applying 

Conditions  

vpmalter1 alter table $EXT add C_MATXX Mandatory

vpmalter2 alter table BOUNDING_BOX add VALID , TYPE , $DATA Mandatory

vpmalter3 alter table PART_LIST,CATIA_MODEL,DOCUMENT,$EXT 
drop/create indexes on those tables Mandatory

vpmalter4 alter table PART_LIST,CATIA_MODEL,DOCUMENT,$EXT Mandatory

vpmalter5 alter table $EXT add C_LAST_MOD Mandatory
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Oracle and DB2 Replication Tools 

If you install from scratch ENOVIAVPM 1.5 PTF16, you can use the Oracle and DB2 replication tools. A large number of tables have been 
modified to make this possible. 
Levels previous to 1.5 PTF16 do not support replication, even after migration. 

Generic Process: Example from VPM 1.2 to 1.5 

All the other migration levels have to follow this process, only check the different structure migration level. VPM 1.5 Std means without 
MultiSite PostInstallation.  

Prerequisite 

1. Create two file systems: 
{ Fs1: /usr/vpm/v15 for the VPM1.5 code  
{ Fs2: /home/vpmadm15 for the VPM1.5 administrator home directory.  

2. Then execute "First Phase - Software Initialization" as described in Installation->Detailed Installation Procedure in the ENOVIAVPM 
Installation & Administration Guide. This corresponds to the "catinst" phase (unload, Build Rif, runtime environment, create/update 
administrator)  

In this document:  

z BASE means ORACLE_SID or DB2DBDFT  
z database means ORACLE or DB2  
z Database administrator: oracle on ORACLE, db2adm on DB2  
z MYENV is one of the VPM environments. The VPM default environment name is VPMENV.  
z /home/vpmadm12 is considered as the VPM1.2 administrator home directory. vpmadm12 is the VPM administrator at this level  
z /home/vpmadm15 is considered as the VPM1.5 administrator home directory. vpmadm15 is the VPM administrator at this level  
z /home/vpmadm15/MIGRATION is the path where to store files reserved for the migration.  
z vpmdata or VPMDATA is the owner in the database of all VPM structure tables: VPM Data Administrator  

In order to migrate from a previous level, use the shell VPMPostinstall.sh to list the different 
scripts to be applied or else edit the file $CATIA/vpm/reffiles/DBMS/VpmMigrationHistory.txt
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Connecting the VPM 1.5 Administrator to the Database 

1. Step 1 - Log on as vpmadm15.  
2. Execute the following command: 

$CATIA/vpm/code/command/VPMInstall.sh –database (oracle or db2)  

This tool allows you to define environment variables.  
We strongly recommend that you choose the /home/vpmadm15/env/YOUR.env update  

3. Answer all questions then log off and log on.  
Using this tool, the following occurs: 

{ The file $CAT_CUST/env/YOUR.env is updated (if chosen).  
{ The directory $CAT_CUST/InstallVPM and its subdirectories are created.  
{ The directory $CAT_CUST/code/bin is updated.  
{ The directories $CAT_CUST/DB2_MULTISITE and $CAT_CUST/ORA_MULTISITE are created.  

4. Step 2 - Log on as vpmadm12.  
5. Look for the VPM1.2 settings using the following: 

$CAT_CUST/env/VPMWsUser.sh  
env|grep -i setting  

This results in:  

CATUserSettingPath=/home/vpmadm12/CATSettings:/home/vpmadm12/QWksVPMWsUser/Settings   
CATReferenceSettingPath=/home/vpmadm12/adm/CATSettings:/home/vpmadm12/QWksVPMWsUser/Settings  

These settings are mandatory in order to be able to connect to the database.  

6. Step 3 - Log on as vpmadm15. 
{ initialization files 

cd /home/vpmadm15/env  
cp $CATIA/vpm/code/command/VPMWsUser.env VPMWsUser.sh  
cp $CATIA/vpm/code/command/VPMWsAdm.env VPMWsAdm.sh  
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Edit the VPM1.2 VPMWs*.sh files in order to update VPM1.5 VPMWs*.sh files with your customization.  
  

{ settings  
According to the results in Step 2 

 
cd /home/vpmadm15  
cp –R /home/vpmadm12/CATSettings .  
cp -R /home/vpmadm12/QWks* .  
cd /home/vpmadm15/code/bin  
cp /home/vpmadm12/code/bin/VPMDBEnv.sh .  

WARNING! For the purposes of CATIA V5 interoperability, it is imperative to have an up-to-date VPMWsUser.sh (vs. VPM 1.2, 
VPM 1.3, etc.). Check to make sure that the following is in this shell:  

  
CATReffilesPath = $CATIA/samples/adm 
export CATReffilesPath  

If this is not the case, add it.  

You now have to validate the setting valuations for each workspace  
cd /home/vpmadm15/env  
. VPMWsUser.sh  
VPMSettings -l  

Check each setting valuation. If any settings refer to the VPM1.2 environment, copy the required data into the VPM1.5 
environment then update the setting value.  

  

{ DDL upgrade 
cd /home/vpmadm15/InstallVPM/reffiles/DBMS/ddl  
cp $CATIA/vpm/reffiles/DBMS/ddl/update2_SECURITY.* .  
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{ declaration parameter update 
cd /home/vpmadm15/site/dec  
ln -s /home/vpmadm15/dec/CATCDMA.dcls CATCDMA.dcls  
ln -s /home/vpmadm15/dec/CATCDM.dcls CATCDM.dcls  

Edit the VPM1.2 files in order to update VPM1.5 files with your customization. If any declaration parameters refer to the 
VPM1.2 environment, copy the required data into the VPM1.5 environment then update the declaration value.  

Check the following declaration parameters carefully with the command catpath –l –A:  
CATCDM.ENV.CATCON must be valuated to CATCON if ORACLE or CATCON6 if DB2  
CATCDM.ENV.DBMINI must be valuated to DBMINI if ORACLE or DBMINI6 if DB2  
CATCDM.DBCONNECTION_PROMPT must be valuated to YES if server and NO if client  
CATCDMA.DBCONNECTION_PROMPT must be valuated to YES if server and NO if client  

Do not forget the declaration parameter defined in the $CATMSTR variable (USRENV.dcls file by default)  

  

{ VPM interoperability 
cd /home/vpmadm15/code/bin  
VPMPostInstall.sh  

Regenerate files for VPM interoperability then edit the VPM1.2 files in order to update VPM1.5 files with your customization 
files i.e. CustoVpmToCatia.sh, CustoVpmToV5.sh and so forth  

Declaring the VPM 1.5 Administrator in the Database 

If you are working in server authentication mode, it is not mandatory to declare the VPM1.5 administrator in the database. You can use 
the VPM1.5 UNIX account and the VPM1.2 login to access the VPM database.   

If you are working in client authentication mode, it is mandatory to declare the VPM1.5 administrator in the database. To do this, logged 
on as vpmadm12, run VPMPeopleEdit, create vpmadm15 and give it the VPMADMIN role of the ADMIN organization.  
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CATDBENV Checkup 

1. Log on as vpmadm15 .  
2. Initialize the VPM environment using /home/vpmadm15/env/VPMWsUser.sh.   
3. In $CAT_CUST/code/bin, launch CATDBENV and verify the instance for each known server.  

Generating the Connection Modules 

To generate the connection modules use:  

VPMInstall.sh -database (ORACLE or DB2)   

In the tool, test the connection to the database then generate the connection modules.  
These modules will be generated in the $HOME administrator. So you have to copy them into the $STEPLIB:   

cd $CAT_CUST/code/steplib/$CATIA_OS  
cp -p /home/vpmadm15/JD06* .  
cp -p /home/vpmadm15/OB071USX .  

Note that for ORACLE, if the connection test is not successful, you must refer to Installation Problems. As an example, you may need to 
build  the libORAGLUE.x.  It is mandatory to build this library with the tool provided in VPMInstall.sh -oracle.  

CATDBENV Test 

1. Log on as vpmadm15 .  
2. Initialize the VPM environment using /home/vpmadm15/env/VPMWsUser.sh.  
3. In $CAT_CUST/code/bin, launch CATDBENV and test the connection for each known server using the vpmadm15 user name and 

vpmadm15 password for the authentication server or nothing for the username and password for the authentication client.  

Mandatory Modification to be Made to VPM1.5 PTF4 

1. In the shell $CAT_CUST/code/bin/Migrate_Prepare_files_DB2.sh, replace: 

# db2 "list tablespaces " | grep Name a mettre dans un fichier 
typeset -i is_found ; is_found=0 
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# db2 "list tablespaces " | grep Name > /tmp/list_tablespaces.$$  

by:  

# db2 "list tablespaces " a mettre dans un fichier 
typeset -i is_found ; is_found=0 
db2 "list tablespaces " > /tmp/list_tablespaces.$$ 

2. In the files $CAT_CUST/code/bin/Migrate_Prepare_files_DB2.sh and $CAT_CUST/code/bin/Migrate_Prepare_files_Oracle.sh, 
make the following changes (the changes are indicated in blue): 

if [[ -f $CATIA/vpm/reffiles/DBMS/VpmMigrationHistory.txt ]] ; then 
pg $CATIA/vpm/reffiles/DBMS/VpmMigrationHistory.txt 
if [[ ! -d $MIGDIR ]] 
then 
mkdir -p $MIGRDIR 
chmod 755 $MIGRDIR 
fi 
cp $CATIA/vpm/reffiles/DBMS/VpmMigrationHistory.txt $MIGRDIR 
fi  

Database Migration 

DB2 
database administrator: db2adm  

ORACLE 
database administrator: oracle  

Migrating Your Database from the 1.2 to the 1.5 Structure 

1. Log on as vpmadm15 .  

You can let the VPM software migrate the database "semi-automated migration" or do the "manual migration" yourself.  
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Case of Semi-automated Migration 

1. Log on as vpmadm15 . 
cd code/bin  

  
2. Launch VPMPostInstall.sh . 

  

3. Define the settings: select VPMPostInstall settings 
{ Provide the CATIA_OS, DBMS, VPM_ADMINISTRATOR (database table owner) and VPMADMINISTRATOR password  

ORACLE  
ORACLE_SID (Oracle connection string), DBA password. 
DB2 
DB2base, DB2Instance, DB2 home directory, DB2bin, user name and password for the database connection.  

{ Check connect adm-string and connect vpm-string which are generated.  

  

4. Read attentively the migration information in VPMPostInstall. 
{ To read the information on migration, select VPM Database structure migration then Migrate typedatabase data structure 

from 1.2 to 1.5 PTF4  
{ To read the information about the migration, select VPM Database structure migration then Database Structure evolution 

history. The information about the history of the migration are available in the file 
$CATIA/vpm/reffiles/DBMS/VpmMigrationHistory.txt  

{ To read the information about the generated scripts, select VPM Database structure migration then prepare scripts / C 
stream for the accurate database then Help on VPM Migration HELP.  

  

5. Build the scripts for the database migration: 
{ In VPMPostInstall, select VPM Database structure migration then prepare scripts / C stream for the accurate database 

then select customize scripts / c streams.  
{ First you have to enter the name of your tablespaces and the datafiles path definition (for Oracle). In case you want a multisite 

installation, you have to install it when you are at VPM 1.4 GA level. If the multisite is not installed the table current_site does 
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not exist and the file update6_PUBSUB is not updated. You do not have to launch it.  
{ Check the file VPPARCUS if you have the following lines, if not, please add them: 

ORACLE  
/* Creator and name of the new CDMA environment */ 
ASSIGN 'MYENV'  TO "GLOBAL_ENV"  ; 
ASSIGN 'MYENV'  TO "GLOBAL_ENV_PWD"  ; 
/* Oracle Tablespace directory */ 
ASSIGN '/mytablespacepath' TO "GLOBAL_DIR_TBSP"  ;  

DB2  
/* Creator and name of the new CDMA environment */ 
ASSIGN 'MYENV'  TO "GLOBAL_ENV" ; 
ASSIGN 'MYENV'  TO "GLOBAL_ENV_PWD"  ;  
ASSIGN ' '  TO "GLOBAL_DIR_TBSP"  ;  

BOTH  
ASSIGN  'MAIL'  TO  "GLOBAL_DICOMAIL"  ; 
ASSIGN  'PROFILE'  TO  "GLOBAL_DICOPROF"  ;  

then quit the editor vi with q.  

{ The scripts are generated in the directory /home/vpmadm15/MIGRATION  
{ Check the built files in /home/vpmadm15/MIGRATION 

  

6. At this step you must check and/or modify some declaration parameters: 
{ Log on as vpmadm15  

“catpath –l –A catcdm.c_stream” must be valuated to '/home/vpmadm15/MIGRATION'  

ORACLE 
“catpath –l –A catcdm.ENV.DBMINI” must be valuated to DBMINI. 
“catpath –l –A catcdm.ENV.CATCON” must be valuated to CATCON.  
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Add the lines in the file /home/vpmadm15/USRENV.dcls:  

catcdm.raw_coid : logical ; 
catcdm.raw_coid = TRUE ;  

DB2  
“catpath –l –A catcdm.ENV.DBMINI” must be valuated to DBMINI6. 
“catpath –l –A catcdm.ENV.CATCON” must be valuated to CATCON6.  

  

7. For the migration of the database, the directory /home/vpmadm15/MIGRATION contains the scripts Run_sql_script_files.sh 
(enabling the running of scripts for migration purposes) and Run_dbcdmd.sh (enabling the running of command streams for 
migration purposes). Note that in these scripts there is an exit after each command which is why you must modify these files taking 
into account both the contents of VpmMigrationHistory.txt (see History of VPM Migration from 1.2 GA to 1.5 PTF4) and your own 
requirements: 

{ cd /home/vpmadm15/MIGRATION  
{ Check and modify the script Run_sql_script_files.sh depending on your customization and VpmMigrationHistory.txt. The file 

Run_sql_script_files.sh was built for a standard migration. 

  

{ DB2  
� You have to check the MML structure when you migrate your database from VPM1.2. See the instructions in Migrating 

your database from the 1.2 to the 1.3 structures : case of manual migration.  
� This shell builds, for each .clp file, a .log and a .lst file.  
� Check the .log and .lst file  
� When you are in logretain mode, you must make a backup of your database before launching the script 

checkind_CONFIG.clp: 
db2 backup database BASE 
After the load phase (exportind2_CONFIG.clp, createind2_CONFIG.clp), importind2_CONFIG.clp), you must launch the 
following command: 
db2 force application all 
db2 backup database BASE  
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{ ORACLE 
� You have to check the MML structure when you migrate your database from VPM1.2. See the instructions in Migrating 

your database from the 1.2 to the 1.3 structures : case of manual migration.  
� To have the right to create and drop triggers in order to run the file update7_PUBSUB.sql , launch the script 

MS_step1_migr_Oracle.sql or do the following:  
sqlplus system/manager 
grant create any trigger to vpmdata 
grant drop any trigger to vpmdata  

{ Launch the shell Run_sql_script_files.sh step by step and check the result after each step.  
{ For migration from the 1.2 to 1.3 structures, a new column must be added to the DOCUMENT table: 

alter table VPMENV.DOCUMENT ADD C_TYPE_REP VARCHAR (80); 
This must be done for all environments.  

{ Check and modify the script Run_dbcdmd.sh depending on your customization and the file history VpmMigrationHistory.txt 
(see History of VPM Migration from 1.2 GA to 1.5 PTF4). This file was built for a standard migration. 

  
� Before launching the script VPINSTS8_1 and VPINSTS8_2 you must check that the table VPMENV.FEATSAMP does 

not already exist for any environment.  
� Before launching the script VPINSTS9_1 and VPINSTS9_2 you must check that the table VPMENV.DOCCAD does not 

already exist for any environment.  

Launch the script Run_dbcdmd.sh step by step and check the result after each step.  

{ This shell has built for each file in command stream an output file, check in those output files that the shell has no error in the 
execution.  

Migrating Your Database from the 1.2 to the 1.3 Structure: Case of Manual Migration 

You have to check the structure of the MML table structure.  

MML Table Structure 

1. Log on as database administrator.  
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2. Check each VPM environment structure using the following method: 

ORACLE  
sqlplus system/manager  
describe MYENV.MML_LINK  
describe MYENV.MML_ENTITY  

  

DB2  
db2  
connect to BASE  
describe select *  from MYENV.MML_LINK  
describe select *  from MYENV.MML_ENTITY  

MYENV.MML_LINK Structure in DB2  

MYENV.MML_ENTITY Structure in DB2  

Sqltype Sqllen sqlname.data sqlname.length
VARCHAR 18  OBJECT_CATAB 12  

CHARACTER 8  OBJECT_COID 11  

CHARACTER 8  OBJECT_COMPID 13  

CHARACTER 8  ENTITY_ID_1 11  

CHARACTER 8  ENTITY_ID_2 11  

CHARACTER 8  ENTITY_KEY 10  

CHARACTER 8  TYPE 4  

TIMESTAMP 26  TS 2  

CHARACTER 3  STATUS 6  

CHARACTER 1  UBIT 4  
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MYENV.MML_LINK Structure in ORACLE  
  

Sqltype Sqllen sqlname.data sqlname.length
VARCHAR 18 OBJECT_CATAB 12

CHARACTER 8 OBJECT_COID 11

CHARACTER 8 OBJECT_COMPID 13

CHARACTER 8 ENTITY_ID_1 11

CHARACTER 8 ENTITY_ID_2 11

CHARACTER 8 ENTITY_KEY 10

VARCHAR 80 ENTITY_NICKNAME 15

TIMESTAMP 26 TS 2

CHARACTER 1 UBIT 4

Name Null? Type
OBJECT_CATAB NOT NULL VARCHAR2(18)

OBJECT_COID NOT NULL RAW(8)

OBJECT_COMPID NOT NULL RAW(8)

ENTITY_ID_1 NOT NULL RAW(8)

ENTITY_ID_2 NOT NULL RAW(8)

ENTITY_KEY NOT NULL RAW(8)

TYPE NOT NULL CHAR(8)

TS NOT NULL DATE

STATUS CHAR(3)

UBIT CHAR(1)
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MYENV.MML_ENTITY Structure in ORACLE  
  

If your result is different on any of your VPM environments, please apply the following process.  
WARNING! Previous MML tables will be dropped so all previous MML entity links are deleted.  

ORACLE  

cd /home/vpmadm15/MIGRATION  
cp $CATIA/vpm/reffiles/DBMS/ddl/NewMML.sql .  

  

1. Log on as database administrator.  

 
sqlplus MYENV/MYENV  
@/home/vpmadm15/MIGRATION/NewMML  

DB2  

cd /home/vpmadm15/MIGRATION  

Name Null? Type
OBJECT_CATAB NOT NULL VARCHAR2(18)

OBJECT_COID NOT NULL RAW(8)

OBJECT_COMPID NOT NULL RAW(8)

ENTITY_ID_1 NOT NULL RAW(8)

ENTITY_ID_2 NOT NULL RAW(8)

ENTITY_KEY NOT NULL RAW(8)

ENTITY_NICKNAME VARCHAR2(80)

TS NOT NULL DATE

UBIT CHAR(1)
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cp $CATIA/vpm/reffiles/DBMS/ddl/NewMML.clp .  

1. Edit the file in order to replace the environment name.  
2. Log on as database administrator.  

 
db2 connect to BASE  
db2 -tvf /home/vpmadm15/MIGRATION/NewMML.clp  

CONFIGURATION IMPROVEMENT 

DB2 
Configuration database migration shell to add indexes on DB2 and improve PERFORMANCES about EDIT CONFIG, SELECT CONFIGH, 
EXPAND GRAPH   

The following DB2 update does not need to be done if your VPM data structure was built in ENOVIAVPM1.1 and was migrated when you 
added the dedicated VPM1.1 PTF according to the ENOVIAVPM1.1 Program Directory.  

CONFIGURATION 

1. Copy the following files into $CAT_CUST/MIGRATION: 
cp $CATIA/vpm/reffiles/DBMS/ddl/checkind_CONFIG.clp .  
cp $CATIA/vpm/reffiles/DBMS/ddl/exportind2_CONFIG.clp .  
cp $CATIA/vpm/reffiles/DBMS/ddl/createind2_CONFIG.clp . 
WARNING! Check to make sure that the generated files are read-only for all users: 
chmod atr*.ixf  
cp $CATIA/vpm/reffiles/DBMS/ddl/importind2_CONFIG.clp .  

2. In the ddl, replace VPMADM with the VPM Data Administrator (VPMDATA) then execute the following commands: 

  
db2 backup database BASE  
db2 -tvf $CAT_CUST/MIGRATION/checkind_CONFIG.clp  

The script returns the maximum length of each column. You must verify that lengths are less than:  
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MAX_ID: 40  
MAX_APPLY: 50  
MAX_LOT_SIZE: 254  
MAX_MODIF_ID: 40  
MAX_ACTION_TYPE: 1  
MAX_OLDLINK: 50  
MAX_OPTION_ID: 40  
MAX_OPTION_TYPE: 40  
MAX_OPTION_LOT_ID: 254  

  
db2 -tvf $CAT_CUST/MIGRATION/exportind2_CONFIG.clp  
db2 –tvf $CAT_CUST/MIGRATION/createind2_CONFIG.clp  
db2 –tvf $CAT_CUST/MIGRATION/importind2_CONFIG.clp  

After this load phase, the tablespace TBS_INDEX may become:   

This is because you are in LOGRETAIN, i.e. in RECOVERY mode, so you have to do the following:  

  
db2 force application all  
db2 backup database BASE  

After the backup, the tablespace BASE becomes:  

Tablespace ID = 3
Name = TBS_INDEX
Type = System managed space
Contents = Any data
State = 0x0020
Detailed 
explanation:
Backup pending
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3. Copy update4_CONFIG.clp, update5_CONFIG_1.clp and update5_CONFIG_2.clp from $CATIA/vpm/reffiles/DBMS/ddl  
4. Edit the files by replacing vpmadm with your vpm data administrator VPMDATA after doing a chmod +w on files  
5. You can now run the following: 

db2 connect to BASE user vpmdata using vpmdata 
db2 -tvf update4_CONFIG.clp 
db2 -tvf update5_CONFIG_1.clp 
db2 -tvf update5_CONFIG_2.clp  

ORACLE  

1. Copy update4_config.sql, update5_CONFIG_1.sql and update5_CONFIG_2.sql from $CATIA/vpm/reffiles/DBMS/ddl  
2. Edit the file update4_config.sql as follows: 

{ Replace vpmadm with your VPMDATA (VPM data administrator) after doing a chmod +w on files   
{ Replace TSTVPM and TSIVPM and TBS_INDEX  

3. Edit the files update5_CONFIG_1.sql and update5_CONFIG_2.sql as follows: 
{ Replace vpmadm with your vpm data administrator VPMDATA after doing a chmod +w on files   
{ Replace TSTVPM and TSIVPM by TBS_CONFIG  

Creation phase:  
sqlplus system/manager  
sql>@update5_CONFIG_1.sql  
sql>quit  

Tablespace ID = 3
Name = TBS_INDEX
Type = System managed space
Contents = Any data
State = 0x0000
Detailed 
explanation:
Normal
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Grant phase:  
sqlplus vpmadm/vpmadm or  
(depending on the authentication mode, you must use the table owner UNIX account)  
sql>@update4_CONFIG.sql 
sql>@update5_CONFIG_2.sql  
sql>quit  

DB2  

1. Copy update4_CONFIG.clp, update5_CONFIG_1.clp and update5_CONFIG_2.clp from CATIA/vpm/reffiles/DBMS/ddl  
2. Edit the files by replacing vpmadm with your vpm data administrator VPMDATA after doing a chmod +w on files.  
3. Launch the scripts: 

db2 connect to BASE user VPMDATA using VPMDATA 
db2 -tvf update4_CONFIG.clp 
db2 -tvf update5_CONFIG_1.clp 
db2 -tvf update5_CONFIG_2.clp  

BOTH  
A new column must be added to the $EXT_LF table:  

ORACLE 

alter table VPMENV.$EXT_LF ADD REPRES_TYPE VARCHAR (230);  

DB2  

alter table VPMENV."$EXT_LF" ADD REPRES_TYPE VARCHAR (230);  
  

This must be done for all environments.  

A new column must be added to the DOCUMENT table:  

alter table VPMENV.DOCUMENT ADD C_TYPE_REP VARCHAR (80);  
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This must be done for all environments.  

Migrating Your Database from 1.3 to 1.4 PTF4 Structure: Case of Manual Migration 

ORACLE Migration 

1. Log on as vpmadm15 . 
cd /home/vpmadm15/MIGRATION  
cp $CATIA/vpm/reffiles/DBMS/ddl/update_ADMIN.sql .  
cp $CATIA/vpm/reffiles/DBMS/ddl/update_PEOPLE.sql . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update2_PUBSUB.sql . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update0_PUBSUB.sql .  
chmod 777 update*  

  
2. Edit each file and modify: 

{ VPM Data Administrator name: VPMDATA  
{ the tablespace name according to your database  

Remarks:  
{ Default tablespaces for those ddl's are in "Default Tablespaces table" at the beginning of this chapter.  
{ You can check your tablespace using the following: 

sqlplus system/manager  
“select FILE_NAME, TABLESPACE_NAME from dba_data_files ;”  
“select TABLE_NAME, TABLESPACE_NAME from dba_tables ;”  

  

3. You can now run the following: 

 

Server Authentication Client Authentication

Log on as vpmadm15  Log on as vpmdata  
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4. At this step you must check and modify some declaration parameters: 

Log on as vpmadm15  
cd /home/vpmadm15/env  
. VPMWsUser.sh  
“catpath –l –A catcdm.ENV.DBMINI” must be valuated to DBMINI.  
“catpath –l –A catcdm.ENV.CATCON” must be valuated to CATCON.  
“catpath –l –A catcdm.c_stream” 

Modify the last one as follows:  
catcdm.c_stream = '/home/vpmadm15/MIGRATION';  

  

5. You also have to set the following declaration parameter: 

  
catcdm.raw_coid : logical ;  
catcdm.raw_coid = TRUE ;  

  
cd /home/vpmadm15/MIGRATION  
cp $CAT_CUST/adm/cdmbatch/CSORAPAR .  
cp $CATIA/vpm/reffiles/DBMS/UPORASHA .  
cp $CATIA/vpm/reffiles/DBMS/UPORAGRA .  
cp $CATIA/vpm/reffiles/DBMS/VPPARPRO .  

The aim is to make the new CATIA V5 Alternate Shape Table available for environments. The environment must have the 

sqlplus vpmdata/vpmdata  
@/home/vpmadm15/MIGRATION/update_ADMIN.sql 
@/home/vpmadm15/MIGRATION/update_PEOPLE.sql 
@/home/vpmadm15/MIGRATION/update2_PUBSUB.sql 
@/home/vpmadm15/MIGRATION/update0_PUBSUB.sql

sqlplus /  
@/home/vpmadm15/MIGRATION/update_ADMIN.sql 
@/home/vpmadm15/MIGRATION/update_PEOPLE.sql 
@/home/vpmadm15/MIGRATION/update2_PUBSUB.sql 
@/home/vpmadm15/MIGRATION/update0_PUBSUB.sql
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PART_LIST table and DOCUMENT table(s).  
The UPORASHA and UPORAGRA file does not have to be modified.  

for the creation of the table DOCCAD (optional): 
cp $CATIA/vpm/reffiles/DBMS/VPINSTS9_1 .  
cp $CATIA/vpm/reffiles/DBMS/VPINSTS9_2 .  
 
chmod 777 *  

  

6. Modify the beginning of files VPINSTS9_1 and VPINSTS9_2:  
 

 
The environment must have PART_LIST table and DOCUMENT table(s).  

  

7. For each environment, modify the file CSORAPAR as follows: 
/* Creator and name of the new CDMA environment */  
ASSIGN 'MYENV'  TO "GLOBAL_ENV"  ;  
 ASSIGN 'MYENV'  TO "GLOBAL_ENV_PWD"  ;  
 /* Oracle Tablespace directory */  
 ASSIGN '/mytablespacepath'  TO "GLOBAL_DIR_TBSP"  ;;  
  

8. Check in the file if you have the following lines: if not, please add them: 
ASSIGN  'MAIL'  TO  "GLOBAL_DICOMAIL"  ;  
ASSIGN  'PROFILE'  TO  "GLOBAL_DICOPROF"  ;  

  
9. Run the following commands (for each environment): 

dbcdmb UPORASHA –u system –p manager –o UPORASHA  

Replace: By:
*ON_ERROR  STOP  
*COMMAND  
VPPARCUS

*ON_ERROR  STOP  
*COMMAND  
CSORAPAR
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and if no failed command is detected in the UPORASHA.out file:  
dbcdmb UPORAGRA –u MYENV –p MYENV –o UPORAGRA 

and if no failed command is detected in the UPORAGRA.out file: 
Before launching this script you must check that the table VPMENV.DOCCAD does not already exist for any environment   

dbcdmb VPINSTS9_1 –u system –p manager –o VPINSTS9_1 

If no failed command is detected in the file VPINSTS9_1.out:  

dbcdmb VPINSTS9_2 –u VPMENV –p VPMENV –o VPINSTS9_2  

  
10. Check output files for errors.  

DB2 Migration  

1. Log on as vpmadm15 . 
cd /home/vpmadm15/MIGRATION  
cp $CATIA/vpm/reffiles/DBMS/ddl/update_PEOPLE.clp .  
cp $CATIA/vpm/reffiles/DBMS/ddl/update_ADMIN.clp . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update2_PUBSUB.clp . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update0_PUBSUB.clp . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update_ENTITY.clp .  
chmod 777 update*  

  

2. Edit each file and modify: 
{ VPM Data Administrator name: VPMDATA  
{ the tablespace name according to your database.  

Remarks:  
{ Default tablespaces for those ddl's are in "Default Tablespaces table" at the beginning of this chapter.  
{ You can check your tablespace using the following: 

db2 connect to BASE user db2adm using db2adm  
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db2 list tablespaces  
db2 "select  NAME,CREATOR,TBSPACE from sysibm.systables 
where CREATOR='VPMDATA'"  

  

3. You can now run the following: 

“ db2 connect to BASE user vpmdata using vpmdata ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update_ADMIN.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update_PEOPLE.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update2_PUBSUB.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update0_PUBSUB.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update_ENTITY.clp ”  

  

4. At this step you must check and modify some declaration parameters: 

Log on as vpmadm15:  
cd /home/vpmadm15/env  
. VPMWsUser.sh 

“catpath –l –A catcdm.ENV.DBMINI” must be valuated to DBMINI6.  
“catpath –l –A catcdm.ENV.CATCON” must be valuated to CATCON6.  
“catpath –l –A catcdm.c_stream”  

Modify the last one as follows:  
catcdm.c_stream = '/home/vpmadm15/MIGRATION';  

cd /home/vpmadm15/MIGRATION  
cp $CAT_CUST/adm/cdmbatch/CSDB2PAR .  
cp $CATIA/vpm/reffiles/DBMS/UPDB2SHA .  
cp $CATIA/vpm/reffiles/DBMS/UPDB2GRA .  
cp $CATIA/vpm/reffiles/DBMS/VPPARPRO .  
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The aim is to make the new CATIA V5 Alternate Shape Table available for environments. The environment must have PART_LIST 
table and DOCUMENT table(s).  
The UPDB2SHA and UPDB2GRA file does not have to be modified.  

for the creation of the table DOCCAD (optional): 
cp $CATIA/vpm/reffiles/DBMS/VPINSTS9_1 .  
cp $CATIA/vpm/reffiles/DBMS/VPINSTS9_2 .  
 
chmod 777 *  

  

5. For each environment, modify the file CSDB2PAR as follows: 

 /* Creator and name of the new CDMA environment */  
 ASSIGN 'MYENV'  TO "GLOBAL_ENV"  ;  
 ASSIGN 'MYENV'  TO "GLOBAL_ENV_PWD"  ;  

  

6. Check in the file if you have the following lines: if not, please add them: 

 ASSIGN  'MAIL'  TO  "GLOBAL_DICOMAIL"  ;  
 ASSIGN  'PROFILE'  TO  "GLOBAL_DICOPROF"  ;  
 ASSIGN ' '  TO "GLOBAL_DIR_TBSP" ;  

  

7. Modify the beginning of files VPINSTS9_1 and VPINSTS9_2:  
 

Replace: By:
*ON_ERROR  STOP  
*COMMAND  
VPPARCUS

*ON_ERROR  STOP  
*COMMAND  
CSDB2PAR
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8. Run the following commands (for each environment): 
dbcdmb UPDB2SHA –u db2adm –p db2adm –o UPDB2SHA  

and if no failed command is detected in the UPORASHA.out file:  
dbcdmb UPDB2GRA –u db2adm –p db2adm –o UPDB2GRA  

  

9. The environment must have a PART_LIST table and DOCUMENT table. Before launching this script you must check that the table 
VPMENV.DOCCAD does not already exist for any environment. 

dbcdmb VPINSTS9_1 –u db2adm –p db2adm –o VPINSTS9_1 

If no failed command is detected in the file VPINSTS9_1.out:  

dbcdmb VPINSTS9_2 –u db2adm –p db2adm –o VPINSTS9_2  

  

10. Check the output files for any errors.  

Migrating Your Database from 1.4 GA to PTF4 

This chapter only concerns VPM database structures that were created at VPM1.4 level. This means that you are concerned if your first 
ENOVIAVPM installation was done at this level (using VPMInstall.sh or VPMInstall.sh -nocheck).   

For post-PTF4 levels, CATIA V5 links are now managed in the following new VPM tables:   

z VPMDATA.VPM_ENTITY   
z VPMDATA.VPM_LINK   
z MYENV.FEATURE   

So if your installation was done at a pre-PTF4 level , you need to run the update_ADMIN script in order to create the tables:   
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z VPMDATA.VPM_ENTITY   
z VPMDATA.VPM_LINK   

1. Log on as vpmadm15 . 
cd /home/vpmadm15/MIGRATION  
cp $CATIA/vpm/reffiles/DBMS/ddl/update_ADMIN.*  
chmod 777 update_ADMIN*  

  

2. Edit the file and modify: 
{ VPM Data Administrator name: VPMDATA  
{ The tablespace name according to your database  

 
Remark:  
Default tablespaces for those ddl are in "Default Tablespaces table" at the beginning of this chapter.  

3. If the table VPMDATA.REPLICATION_QUEUE already exists (relative to multisite), edit update_ADMIN.* then remove all the line 
linked to this table and its indexes. 

  

4. You can now run the following: 

ORACLE:  

DB2:  
“ db2 connect to BASE user vpmdata using vpmdata ”  

Server Authentication Client Authentication
Log on as vpmadm15  
sqlplus vpmdata/vpmdata  
@/home/vpmadm15/MIGRATION/update_ADMIN

Log on as vpmdata  
sqlplus /  
@/home/vpmadm15/MIGRATION/update_ADMIN
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“ db2 –tvf /home/vpmadm15/MIGRATION/update_ADMIN.clp ”   

Migrating Your Database from 1.4 PTF4 to 1.5 Structure: Case of Manual Migration 

Oracle Migration 

1. Log on as vpmadm15 . 
cd /home/vpmadm15/MIGRATION  
cp $CATIA/vpm/reffiles/DBMS/ddl/update_SECURITY.sql .  
cp $CATIA/vpm/reffiles/DBMS/ddl/update2_SECURITY.sql . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update3_PUBSUB.sql . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update5_PUBSUB.sql . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update6_PUBSUB.sql . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update7_PUBSUB.sql .  
chmod 777 update*  

  
2. Edit each file and modify: 

{ VPM Data Administrator name: VPMDATA  
{ the tablespace name according to your database  

Remarks:  
{ Default tablespaces for those ddl's are in the Default Tablespace table at the beginning of this chapter.  
{ You can check your tablespace using the following: 

sqlplus system/manager  
“select FILE_NAME, TABLESPACE_NAME from dba_data_files ;”  
“select TABLE_NAME, TABLESPACE_NAME from dba_tables ;”  

  

3. To have the right to create and to drop any triggers for the script update7_PUBSUB.sql, run the script MS_step1_migr_Oracle.sql or 
do the following: 

 
sqlplus system/manager 
grant create any trigger to vpmdata 
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grant drop any trigger to vpmdata 

  

4. You can now run the following: 

 

  

5. To create the new CATIA V5 interoperability table FEATURE, FEATSAMP (new sample table for feature management, optional)  
 

At this step you must check and modify some declaration parameters:  

Log on as vpmadm15 .  

cd /home/vpmadm15/env  
. VPMWsUser.sh  
“catpath –l –A catcdm.ENV.DBMINI” must be valuated to DBMINI.  
“catpath –l –A catcdm.ENV.CATCON” must be valuated to CATCON.  
“catpath –l –A catcdm.c_stream” must be modified to 
catcdm.c_stream = ’/home/vpmadm15/MIGRATION’;  

Server Authentication Client Authentication
Log on as vpmadm15  
sqlplus vpmdata/vpmdata  
@/home/vpmadm15/MIGRATION/update_SECURITY.sql 
@/home/vpmadm15/MIGRATION/update2_SECURITY.sql 
@/home/vpmadm15/MIGRATION/update3_PUBSUB.sql 
@/home/vpmadm15/MIGRATION/update5_PUBSUB.sql 
@/home/vpmadm15/MIGRATION/update6_PUBSUB.sql 
@/home/vpmadm15/MIGRATION/update7_PUBSUB.sql

Log on as vpmdata  
sqlplus /  
@/home/vpmadm15/MIGRATION/update_SECURITY.sql 
@/home/vpmadm15/MIGRATION/update2_SECURITY.sql 
@/home/vpmadm15/MIGRATION/update3_PUBSUB.sql 
@/home/vpmadm15/MIGRATION/update5_PUBSUB.sql 
@/home/vpmadm15/MIGRATION/update6_PUBSUB.sql 
@/home/vpmadm15/MIGRATION/update7_PUBSUB.sql
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You have to set the following declaration parameter too:  

catcdm.raw_coid : logical ;   
catcdm.raw_coid = TRUE ;  
cd /home/vpmadm15/MIGRATION  
cp $CAT_CUST/adm/cdmbatch/CSORAPAR .  
cp $CATIA/vpm/reffiles/DBMS/VPPARPRO . 

for the creation of the table FEATURE: 
cp $CATIA/vpm/reffiles/DBMS/VPINSTS7_1 .  
cp $CATIA/vpm/reffiles/DBMS/VPINSTS7_2 .  

for the creation of the table FEATSAMP (optional): 
cp $CATIA/vpm/reffiles/DBMS/VPINSTS8_1 .  
cp $CATIA/vpm/reffiles/DBMS/VPINSTS8_2 .  

chmod 777 VP*  

  

6. Modify the beginning of files VPINSTS7_1, VPINSTS7_2, VPINSTS8_1and VPINSTS8_2:  
 

 
The environment must have PART_LIST table and DOCUMENT table(s).  

  

7. For each environment, modify the file CSORAPAR as follows: 

Replace: By:
*ON_ERROR  STOP  
*COMMAND  
VPPARCUS

*ON_ERROR  STOP  
*COMMAND  
CSORAPAR
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/* Creator and name of the new CDMA environment */  
ASSIGN 'MYENV'  TO "GLOBAL_ENV"  ;  
ASSIGN 'MYENV'  TO "GLOBAL_ENV_PWD"  ;  
/* Oracle Tablespace directory */  
ASSIGN '/mytablespacepath'  TO "GLOBAL_DIR_TBSP"  ;;  

  

8. Check in the file if you have the following lines: if not, please add them: 

 
ASSIGN  'MAIL'  TO  "GLOBAL_DICOMAIL"  ;  
ASSIGN  'PROFILE'  TO  "GLOBAL_DICOPROF"  ;   

and run the following commands (for each environment):  

  
dbcdmb VPINSTS7_1 –u system –p manager –o VPINSTS7_1 
If no failed command is detected in the file VPINSTS7_1.out: 
dbcdmb VPINSTS7_2 –u VPMENV –p VPMENV –o VPINSTS7_2 

dbcdmb VPINSTS8_1 –u system –p manager –o VPINSTS8_1 
If no failed command is detected in the file VPINSTS8_1.out: 
dbcdmb VPINSTS8_2 –u VPMENV –p VPMENV –o VPINSTS8_2  

DB2 Migration 

1. Log on as vpmadm15 . 
cd /home/vpmadm15/MIGRATION  
cp $CATIA/vpm/reffiles/DBMS/ddl/update_SECURITY.clp .  
cp $CATIA/vpm/reffiles/DBMS/ddl/update2_SECURITY.clp . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update3_PUBSUB.clp . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update5_PUBSUB.clp . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update6_PUBSUB.clp . 
cp $CATIA/vpm/reffiles/DBMS/ddl/update7_PUBSUB.clp .  
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chmod 777 update*  
  

2. Edit each file and modify: 
{ VPM Data Administrator name: VPMDATA  
{ the tablespace name according to your database  

  

3. Remarks: 
{ Default tablespaces for those ddl's are in the Default Tablespace table at the beginning of this chapter.  
{ You can check your tablespace using the following: 

db2 connect to BASE user db2adm using db2adm  
db2 list tablespaces  
db2 "select  NAME,CREATOR,TBSPACE from sysibm.systables 
where CREATOR='VPMDATA'"  

  

4. You can now run the following: 

“ db2 connect to BASE user vpmdata using vpmdata ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update_SECURITY.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update2_SECURITY.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update3_PUBSUB.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update5_PUBSUB.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update6_PUBSUB.clp ” 
“ db2 –tvf /home/vpmadm15/MIGRATION/update7_PUBSUB.clp ”  

  

5. To create the new CATIA V5 interoperability table FEATURE, FEATSAMP (new sample table for feature management, optional) 

At this step you must check and modify some declaration parameters:  

Log on as vpmadm15 .  
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cd /home/vpmadm15/env  
. VPMWsUser.sh  
“catpath –l –A catcdm.ENV.DBMINI” must be valuated to DBMINI6.  
“catpath –l –A catcdm.ENV.CATCON” must be valuated to CATCON6.  
“catpath –l –A catcdm.c_stream” must be modified as follows: 
catcdm.c_stream = '/home/vpmadm15/MIGRATION' ;  
cd /home/vpmadm15/MIGRATION  
cp $CAT_CUST/adm/cdmbatch/CSDB2PAR .  
cp $CATIA/vpm/reffiles/DBMS/VPPARPRO .  
for the creation of the table FEATURE: 
cp $CATIA/vpm/reffiles/DBMS/VPINSTS7_1 .  
cp $CATIA/vpm/reffiles/DBMS/VPINSTS7_2 .  
for the creation of the table FEATSAMP (optional): 
cp $CATIA/vpm/reffiles/DBMS/VPINSTS8_1 .  
cp $CATIA/vpm/reffiles/DBMS/VPINSTS8_2 .  
 
chmod 777 VP*  

  

6. Modify the beginning of files VPINSTS7_1, VPINSTS7_2, VPINSTS8_1and VPINSTS8_2:  
 

 
The environment must have PART_LIST table and DOCUMENT table(s).  

  

7. For each environment, modify the file CSDB2PAR as follows: 

/* Creator and name of the new CDMA environment */  

Replace: By:
*ON_ERROR  STOP  
*COMMAND  
VPPARCUS

*ON_ERROR  STOP  
*COMMAND  
CSDB2PAR
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ASSIGN 'MYENV'  TO "GLOBAL_ENV"  ;  
ASSIGN 'MYENV'  TO "GLOBAL_ENV_PWD"  ;  

  

8. Check in the file if you have the following lines. If not, please add them: 

 
ASSIGN  'MAIL'  TO  "GLOBAL_DICOMAIL"  ;  
ASSIGN  'PROFILE'  TO  "GLOBAL_DICOPROF"  ; 
ASSIGN ' '  TO  "GLOBAL_DIR_TBSP"  ;  

  

9. Run the following commands (for each environment): 

  
dbcdmb VPINSTS7_1 –u db2adm –p db2adm –o VPINSTS7_1 
If no failed command is detected in the file VPINSTS7_1.out: 
dbcdmb VPINSTS7_2 –u db2adm –p db2adm –o VPINSTS7_2 

dbcdmb VPINSTS8_1 –u db2adm –p db2adm –o VPINSTS8_1 
If no failed command is detected in the file VPINSTS8_1.out: 
dbcdmb VPINSTS8_2 –u db2adm –p db2adm –o VPINSTS8_2  

  

10. Check output files for errors. (If errors are encountered in VPINSTS7_1, remove the insert part.  

Updating P&O Processes 

1. Execute the following command under the VPM administrator: 
{ Log on as vpmadm15 .  
{ cd env  
{ . VPMWsAdm.sh  
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{ cd /home/vpmadm15/code/bin  

Note: Remember to log off before starting VPM.  

{ Use VPMPeopleEdit to manage the new processes.  
The new processes in the P&O area as follows:   
 

Upgrading the Licenses 

Rule-based configuration and milestone creation also require using Product Engineer.  
This means you have to grant this license for each role.   

Granting CFG Processes for the Desired Roles 

Example:   

VPM CFG myData  

or:   

Server Authentication Client Authentication
VPMDataManager vpmadm15 vpmadm15 VPMDataManager

VPM BOM DeleteZone

VPM CFG AnalyseBranch

VPM CFG DeleteDateMilestone

VPM CFG DeleteRangeMilestone

VPM CFG ManageDateMilestone

VPM CFG ManageOptionDictionaryCorp

VPM CFG ManageRangeMilestone

VPM CFG ManageRules

VPM CFG ManageRulesCorp
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VPM CFG ManageRangeMilestone myOrgData  

Generating the Shared Library libLV0XCDMA (Mandatory after Structure Update) 

1. Create a new directory VPMPSN under $HOME (chmod 777 VPMPSN)   
2. Under the VPMPSN directory, create the NAV.in file.   
3. Repeat the last three lines for each environment:  

*DB CATCON  
*ENV MYENV  
CATIA_MODEL  
DOCUMENT 
FEATURE 
FEATSAMP 
DOCCAD 
....   

Remarks:  
{ To check your environments, in your database:  

"select * from catia.coname"  

{ To check tables CATIA_MODEL and DOCUMENT: 

"list tables for schema MYENV"  

or   

" select table_name from user_tables where owner='MYENV'  

4. Add the following declaration parameter in your USRENV.dcls for each environment defined in the NAV.in file: 

CATCDMA.VPM.CDMA_ENVIRONMENT='MYENV';  
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5. Generate and compile the Express Schema:  

cd $CAT_CUST/env  
. VPMWsAdm.sh  
cd $CAT_CUST/VPMPSN  
catpsninst.sh NAV.in  

This will create, in your current directory libLV0XCDMA that you have to copy into your $STEPLIB ($CAT_CUST/code/steplib/
$CATIA_OS by default).  

Migration Check 

1. Launch VPM and try to connect as vpmadm15.  
2. Open the PSN graph.   
3. If by any chance you cannot logon to VPM, do as follows: 

Log on as vpmadm15  
cd /home/vpmadm15/MIGRATION  
cp $CATIA/vpm/reffiles/DBMS/ddl/grant_PEOPLE.*  
chmod 777 grant_PEOPLE.*  

Edit the file and modify the VPM Data Administrator name: VPMDATA  

You can now run the following:  

ORACLE:  
  

DB2:  

Server Authentication Client Authentication
Log on as vpmadm15  
sqlplus vpmdata/vpmdata  
@/home/vpmadm15/MIGRATION/grant_PEOPLE

Log on as vpmdata  
sqlplus /  
@/home/vpmadm15/MIGRATION/grant_PEOPLE
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" db2 connect to BASE user vpmdata using vpmdata "  
" db2 –tvf /home/vpmadm15/MIGRATION/grant_PEOPLE.clp "  

Installation Problems 

Identified Errors 

  

  

Problem 1 You cannot log on as VPMADMIN user to verify what was created 
in the database.

Solution Try to logon as this user in order to see if you are prompted to 
change the password.

Problem 2 Oracle attempts to enter the db but seems to go into an infinite 
loop (or a tnsnames.ora error) or Unknown class error ( = 
VX0TCNX VPMADMIN error or VPMDataManager)

Solution z Verify the tnsnames.ora and listener.ora syntax (look for null 
characters ( CR or spaces) by the end of the lines).  

z Verify the value of the TNS_ADMIN environment variable.  
z Check if the authentication of the database corresponds to 

the authentication you want with VPM (see VPM 
Authentication Modes).  

Problem 3 ddl error

Solution z The database is not cleaned properly (see "Cleaning Your 
Database" in the ENOVIAVPM Installation & Administration 
Guide).  

z There is not enough space on disk (FS) for TBS.  
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Problem 4 You get the following message during installation: 
Can’t open library libPR0ORAC.a 
--> reason = A file or directory in the path name does not 
exist. 
Can’t open library libPR0ORAC_Connection.a 
--> reason = A file or directory in the path name does not 
exist.

Solution z Regenerate the lbclntsh library.  
z Regenerate the liboraglue library.  
z Verify if the listener had really launched the instance used.  
z Verify that the compilers are working properly (cp a *.f file in 

temp and launch f77 file_name.f)  

Problem 5 On AIX and SUN you get the following message during installation: 
Can’t open library libPR0ORAC.a 
--> reason = A file or directory in the path name does not 
exist. 
Can’t open library libPR0ORAC_Connection.a 
--> reason = A file or directory in the path name does not 
exist.

Solution z Regenerate a library ( libORAGLUE.a or libORAGLUE.so ) 
with $CAT_CUST/code/bin/oracleglue.sh:  

z Oracle 8.0.0 and higher: You need to set and export the 
following UNIX variable: 
export _Oracle_8_VPM=YES  

z Oracle 8.0.4 and 8.0.6: You normally do not have to rebuild 
this lib.  

z Oracle 8.0.5: Due to a modification to the include file by 
Oracle the oratypes.h file delivered by Oracle must be edited 
as follows: 
#ifndef lint 
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typedef unsigned long ub4 
typedef signed long sb4 
must be changed to: 
#ifndef lint 
typedef unsigned int ub4 
typedef signed int sb4   

Problem 6 You get the following message during installation: 
Can't open library libPR0ORAC.so 
--> reason = Symbol slpmprodstab : referenced symbol not 
found 
Can't open library libPR0ORAC.so_Connection.so 
--> reason = No such file or directory

Solution z In the genclntsh shell script, comment the line: ar d 
$LIBCOMMON sorapt.o  

z Regenerate the libclntsh library.  

Problem 7 On AIX

Solution Verify that /usr/ibmcxx/bin is correctly initialized in $PATH.

Problem 8 VPMInstall.sh fails at CDMA level

Solution Verify that the path given to the catia.C_STREAM is less than 44 
characters. Usually the path given to this variable is 
$CAT_CUST/InstallVPM/reffiles/DBMS. In that case, you have to 
move the administrator home into a shorter path.
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Problem 9 VPMInstall.sh fails with ABEND U998

Solution Clean the running processes ---> ps -fu VPMADM ---> kill -9 " 
License process numbers". 
Clean the database (see the ENOVIAVPM Installation & 
Administration Guide). 
Relaunch the ENOVIAVPM installation.

Problem 10 Using the PSN fails with ABEND S0004

Solution Add the following declaration parameters: 

CATCDMA.VPM.EXPAND.OLD.BEHAVIOR : logical ; 
CATCDMA.VPM.EXPAND.OLD.BEHAVIOR = TRUE;  

Problem 11 When generating the PSN library on Solaris, if shell script traces are 
ON, an error occurs and the PSN library is not built.

Solution In the script file catpsninst.sh, replace all occurrences of the line: 

VCOMP=‘head -1 $TMP | cut -d"+" -f3 | cut -d"." -f1‘  

with:  

VCOMP=‘tail -1 $TMP | cut -d"+" -f3 | cut -d"." -f1‘  

and replace the line:  
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Compiler Support 

Support of compiler SunOS V5 

The installation supports this new compiler. The following script shells must however be updated:  

  

Update 

To find out the compiler level, log on and enter the following: SunOS> CC -V  

If the version is 5, go into the shells listed above and replace "SunOS" with:  

CC par CC -compat=4  

$SH_LIBPATH $SH_LIB *.o -o libLV0XCDMA.so  

with:  

$SH_LIBPATH $SH_LIB $OBJECTS -o libLV0XCDMA.so  

BuildSchema.sh Compiles and builds the express schema library

VPMExchangesInst.sh Installation shell for VPM export/import mapping 
environment

makeLV0XUSR.sh Installation shell for VPM1 user exits: CATDMUsrMethod

makeVX0AFUSR.sh Installation shell for VPM1 user exits: 
CATVpmAFUsrMethod

makeVX0PEUSR.sh Installation shell for VPM1 user exits: 
CATVpmPEUsrMethod

migrinst.sh Installation shell for migration
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Compiler V5 on Solaris 8 

If problems are encountered, the compiler can be downgraded to level 5.0 .  

Multisite 

1. If you are using DB2 V7 when setting up a multisite environment, before running VPMPostInstall.sh make sure you modify the 
following files: 

$CAT_CUST/InstallVPM/reffiles/DBMS/ddl/create_Tbs_EXPORT_DB2.clp 
$CAT_CUST/InstallVPM/reffiles/DBMS/ddl/create_Tbs_IMPORT_DB2.clp  

to uncomment the "grant" command.  

2. Add the Multisite declaration parameters if they are missing after installation on the PTF1 level. (See the relevant documentation.)  

Updating Your Administrator Environment after each PTF Installation 

1. In your $HOME directory: 
rm -rf InstallVPM directory 
rm DB2_MULTISITE and ORA_MULTISITE directories according to customization 

  

2. Launch VPMInstall.sh -db to update scripts.  
3. Modify files in the DB2_MULTISITE and ORA_MULTISITE directories.  
4. In ORA_MULTISITE, a directory should be created, at the first export, with the export site name.  
5. If not, create this directory and copy inside the different files by default. (Check the Customization guide in VPMPostInstall.sh.)  

Updating Multisite From VPM 1.4 to VPM 1.5 

1. Follow the documentation as described in VPMPostInstall.sh, "Multisite Support".  
2. Site is now inserted in the database using the VX0PESIT utility through the VPMPostInstall.sh procedure. (Do not forget the new 

post-installation settings.) 
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You are prompted to give your " VPM DATABASE NAME DEFINITION ". This means the SITE NAME you want to insert.  

Migrating Multisite from the VPM 1.5 GA Level to the PTF1 Level 

1. Update your Admin directory as previously described.  
2. Copy the $HOME/multisite directory into the $HOME/site directory.  
3. Check to make sure that the file $HOME/site/multisite/PARTLIST.txt is present.  
4. Source . ./env/YOUR.env to be sure that $VPM_DB_IMPORT_CONFIGURATION_FILE is set (DB according to your DBMS)  
5. Launch VPMPostInstall.sh and choose MULTISITE Support/Migration from GA Level to PTF1 Level. A new table should be created.  
6. If nothing is displayed, check your $VPM_DB_IMPORT_CONFIGURATION_FILE  

CATIA V5R7 Interoperability Settings 

The CATSettings definition for VPM database connection must be done at GA Level and set outside interactive CATIAV5/Tools. You need 
to generate CATDbServers.CATSettings as follows:  

1. Logon as VPMADM.  
2. Source the V5 environment.  
3. Launch the V5 CATDBENV utility and set your connection parameters.  

z The file CATDbServers.CATSettings will be generated in $HOME/CATSettings  
z CDM Dictionary and Mapping have to be done in interactive CATIA V5/Tools.  

Multisite - DBLFCDM Data Import/Export Problem 

When importing and exporting DBLFCDM data, model geometry is not loaded into CATIA V4/V5 causing error 803 in DB2 and error -1 in 
ORACLE. To avoid this, do as follows:  

In DB2
Correct the file MS_import_DB2.clp by commenting the line: 

import from %3/INFO_LF.IXF of ixf insert into 
CDMOWNER.INFO_LF ;  

by putting "--" just before it:  
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Declaration Quick Reference 

  

-- import from %3/INFO_LF.IXF of ixf insert into 
CDMOWNER.INFO_LF ;  

In 
ORACLE:

In the directories $MULTI_DIRECTORY/site_name (where "site_name" is the directory 
with the name of the site from where the data is to be imported), correct the file 
authorized_import_files by removing the line INFOLF to avoid importing the fields in the 
table CDM.INFO_LF.

Declaration Parameter catcdma.DBCS.ORACLE
Category Environment Setup Parameter
Purpose This parameter corrects a DBCS character problem affecting P & O requests on 

ORACLE. The default setting is TRUE with the effect that things work as before. 
If FALSE is used instead DBCS characters are supported except on certain items 
in P & O on ORACLE.

Type Logical
Default Value(s) TRUE
Declaration Example catcdma.DBCS.ORACLE=FALSE;

Declaration Parameter catcdma.VPM.MML.CACHE.INCREMENTAL
Category MML
Purpose This parameter is TRUE by default (you are strongly advised, for performance 

reasons, to use TRUE. This means that the MML cache is not fully read each 
time a new MML window is opened or a refresh is made, but is read 
incrementally at each single expand operation. The result is that the MML 
window appears very quickly, but the expand is slower. This behavior is 
particularly useful when dealing with large databases and relatively small MML 
trees.

Type Logical
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Default Value(s) TRUE
Declaration Example catcdma.VPM.MML.CACHE.INCREMENTAL=FALSE; 

(corresponds to the old behavior i.e. prior to VPM 1.3 PTF11)

Declaration Parameter catcdma.VPM.SIMPLE_QUERY.LASTVERSION 
Category Simple query customization
Purpose This parameter indicates whether simple queries should only return the last 

version of the resulting parts, instead of all the versions.  
Note: This parameter is only effective for Part objects and for queries performed 
from the simple query combo box in the main panel: it has no effect on queries 
performed from the query panel.

Type Logical
Default Value(s) FALSE
Declaration Example catcdma.VPM.SIMPLE_QUERY.LASTVERSION=TRUE;

Declaration Parameter catcdma.QUERY.OPERATOR_START_WITH 
Category Advanced query customization
Purpose This parameter indicates whether advanced queries should use the Start With 

operator as default, instead of With.

Type Logical
Default Value(s) FALSE
Declaration Example catcdma.QUERY.OPERATOR_START_WITH=TRUE;

Declaration Parameter catcdma.VPM.GRAPHSESSION.C_COUNT 
Category Graph session
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Purpose This parameter allows you to manage C_COUNT attributes in static PSN 
sessions. 

This means that if a Part has no child, its CATASS attribute will no longer be read 
in the database. Also, when a Part is pasted and cut and the graph is saved, the 
cut link will no longer reappear when the session is read.  

Note that:  

z you need to rebuild the libLV0XCDMA library in order to update the 
cdma.express schema to take into account this correction.  

z These corrections are effective only with new sessions as new data is 
required from the new schema.  

Type Logical
Default Value(s) FALSE
Declaration Example catcdma.VPM.GRAPHSESSION.C_COUNT=TRUE;

Declaration Parameter catcdma.*.IMPORT 
Category Environment Setup Parameter
Purpose This parameter allows you, for a specified user name label, not to write models or 

documents when importing. The representations referenced by the STEP file to 
be imported are neither updated nor created.

Type Logical
Default Value(s) FALSE
Declaration Example catcdma.IMPORTDS203.IMPORT = TRUE ;

Declaration Parameter catcdma.STEP.MODE.REP.IMPORT 
Category Environment Setup Parameter
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Purpose Allows, in the absence of a representation, not to create or update the 
representation metadata during the VPM import process. To do so, the value 
should be set to NONE. 
The default behavior is creation or update of the representation metadata.

Type String
Default Value(s) ' '
Declaration Example catcdma.STEP.MODE.REP.IMPORT=NONE;

Declaration 
Parameter catcdma.VPM.OPT_GRAPH.HIDE_REJECTED_MNGT

Category Environment Setup Parameter
Purpose Automatically hides rejected options in the dictionary 

graph. This simplifies configuration definition by 
reducing the amount of displayed options at each user 
selection.

Type Logical
Default Value
(s) FALSE

Declaration 
Example

catcdma.VPM.OPT_GRAPH.HIDE_REJECTED_MNGT 
= TRUE

 
Declaration Parameter catcdma.VPM.EXPAND.INQMARK

Category Environment Setup Parameter
Purpose For Product Structure queries, this declaration parameter controls the number of 

values in queries such as WHERE $COID IN (?,?, ...). You can change the 
default value, but if you do so, exercise caution. 
If you use a larger number, you minimize the number of queries on the server but 
you need more server memory. If the number you choose is below 75 you need 
less memory on the server but you increase the number of queries. 
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For configuration queries, see catcdma.VPM.CFGDB.MAX_ARG.

Type Integer
Default Value(s) 250
Declaration Example catcdma.VPM.EXPAND.INQMARK= 100

 
Declaration Parameter catcdma.VPM.CFGDB.MAX_ARG

Category Environment Setup Parameter
Purpose For configuration queries, this declaration parameter controls the number of 

values in queries such as WHERE $COID IN (?,?, ...). You can change the 
default value, but if you do so, exercise caution. 
If you use a larger number, you minimize the number of queries on the server but 
you need more server memory. If the number you choose is below 75 you need 
less memory on the server but you increase the number of queries. 
To minimize APP_CTL_HEAP_SZ on a UDB 7.2 server you can set 
CATCDMA.VPM.CFGDB.MAX_ARG to 100. 
For Product Structure queries, see catcdma.VPM.EXPAND.INQMARK.

Type Integer
Default Value(s) 200
Declaration Example catcdma.VPM.CFGDB.MAX_ARG = 100

Declaration Parameter catcdma.VPM.MML.CATIA_V5
Category MML
Purpose This parameter enables you to visualize the CATIA V5 links in the MML graph if 

they exist.
Type Logical
Default Value(s) FALSE
Declaration Example catcdma.VPM.MML.CATIA_V5=TRUE;
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Startup Session 

A startup session is a VPM file containing a run-time environment that the user defines and saves and can then select at login time. This 
means that it opens automatically in VPM and the user can start working directly in his current environment. A session is selected from the 
VPM login panel with a combo box showing the history of the last sessions opened. It is possible to define a new startup session by 
pressing the button, which displays the session file dialog. A startup session file can be a query (.qry) or graph (.psn) file. The type is 
selected using the File type combo box in the session file dialog. Selecting either type automatically activates the corresponding file filter. 
When the selected type is Graph, extra options can be activated:  

Declaration Parameter catcdma.VPM.MML.CATIA_V5_RELEASE_VALIDITY 
Category MML 
Purpose This parameter enables you to visualize the correct CATIA V5 link 

synchronization. 
WARNING! This parameter may prove to be CPU-intensive. 

Type Logical 
Default Value(s) FALSE 
Declaration Example catcdma.VPM.MML.CATIA_V5_RELEASE_VALIDITY=TRUE; 

Declaration Parameter catcdma.PSN.REPLACE_CUSTOM
Category Product Structure customization
Purpose When set to TRUE, this parameter provides access to a new graph, by means of 

the Replace/Custom command in the contextual menu of Part objects in the 
Product Structure, making it possible to replace the selected Part(s) with those 
provided by the dedicated user exit 
CATDMUsrMethod::GetReplaceCustomParts() 
instead of the one in the clipboard.

Type Logical
Default Value(s) FALSE
Declaration Example catcdma.PSN.REPLACE_CUSTOM=TRUE;
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z load mode 
Indicates whether the file should be loaded as a static or dynamic PSN file  

z instance mode 
Indicates whether all branches are to be opened or selected ones  

z viewer 
Indicates if a viewer (CATIA, 4D Navigator, etc.) should be started automatically so that the selected instances as referenced in the 
graph files can be directly loaded into it.  

If None is selected in the history combo box, VPM will be started as usual without any session file opening.  

Note that:  

z Startup sessions are made available by setting to YES the VPM variable VPM_STARTUP_SESSION  
z If the variable VPM_STARTUP_SESSION_AUTO is also set to YES, the login process will resume automatically as soon as a 

session file is selected (i.e. the user will not have to press the OK button).  

MML 

PTF1 

The Print Tools menu has been added to the MML editor. This menu is similar to the File menu in the PSN in that it contains the following 
items:  

z Configure printers 
Enables default printer configuration  

z Print graph 
Prints the current graph  

z Capture graph 
Captures the current graph in bitmap or vector format  

z Capture album 
Stores and visualizes captured images.  

The behavior of the declaration parameter catcdma.VPM.MML.CACHE.INCREMENTAL has been modified.  
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PTF2 

The environment(s) to be used for searching for MDLTOMDL-type MML links must now be defined by selecting the File->Settings... menu 
item and then the Relation tab. There are three options defining the environment(s) where database requests are to be made:  

z All environments  
z Current environment  
z Selected environments.  

PTF3 

z The Identify function allows you to select a solid in the CATIA V4 viewer and then see highlighted in the MML graph the models 
pointing to the selected solid. To use this function, place the cursor on the model objects in the graph and then select Identify in the 
contextual menu. 
IMPORTANT! Remember to load the model into the CATIA V4 viewer beforehand.  

z AT0MIGMML can be used for batch migration of MDLTOMDL links to ENTITY links. This batch writes the ENTITY links and deletes 
the MDLTOMDL links of an MML structure. The command to be used should look like this: 

AT0MIGMML -file <file name> -user <VPM user>  

You can add other optional arguments:  
{ -role <VPM role for the user>  
{ -org <VPM organization for the user>  
{ -pwd <user password>  

The input file contains information about the root model of the structure. The structure is expanded in Impacted By mode and all the 
MDLTOMDL links found between models are then migrated. The file looks like this:  

  
<CAENV> 
<CATAB> 
<COID> (hexa format) 
<COMPID> (hexa format)  

The declaration parameter for MML link creation must be set correctly:  
CATCDMA.MML_TYPE_EXPORT = 'ENTITY';  
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The L3016MML module must be built beforehand. As L2011MML is identical to L3016MML, you can refer to the L2011MML 
synchronization module construction process described in "Building the Synchronization Batch Executable Program" in the section 
"Customizing V4 Multimodel Link Dependencies" of the ENOVIAVPM Installation and Administration Guide.  

The script shell declaration parameter must also be correctly valuated:  
CATCDMA.VPM.MML.MIGRATE.SCRIPT : STRING; 
CATCDMA.VPM.MML.MIGRATE.SCRIPT = ’/tmp/bin/MMLMigr.sh’;  

Note that the location where the script shell can be found by VPM is:  
/tmp/bin/MMLMigr.sh  

(MMLMigr.sh is delivered as a command sample.)  

z The environments where MML requests are to be made are now defined by the File->Settings->Relation command. For example, an 
MML link between an entity of environment A and an entity of environment B will only be seen if both environments are selected.  

PTF4 

Using V4 Multi-Model Link Dependencies  

Context Menus on Objects  

z Identify - Allows you to identify the models containing a solid used in the reference model. 
Note: The reference model must be loaded in CATIA V4 beforehand. 
The Identify menu starts a dialog in CATIA V4. You must then select an exact solid (SolidE); the MML graph will highlight the 
models where this solid is used.  

MultiCAD 

PTF1 

Until now, the MultiCAD server used a login file in server authentication mode. It is now MANDATORY whatever the mode.  

To create this file:  
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1. In the PNO panel in VPM, select the menu item Setup->Batch login creation. 
The "Batch Login" panel appears.  

2. Complete all the fields in this panel. 
The name of  the application must be LV0SRVXC.  

For more information, see "Batch Login File Creation and Usage" in the ENOVIAVPM Installation and Administration Guide 
(Basic Tasks->People & Organization Administration->Managing the Setup).  

PTF2 

z The MultiCAD server can now accommodate the name of the VPM user as an argument (the UNIX user is the default). 
Example: LV0SRVXC vpm_user  

z Generation of cgr, NCGM, etc. for ProE documents: 
The V5 utility CATDMUUtility does not accept .prt file names in uppercase. Similarly, when requesting NCGM output the root of the 
name must be in lowercase. 
Using the shell CATStartV5GenXCADFilesPRTNCGM.sh will solve these problems for the moment. 

IMPORTANT! Remember to customize the declaration parameter:  
CATCDMA.VPM.PRT.TO.V5='CATStartV5GenXCADFilesPRTNCGM.sh ....';  

where .... represents any options you may wish to specify.  

CATStartV5GenXCADFilesPRTNCGM.sh looks like this:  
#!/bin/ksh 
#========================================================================= 
# 09/08/1999 : Create 
# V5 environment initialization 
# Generation of the launching shell generating Format, BoundingBox and 3Dmap 
#========================================================================= 
fileSH=$1"sh" #Temporary file 
fileLOG=$1"log" #Trace file 
fileTyp="prt" 
t1=‘echo $2 | cut -d"\"" -f2‘  
fileOri=‘echo $t1 | cut -d"\"" -f1‘  
fileNew="/tmp/"$$"."$fileTyp 
cp $fileOri $fileNew 
shift 2 
#cmdParam="-f "$fileNew" "$* 
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unset ncgmNew 
cmdParam="-f "$fileNew" " 
typeset -i t=0 
typeset -L1 tiret 
for i in $* 
do 
tiret=$i 
if [[ $tiret = ’-’ ]] ; then 
if [[ $i = "-NCGM" ]] ; then 
t=1 
fi 
cmdParam=${cmdParam}${i}" " 
else 
if [ $t = 1 ] ; then 
ncgmOri=$i 
ncgmNew="/tmp/"$$".NCGM" 
cmdParam=${cmdParam}${ncgmNew}" " 
t=0 
else 
cmdParam=${cmdParam}${i}" " 
fi 
fi 
done 
#========================================================================= 
#V5 environment settings 
. CustoVpmToV5.sh CATIA 
#========================================================================= 
#Set up the utility launching shell : file $fileSH 
echo "#!/bin/ksh" > $fileSH 
echo "unset PANELV2ODOTOP" >> $fileSH 
echo "CATDMUUtility $cmdParam > $fileLOG 2>&1" >> $fileSH 
echo ’stat=$?’ >> $fileSH 
echo ’exit $stat’ >> $fileSH 
#========================================================================= 
#Ok, launch the utility 
chmod 777 $fileSH 
$V5_Starter -run $fileSH 
stat=$? 
if [ -a $fileNew ]; then 
\rm $fileNew 
fi 
if [ $ncgmNew ]; then 
if [ -a $ncgmNew ]; then 
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mv $ncgmNew $ncgmOri 
fi 
fi 
unset PANELV2ODOTOP 
if [ -a $fileSH ]; then 
\rm $fileSH 
fi 
exit $stat  

  

z The shell VPMStart.sh has been modified. The new version should be copied from the tar file (see Administration shell scripts).  

Program Level Information 
All the problems fixed in ENOVIAVPM Version 1 Release 2 until PTF 4 have been incorporated into ENOVIAVPM Version 1 Release 5.  

PTF1 Update 
REMEMBER to rebuild the user exits!  

User exit sample resides under $CATIA/code/sample .  

Declaration Parameters 

z For correction of a character problem in P & O on ORACLE, see catcdma.DBCS.ORACLE  
z The behavior of the declaration parameter catcdma.VPM.MML.CACHE.INCREMENTAL has been modified.  

Startup Session 

MML 
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Multisite - DBLFCDM Data Import/Export Problem 

Cumulative Fixes PTF1 

Free Text PTF1 

OS UB OS UB OS UB OS UB
IX UB88358 HP UB88341 SG UB88351 SU UB88362

IX UB88338 HP UB88363 SG UB88343 SU UB88333

IX UB88335 HP UB88347 SG UB88340 SU UB88352

IX UB88349 HP UB88355 SG UB88360 SU UB88337

IX UB88357 HP UB88348 SG UB88359 SU UB88361

IX UB88346 HP UB88342 SG UB88344 SU UB88364

IX UB88336 HP UB88356 SG UB88350 SU UB88334

IX UB88354 HP UB88345 SG UB88339 SU UB88353

AFL z HC79142: Concurrent accesses of an Action cause loss of information.  
z When an Action is created from a MML graph, the model is now associated as a 

model and not as an external file.  

BOM
z PB deployment part  
z Core dump after copy VPM-A / paste PSN / Commit  
z HC81369: Growth of table LF0001  
z HC78277: Cycles are not prevented when links are created within VPMA.  
z HC81997: When a model attribute is changed, there is a different result in VPM 

1.3 PTF9 and 1.2 PTF12.  
z HC72433: In the PSN boxes and in the PROPERTY panel, an integer is now 

displayed with the number of digits declared 
through the MAX value in the profile.  

z The cdma_id in the .pst are cleaned up for next storages.  
z When a VPM 1.3 session was read in VPM 1.4, it was dynamic and without any 
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filter (the .pst and .vlm were not taken into account). Now it may be dynamic or 
static and the CSB filter is applied.  

z HD00034: Not possible to use VPM filter in batch mode.  

CFG z HC81505: The user can update link information by part of configured old version.  
z Option/Category rename from corporate to update the whole database  
z The following links can now be filtered by effectivity: Part-Feature,  Part-

Document, Part-Model.  

Install z A sample Feature table has been created in the default VPMENV environment. 
This table is now available as soon as a new installation is performed.  

z A correction has been delivered related to VPM + ORACLE 817 + AIX. The shell 
rootpre.sh must be applied to every VPM client, under AIX + Oracle 817 and 
higher.  

Interoperability 
3dcom

z HC78949: When declaring more than 20 datalink servers, we cannot read or write 
CATIA models.  

z Memory clean up has been enhanced.  
z The performance of the EDIT CONFIG ON THE FLY has been upgraded.  
z The performance of XML generation has been enhanced.  
z The _Creatable attribute has been added.  
z A core dump has been corrected when a profile error occurred.  
z The AUTHORIZED and HELP values have been tuned up so that the Portal 

works correctly on the & symbol.  

Interoperability 
CATIA V5

z Version/revision has been set up for V5 MMLs.  
z The doc/doc links are displayed in the PSN.  

Miscellaneous z HC77248: Call repeated to the trace files tracdmax  
z In the Settings panel, a Units tab has been added. It is possible to modify 

interactively the active unit of each magnitude described in the CATUNI.dcls file.  

P & O z VPMPeopleImport does not import the P&O structure properly.  

PSN z HC80633: Copy/paste or paste same position  
z HC78236: Cycles in the PSN tree cannot be deleted  
z The OPEN IN NEW contextual menu has been added for a VPM document in the 

PSN.  

Publish 
Subscribe z Implicit subscriptions do not work for Subscribe with replication  
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PTF2 Update 
REMEMBER to rebuild the user exits!  

User exit sample resides under $CATIA/code/sample .  

Declaration Parameters 

z For simple queries to provide only the last version of the resulting parts, see catcdma.VPM.SIMPLE_QUERY.LASTVERSION.  

MultiCAD 

MML 

CATIA V5 / ENOVIAVPM Interoperability 

In the ENOVIAVPM User’s Guide, (Advanced Tasks->Interoperability->CATIA V5 / ENOVIAVPM Interoperability, in the section "From CATIA 
V5 to ENOVIAVPM") it is stated that assembly constraints cannot be saved. In fact, such constraints CAN be saved.  

VPM Process/Privilege Security 

Access to VPM is only possible through roles to which the VPM.Login process is granted. A user must therefore have a valid role attached 
in order to access the application, even though the VPM user is correctly declared in the P&O database. Granting access to VPM.Login 
process directly to users will not provide them with login capability. Moreover, a role that does not have a privilege granted for that process 
will not provide login access.  

Note : For performance purposes, the privilege on VPM.Login must be defined directly on the process itself ; defining it on a process 

Revisioning z HC81373: Update version with lowercase  

Page 105 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



group containing the process will not make the role selectable for login.  

Cumulative Fixes PTF2 

Free Text PTF2 

OS UB OS UB OS UB OS UB
IX UB89046 HP UB89043 SG UB89054 SU UB89055

IX UB89048 HP UB89041 SG UB89060 SU UB89040

IX UB89038 HP UB89037 SG UB89042 SU UB89036

IX UB89051 HP UB89052 SG UB89050 SU UB89057

IX UB89044 HP UB89061 SG UB89056 SU UB89059

IX UB89062 HP UB89045 SG UB89053 SU UB89035

IX UB89047 HP UB89039 SG UB89058 SU UB89049

AFL z Concurrent access to an Action causes loss of information.  
z Action modification is possible for a non-authorized person.  
z Secondary ID of Actions limited to 18 characters. It is now possible to enter as many as 

50 characters.  
z An Action is not created when an existing Action has been opened.  
z An Action promote is not possible if the Action has not been previously stored.  
z Doc cannot be added to the Action interface.  
z The abend S0004 occurs when you transfer an Action using USER and 

ORGANIZATION, and when you select it using P&O.  

BOM
z The Unsubscribe function does not work with DB2.  
z The abend S11 occurs when a timestamp-customized attribute is valuated.  
z There is a problem with the Select Object function in PSN with V5 documents.  
z A new version cannot be created.  

CFG
z Milestone dates cannot be modified to the future.  
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PTF3 Update 

WARNING! 
Updating the VPM Administrator is mandatory for VPM1.5 PTF3 

Why? 
New code (orchmod.c) has been added for use by the connection load module OB071USX. Updating the administrator is the only way for 
this new code to be taken into account.  

How to update the administrator 
Use the tool catinst by means of the menu Configure Step By Step->Create/Update Administrator Environment.  
This updates the file OB071USX in $CAT_CUST/code/src with the result that the syntax becomes FileName.update_mm:dd:yy. 
You must then rename this to FileName to regenerate the OB071USX load.  
Example: mv OB071USX.update_10:11:01 OB071USX  

WARNING! 
Building the connection load module OB071USX is mandatory for VPM1.5 PTF3 

Why? 
Because new code has been added (see WARNING! above)  

How to build OB071USX 
Prerequisite: The VPM administrator should be updated after having unloaded the PTF3.  

z When effectivities are committed at the same time, the result is corrupted.  

MML
z Versioning of MML links  

Multisite
z Models stored in DBLFCDM mode are not imported properly.  

User 
Exits z The APIs OpenGraph and GetEnvironment are missing.  
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There are two ways to do this:  

z manual  
z automatic  

Manual Method 

1. Log on as vpm admin.  
2. Initialize VPM: 

cd env 
. VPMWsUser.sh  

3. Move or remove the old load module OB071USX from $CAT_CUST/code/steplib/OS .  
4. Create the new load module OB071USX: 

oruecl  

=> the OB071USX should have been created in $CAT_CUST/code/steplib/OS  

Automatic Method 

1. Use the VPMInstall.sh shell with a specific option (-oracle / -db2).  

Error Message 

If, when trying to run oruecl to create the OB071USX module, you get an error message such as:  

cc: "/apps/vpm/vpmadm/code/src/orchmod.c", line 31: error 1705: Function prototypes are an ANSI feature.  

open the file orchmod.c in the VPM administrator directory $HOME/code/src and replace lines:  

int orchmod (char *oper, char *path, char *mode, int *err)  
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with:  

int orchmod (oper, path, mode, err) char *oper; char *path; char *mode; int *err;  

and  

void ormount (char *accmet ,char *madata ,int *lg_madata ,char *dbca )  

with:  

void ormount (accmet, madata, lg_madata, dbca) char *accmet; char *madata; int *lg_madata; char *dbca;  

MML 

Multisite 

Cumulative Fixes PTF3 

OS UB OS UB OS UB OS UB
IX UB94941 HP UB94936 SG UB94949 SU UB94939

IX UB94946 HP UB94937 SG UB94954 SU UB94950

IX UB94947 HP UB94938 SG UB94957 SU UB94951

IX UB94952 HP UB94940 SG UB94958 SU UB94956

IX UB94953 HP UB94942 SG UB94959 SU UB94964

IX UB94955 HP UB94943 SG UB94962 SU UB94966

IX UB94960 HP UB94944 SG UB94965 SU UB94967

IX UB94961 HP UB94945 SG UB94969 SU UB94968

IX UB94963 HP UB94948 SG UB94971 SU UB94970
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Free Text PTF3 

PTF4 Update 
REMEMBER to rebuild the user exits!  

User exit sample resides under $CATIA/code/sample  

Mandatory Modification to be Made to the VPM1.5 PTF4 Level 

MML 

The secondary Action IDs were previously limited to 16 characters. It is now possible to use as many as 50. This involves the attribute 
PUBLISHER_OID with the format char(50) in the tables VPMADM.EXP_SUBSCRIBERS and VPMADM.PUBLISHED_EVENTS. The 
bases created with versions prior to VPM 1.4 used the format char(16) for the attribute PUBLISHER_OID. The scripts 
update0_PUBSUB.sqlfor ORACLE and update0_PUBSUB.clp for DB2 enable you to make this update ($CATIA/vpm/reffiles/DBMS/ddl) if 
required.  

Admin z HC81670: .in files generated on HP are different than those generated on AIX.  

BOM z HC82569: The drawing of the cursor represents a one-way road sign.  
z HC84774: The viewer specified by Open a graph session cannot be started.  

CFG z HC84980: EPMR: Create config handler API problem  
z HC82234: Incident I250 : Proposed effectivity and action recreate processes in 

VPM are not correctly covered by the corresponding privileges.  
z HC85170: Call the Print part list function. The files in the directory are not listed.  

Interoperability z HC82393: There is no way to redirect /tmp to a larger file system with 3dcom.  

MML z HC84001: Problem synchronize MMLs with the option This Level  

STEP z HC78482: Incident I277: Step export list does not include Parts displayed in the 
config handler by default.  
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IMPORTANT!  

z This operation drops these two tables and recreates them as well as the associated indexes.  
z The data using the format char(16) can no longer be used in the format char(50) and can therefore not be migrated.  

Problem Opening the PSN 

If, when the PSN is opened, there is a coredump with the following error message:  

Run-time error, libC: 
’delete[]’ does not correspond to any ’new[]’  

you have to create the table ALTERNATE_SHAPE (UPORASHA UPORAGRA for ORACLE, UPDB2SHA UPDB2GRA for DB2) then 
recreate the PSN library (libLV0XCDMA).  

This will be corrected in the next PTF.  

Versioning 

When a V5 document saved in VPM is revisioned (and of course also when the Part containing such a document is versioned), remember 
that for the elements associated with this V5 document (Publications) to be transferred to the new revision, the profile must contain the 
following:  

ASSIGN ’FEATURE, FEATSPEC, FEATURES, Publication, ContextInput, Connection ’ TO 
"GLOBAL_$LIST_FEATURE_DUPLICATE";  

VPMInstall.sh 

Correction to the Administrator Update Operation 

1. Log on as root.  
2. cd $CATIA/vpm/code/command ($CATIA of the PTF4 configuration)  
3. Edit the file CpInstFiles.sh replacing: 
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save_dir $CAT_SITE/multisite 
rc4=$?  

with:  

save_dir $CAT_SITE/multisite 
rc4=$? 
save_dir $CAT_CUST/code/bin 
rc5=$?  

and  

let "rc=( $rc1 || $rc2 || $rc3 || $rc4 )"  

with:  

let "rc=( $rc1 || $rc2 || $rc3 || $rc4 || $rc5 )"  

  

4. Log on as VPM administrator.  
5. cd $CATIA/vpm/code/command ($CATIA of the PTF4 code)  
6. Run the shell script with the following parameters:  

CpInstFiles.sh $CATIA$CAT_CUST UPDATE  
7. To update the VPM environment, run: 

$CATIA/vpm/code/command/VPMInstall.sh -db2 or -oracle  
8. Check to make sure you have the proper PATH set. For example, the command type oruecl should return $CATIA/code/bin/oruecl 

$CATIA/code/bin/oruecl with $CATIA equal to the PTF4 configuration.  

Corrections to Be Done Prior to VPM Migration 

z In the file $CAT_CUST/code/bin/Migrate_Prepare_files_Oracle.s 

replace:  
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VPMADM13|vpmadm13)cat $cpfile|sed -e "s!VPMADM13!$U_VPM_ADMINISTRATOR!g" -e "s!vpmadm13!$U_VPM_ADMINISTRATOR!

g">$cpfile1;;  

with:  

VPMADM13|vpmadm13)cat $cpfile|sed -e "s!VPMADM13!VPMADM!g" -e "s!vpmadm13!vpmadm!g">$cpfile1;;  

  

z In the file $CAT_CUST/code/bin/Migrate_VPPARCUS_generation.sh 

replace:  

###################################################################  
# check if catcdm.c_stream is defined for $CAT_CUST/MIGRATION #  
###################################################################  
VPPARCUS_PLACE=‘catpath catcdm.c_stream VPPARCUS‘  
rc=$?  
if [[ $rc -ne 0 ]] ; then  
echo "catcdm.c_stream = ’$CAT_CUST/MIGRATION’ ;" >> $CATMSTR  
rc=0  
fi  
VPPARCUS_PLACE=‘catpath catcdm.c_stream VPPARCUS‘  
if [[ $VPPARCUS_PLACE != $CAT_CUST/MIGRATION/VPPARCUS ]] ; then  
if [[ $TRACE_VPM -ge 1 ]]; then set -x ; else tput clear ; fi  
printf "\n\n"  
printf "\t**********************************************************************\n"  
printf "\t* WARNING: *\n"  
printf "\t* catpath catcdm.c_stream VPPARCUS does not return *\n"  
printf "\t* \$CAT_CUST/MIGRATION/VPPARCUS *\n"  
printf "\t* *\n"  
printf "\t* Please edit your \$CATMSTR file and add the following: *\n"  
printf "\t* catcdm.c_stream = ’$CAT_CUST/MIGRATION’ ;\n"  
printf "\t* *\n"  
printf "\t* in order to use the proper command streams files. *\n"  
printf "\t* *\n"  
printf "\t**********************************************************************\n"  
press_enter  
rc=1  
return $rc  
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fi  

with:  

###################################################################  
# check if catcdm.c_stream is defined for $CAT_CUST/MIGRATION #  
###################################################################  
VPPARCUS_PLACE=‘catpath catcdm.c_stream VPPARCUS‘  
if [[ $VPPARCUS_PLACE != $CAT_CUST/MIGRATION/VPPARCUS ]] ; then  
if [[ $TRACE_VPM -ge 1 ]]; then set -x ; else tput clear ; fi  
printf "\n\n"  
printf "\t**********************************************************************\n"  
printf "\t* WARNING: *\n"  
printf "\t* catpath catcdm.c_stream VPPARCUS does not return *\n"  
printf "\t* \$CAT_CUST/MIGRATION/VPPARCUS *\n"  
printf "\t* *\n"  
printf "\t* The following will be added to your \$CATMSTR file : *\n"  
printf "\t* *\n"  
printf "\t* erase catcdm.c_stream ;\n"  
printf "\t* catcdm.c_stream = ’$CAT_CUST/MIGRATION’ ;\n"  
printf "\t* *\n"  
printf "\t* in order to use the proper command streams files. *\n"  
printf "\t* *\n"  
printf "\t**********************************************************************\n"  
press_enter  
echo "erase catcdm.c_stream ;" >> $CATMSTR  
echo "catcdm.c_stream = ’$CAT_CUST/MIGRATION’ ;" >> $CATMSTR  

fi  

Cumulative Fixes PTF4 

OS UB OS UB OS UB OS UB
IX UB96033 HP UB96064 SG UB96043 SU UB96074

IX UB96030 HP UB96061 SG UB96058 SU UB96067

IX UB96065 HP UB96060 SG UB96024 SU UB96068

IX UB96038 HP UB96062 SG UB96063 SU UB96039
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Free Text PTF4 

IX UB96053 HP UB96044 SG UB96029 SU UB96076

IX UB96023 HP UB96073 SG UB96027 SU UB96066

IX UB96021 HP UB96052 SG UB96040 SU UB96054

IX UB96046 HP UB96059 SG UB96031 SU UB96075

IX UB96022 HP UB96056 SG UB96032 SU UB96057

IX UB96047 HP UB96034 SG UB96055 SU UB96045

IX UB96049 HP UB96048 SG UB96036 SU UB96070

IX UB96025 HP UB96072 SG UB96035 SU UB96071

IX UB96028 HP UB96050 SG UB96042 SU UB96069

IX UB96041 HP UB96037 SG UB96026 SU UB96051

AFL z HC84163: When an attempt is made to promote an Action from the In Work 
status VPM terminates abnormally and the Action data is broken.  

z HC84395: There is no update of the CATASS link with a Creation/Cut function 
on the same Action.  

z HC85667: After recreating a corrupted action, the links are lost.  
z HC86407: There is a VPM abend during a New Query in an object Action.  

BOM z HC57244: There is a VPM abend after a cut and paste operation when the 
model has been translated.  

z HC80939: The Where Used function does not work correctly.  
z HC82490: It is impossible to create/duplicate if one of the IDs (S_*) is a data 

attribute.  
z HC82613: There is no scrollbar in the choice list of the Advanced Query.  
z HC84015: There is a problem with the PDF encrypted file.  
z HC84213: View access by means of a user exit  
z HC84308: There is a problem on the DLFM server when you save any 

document in VPM.  
z HC83870: It is impossible to update a CatPart.  
z HC85102: There is a problem when updating the document in VPM.  
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z HC85121: The ITFCHECK result is not returned to VPM / database.  
z HC84543: There is an error with a duplicate function.  
z HC85947: Undeclared parameters are issued on the UNIX terminal when a 

model is loaded into CATIA from the VPMA window.  
z HC85846: The cgr is not updated after modification of a document stored in 

datalinks.  
z HC87178: Starting the DMU Navigator from the PSN results in an abend.  

CFG z HC85229: The proposed effectivity does not allow a complex effectivity 
-> CATCDMA.VPM.COMPLEX_PROPOSED_EFF (logical)  

z HC84553: The VPM Configuration Handler Change Ownership fails.  
z HC84562:  The info link effectivity displays m2->m1 when m1->m2 is 

expected.  
z HC85371: The effectivity is corrupted after replacing a Part version.  
z HC86230: Part-Options is incorrectly displayed in the PSN when milestones 

are defined covering the range of the affected Parts.  
z HC85746: There is an abend S06 with a proposed effectivity function.  
z HC85874: Milestones are lost after versioning a Part.  
z There is effectivity corruption after a new Part version.  
z Demote on configurable Part until delete without unset configurable  
z Configuration analysis on a configurable Part without effectivities on sub-

assembly  
z Hours / minutes / seconds on effectivities are not taken into account during an 

expand.  
z Display milestone in Child / Parent Analysis  

Publish/Subscribe z HC85756: The SUB/PUB function with the event write with like consequence a 
replicate nook  

z The MODEL.write event is published when doing a Catia File/Save.  
z New events PART/MODEL/DOCUMENT/.Rename on rename function -> 

update5_PUBSUB.sql/clp must be used  

CDMA z HC83989: There is a security problem with a CDMA profile for RENAME and 
DELETE in the PSN.  

z HC85688: Launching 4D Navigator from the PSN   

Multisite
z HC85881: The function enabling the import/export of a process group does not 

work.  
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PTF5 Update 
REMEMBER to rebuild the user exits!  

z HC87103: The column C_SITE_RESPONSIBLE is created on a non-multisite 
environment.  

z Replication tools for Publish/Subscribe (VX0RPELP)  
z Possibility to modify User / Organization when performing a transfer to a site  
z Transfer To Site is inhibited if the data does not belong to the user (the 

process VPM.BOM.UpdateOwnership is taken into account).  

P&O z HC83383: The function Paste Quantity in the contextual menu of the Part is 
available although the process CeateRelation is not granted in P&O.  

z P&O clusters and Pub/sub clusters : display problem for "<=" comparator  
z P&O export : Process group import / export (VPMPeopleImport)  

PSN z HC79003: There is a memory leak in the VPM PSN expansion.  
z HC79232: The Part whose data does not exist counts by computing the 

number of children.  
z HC80758: There is a duplicated representation of a new document in the PSN 

after the association of a new document.  
z HC87215: There is a response time problem during a graph expand.  
z HC87625: The PSN cut and paste does not work.  
z The PSN does not close after File / Close / Save changes.  
z Opening a .psn file with options other than dynamic + all instances does not 

work.  
z The privilege BOM.ModifyRelation is taken into account when C_COMMENT 

is edited in the info-link panel.  

STEP z New option - mod 2 into psnmigex.sh  
z There is a coredump when exporting (PDM_SCHEMA+config) a configurable 

part without a child part (CATASS=0).  

APIs z CATDMUsrInstance::ReplaceChild()  
z CATDMUsrInstance::AddChild()  

Note that the arguments for these two APIs have changed. 
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User exit sample resides under $CATIA/code/sample  

Building the BOM User Exit Library (libLV0XUSR.*) 

To build the BOM user exit library (libLV0XUSR.*), go into the shell makeLV0XUSR.sh and replace:  

optI="$optI -I$VPM/PublicInterfaces"  

with:  

optI="$optI -I$VPM/PublicInterfaces -I$CATIA/code/include"  

Potential Performance Enhancement (VPM1.5 PTF5) 

To obtain the enhancements described above, do as follows:  

Expand PSN Tree in VPM1.5 PTF5 

Impacted 
Functionality Performance Enhancement

Expand PSN Tree z almost 20% in CPU time on the VPM client, between VPM1.3 PTF13 and 
VPM1.5 PTF5  

z almost 40% in CPU time on the VPM server, between VPM1.3 and VPM1.5  
z on memory leaks: as much as 80% has been gained between VPM1.3 and 

VPM1.5  
z 30% in total memory used by the VPM process, on the VPM client, between 

VPM1.3 and VPM1.5  

Expand PSN Web 
Tree on NT

z an improvement of almost 70% in CPU time on the NT client, on VPM1.5 by 
means of a new variable  

Open in DMU when 
loading models into 
DMU

z almost 60% in CPU time on the VPM client, between V5R6SP4 and 
V5R7SP6 or V5R8GA  
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Work with the dictionary in memory  

1. Edit the file CATCDM.dcls by replacing the line: 

DB2  

catcdm.DBCONN.DB2.MODULE = ’JD061DIB’ 
with: 
catcdm.DBCONN.DB2.MODULE = ’JD062DIM’;  

ORACLE  

catcdm.DBCONN.ORACLE.MODULE = ’JD061DIB’ 
with: 
catcdm.DBCONN.ORACLE.MODULE = ’JD062DIM’;  

Customize your database to add the C_COUNT attribute  

Expand queries on leaf Parts and on non-configured Parts have been improved. A system column is added to the part_list table: 
C_COUNT (type varchar). The column format is: ’c:c:’ 
The first c takes the value ’Y’ if the Part has at least one CATASS link, ’N’ if there is no CATASS link or ’U’ if unknown. 
The second c  takes the value 'Y' if the Part is configured, 'N' if not configured or 'U' if unknown. 
Database triggers to update this column must be created using the provided update_EXT sql script.  

Step 1: To update the tables, play, for each environment, the update_EXT script sql:  

DB2 

1. In the DB2 script 
$HOME/InstallVPM/reffiles/DBMS/ddl/MS_conf_migr_DB2.clp
replace VPMADM with the VPM Administrator value.  

2. Run the DB2 script 
$HOME/InstallVPM/reffiles/DBMS/ddl/MS_conf_migr_DB2.clp

3. Replace the DB2 script update_EXT.clp (in 
$HOME/InstallVPM/reffiles/DBMS/ddl of the VPM administrator) 
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with the following: 

-------------------------------------------------- 
-- (c) Dassault Systemes 2002 
-------------------------------------------------- 
-- Mandatory : NO  
--  
-- update_EXT.clp  
--  
-- Description :  
-- expand PSN Graph performance improvement  
-- Alter VPMENV.PART_LIST ( add column C_COUNT )  
-- Create trigger VPMENV.EXT_AFTER_INSERT on VPMENV."$EXT"  
-- Create trigger VPMENV.EXT_AFTER_DELETE on VPMENV."$EXT"  
-- Update C_COUNT of VPMENV."PART_LIST"  
-- Create trigger VPMENV.CI_AFTER_INSERT on "VPMADM"."configuration_item_"  
-- Create trigger VPMENV.CI_AFTER_DELETE on "VPMADM"."configuration_item_"  
-- Update C_COUNT of VPMENV."PART_LIST"  
--  
--  
-- VPM Level : VPM1.5 PTF5 and above  
--  
--  
--  
-- DB2 Only  
--  
-- C_COUNT column internal VPM usage  
--  
-- CHAR [1] -> $EXT $TYPE= ’CATASS’  
-- CHAR [3] -> CONFIG_ITEM  
--  
alter table VPMENV.PART_LIST  
add C_COUNT VARCHAR(30) default ’U:U:U:UUUUUUUU:UUUUUUUU’;  
-- ============================ INSERT EXT 
===============================  
drop trigger VPMENV.EXT_AFTER_INSERT;  
create trigger VPMENV.EXT_AFTER_INSERT  
after insert on VPMENV."$EXT"  
referencing new as mynew  
for each row mode db2sql  
update VPMENV.part_list set "C_COUNT" = ’Y’ || substr ( "C_COUNT" , 2)  
where "$COID" = mynew."$COID" AND mynew."$TYPE" = ’CATASS’;  
-- ============================ DELETE EXT 
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===============================  
drop trigger VPMENV.EXT_AFTER_DELETE;  
create trigger VPMENV.EXT_AFTER_DELETE  
after delete on VPMENV."$EXT"  
referencing old as myold  
for each row mode db2sql  
update VPMENV.part_list set "C_COUNT"= ’U’ || substr ( "C_COUNT" , 2)  
where "$COID" = myold."$COID" AND myold."$TYPE" = ’CATASS’;  
-- =========================== UPDATE 
==================================  
-- =========================== UPDATE FOR 
’Y’===========================  
update VPMENV.part_list part  
set part."C_COUNT" = ’Y’ || substr ( part."C_COUNT" , 2)  
where (( select count(1) from VPMENV."$EXT" ext where ext."$COID" = part."$COID"  
and ext."$TYPE" = ’CATASS’ ) > 0 ) ;  
-- =========================== UPDATE FOR ’N’ 
==========================  
update VPMENV.part_list part  
set part."C_COUNT"= ’N’ || substr ( part."C_COUNT" , 2)  
where ( ( select count(1) from VPMENV."$EXT" ext where ext."$COID" = part."$COID"  
and ext."$TYPE" = ’CATASS’ ) = 0 );  
-- CONFIG_ITEM  
-- ============================ INSERT CI 
===============================  
drop trigger VPMENV.CI_AFTER_INSERT;  
create trigger VPMENV.CI_AFTER_INSERT  
after insert on VPMADM."configuration0001_"  
referencing new as mynew  
for each row mode db2sql  
update VPMENV.part_list  
set "C_COUNT" = substr("C_COUNT",1,2) || ’Y’ || substr ("C_COUNT",4)  
where "$COID" = mynew."$COID" AND mynew."CAENV" = ’VPMENV’;  
-- ============================ DELETE CI 
===============================  
drop trigger VPMENV.CI_AFTER_DELETE;  
create trigger VPMENV.CI_AFTER_DELETE  
after delete on VPMADM."configuration0001_"  
referencing old as myold  
for each row mode db2sql  
update VPMENV.part_list  
set "C_COUNT" = substr("C_COUNT",1,2) || ’U’ || substr ("C_COUNT",4)  
where "$COID" = myold."$COID" AND myold."CAENV" = ’VPMENV’;  
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Step 2: To set the declaration parameter, add the following to your CATIA declaration file:  

CATCDMA.VPM.EXPAND.C_COUNT : LOGICAL; 

-- =========================== UPDATE 
==================================  
-- =========================== UPDATE FOR 
’Y’===========================  
update VPMENV.part_list part  
set "C_COUNT" = substr("C_COUNT",1,2) || ’Y’ || substr ("C_COUNT",4)  
where (( select count(1) from VPMADM."configuration0001_" ci where ci."$COID" = 
part."$COID"  
and ci."CAENV" = ’VPMENV’ ) > 0 ) ;  
-- =========================== UPDATE FOR ’N’ 
==========================  
update VPMENV.part_list part  
set "C_COUNT" = substr("C_COUNT",1,2) || ’N’ || substr ("C_COUNT",4)  
where ( ( select count(1) from VPMADM."configuration0001_" ci where ci."$COID" = 
part."$COID"  
and ci."CAENV" = ’VPMENV’ ) = 0 );  

  

4. Replace VPMENV with the environment name and VPMADM with the 
VPM Administrator name.  

5. Run update_EXT.clp.  

Oracle  

1. In the Oracle script 
$HOME/InstallVPM/reffiles/DBMS/ddl/MS_conf_migr_Oracle.sql replace 
VPMADM with the VPM Administrator value.  

2. Run the Oracle script 
$HOME/InstallVPM/reffiles/DBMS/ddl/MS_conf_migr_Oracle.sql  

3. Replace VPMENV with the environment name and VPMADM with the 
VPM Administrator value.  

4. Run the Oracle script update_EXT.sql which is in 
$HOME/InstallVPM/reffiles/DBMS/ddl of the VPM administrator.  
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CATCDMA.VPM.EXPAND.C_COUNT = TRUE;  

WARNING! Using the setting CATCDMA.VPM.EXPAND.C_COUNT = TRUE; in PTF5 has a restriction. See Restriction When Using 
CATCDMA.VPM.EXPAND.C_COUNT.  

Checking Statistics on the Database 

To check statistics on the database, the DB2 administrator must do as follows:  

1. Connect to the database.  
2. Run the command: 

db2 reorgchk update statistics on table all.  
3. Look at the result column REORG.  
4. If the value is -** or *** , table reorganization is mandatory. Here is an example of the command you must then run: 

reorg table VPMADM."configuration0001_"  

Impact on Performance When Expanding  

As of VPM1.5 PTF5, for optimum performance when expanding, the following functionalities are no longer available by default. They must 
be explicitly activated by changing the default value (false) to true i.e. they should only be implemented if you judge it necessary for your 
application given the negative consequences on performance.  

1. To configure the models of a Part the following variable must be added to the declaration file: 
CATCDMA.VPM.EXPAND.CONFIGURABLE_REPS : logical; 
CATCDMA.VPM.EXPAND.CONFIGURABLE_REPS = true;  

2. To configure the features of a Part the following variable must be added to the declaration file: 
CATCDMA.VPM.EXPAND.CONFIGURABLE_FEATURES : logical; 
CATCDMA.VPM.EXPAND.CONFIGURABLE_FEATURES = true;  

IMPORTANT! Be aware of the following behavior in feature-compliant environments:  

z the default value (false) means that there is no database access hence better performance but that when expanded, all models, 
whether they have features or not, are displayed with an activator button. This will be modified in a future PTF.  

z If the default value is changed to true the database is accessed with the resulting impact on performance and models are displayed 
with an activator button only when they have features.  
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Expand PSN Web Tree in VPM1.5 PTF5 

On your UNIX Portal Server  

1. Edit the file <Path Installation Server>/docs/java/CDMAConfiguration.properties by adding the following line: 
XMLExpandRequired=true  

Load in DMU from VPM 

1. Set the variable ReviewMode for CATIA V5R7SP6 and CATIA V5R8.  
2. Set the variable Optim3DIC=1 for CATIA V5R8.  

Restriction When Using CATCDMA.VPM.EXPAND.C_COUNT 

When the declaration parameter CATCDMA.VPM.EXPAND.C_COUNT is set to TRUE, there is an error when you open graph sessions in 
static mode. Graph expansion is not possible. To open a graph session in static mode you must make sure the value FALSE is used. Be 
aware however that this prevents the gain in performance you can expect when using CATCDMA.VPM.EXPAND.C_COUNT = TRUE; . 
This will be corrected for PTF6.  

DOCUMENT Table 

The DOCUMENT table must exist in every environment even if it stays empty.  

For optimum performance for the PSN expand, the DOCUMENT select is hard-coded.  

If the DOCUMENT table does not exist, not only will the PSN expand not work but even before that, the PSN library cannot be built.  

Volume Filter 

Inappropriate behavior may occur if you open the Volume Filter panel when the PSN tree is already expanded. To avoid this you can 
either:  

z open the Volume Filter panel before expanding the root node or  
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z add the following lines to your declaration file: 

CATCDMA.VPM.ALWAYS.SET.VOLUME : logical; 
CATCDMA.VPM.ALWAYS.SET.VOLUME = true;  

This problem will be corrected in the next PTF.  

MBCS Support in the PSN 

PSN and Mixed Characters 

To support MBCS (Mixed Characters) in the PSN (Japanese/Chinese and alphanumeric/Latin characters), add the following variable to 
the file YOUR.env:  

export SBCS_DBCS_Text = 1  

IMPORTANT! To optimize performance, this variable is not set by default.  

Visualizing Japanese/Chinese Characters in the 3d com/VPM Portal 

To visualize the VPM columns set natively in DBCS (Japanese/Chinese characters):  

1. Go into the file CDMAConfiguration.properties located in $install_path/docs/java .  
2. Change the line: 

NLSEnvironmentRequired = false  

to:  
NLSEnvironmentRequired = true  

Solaris 8 Support for VPM / CATIAV4 / CATIAV5 

Opening Catalogs in CATIA V5 
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As of VPM1.5 PTF5, there is a radio button in File->Settings->Open Model allowing you to select the mode to be used to open catalogs 
(edit or browse) in CATIA V5. Note that this only works with CATIA V5R8.  

Simple Queries 

For purposes of incident report correction the behavior of the Simple Query combo has slightly changed. Now, once you have selected the 
appropriate string in the pull-down list, click Search now to run the request.  

Integration of VPM - CATIA V5R7/V5R8 on IRIX 

IRIX Client 

CATIA V5 is a program built with the N32 compilation option under IRIX (MIPSpro C++ 32-bit compiler) for better performance whereas 
ENOVIAVPM is an O32 program (ucode C++ 32-bit compiler). The same Oracle DB client (or, to be more precise, the Oracle client 
libraries) can therefore not be referenced simultaneously by both programs. It is therefore necessary to:  

z use an O32 DB client for ENOVIAVPM (Oracle 806, for example)  
z use a N32 DB client for CATIA V5 (Oracle 817, for example).  

Solution  

As of CATIA V5R7, the prerequisite Oracle level is 817 (N32). The level supported by VPM is O32. This means that you must have two 
Oracle clients (O32 and N32) on the same IRIX client machine for the integration of VPM - CATIAV5. You must make sure beforehand 
that the connection to the server base (VPM15 is referenced in tnsnames.ora) is working satisfactorily using Oracle SQL/Plus:  

sqlplus system/manager@VPM15  

When CATIA V5 is launched from VPM, the V5 environment shell is executed after VPMDBEnv.sh. Certain variables can therefore be 
redefined and then be taken into account when CATIA V5 is next launched. This applies, for example, to the following environment 
variables that must point to the N32 Oracle client:  

z ORACLE_HOME  
z TNS_ADMIN  
z ORA_NLS33  
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z PATH  
and, in particular:  

z LD_LIBRARYN32_PATH ($ORACLE_HOME/lib32).  

Moreover, the variables ORACLE_SID et TWO_TASK reference the server instance.  

Example  

The VPMDB15  Oracle server instance is running on the AIX machine ibmdsy. On the client machine sgidsy the following is installed:  

z the VPM 1.5 code  
z CATIA V5R8  
z two Oracle clients: 

{ an 806 Oracle client whose $ORACLE_HOME is /app/ora806  
{ an 817 Oracle client whose $ORACLE_HOME is /app/ora817  

The file tnsnames.ora, shared by these two clients, is located in the directory /app/oracle. It references the VPM15 server instance. 
Connections via sqlplus using an alias run on both Oracle clients.  

Variables are always redefined in the CATIA V5 environment script.  

VPMDBEnv.sh  

export ORACLE_SID=VPM15 
export TWO_TASK=VPM15 
export ORACLE_HOME=/app/ora806 
export PATH=$PATH:/app/ora806/bin  

CATIA.V5R8.B08.sh  

LD_LIBRARYN32_PATH=/app/ora817/lib32:$ LD_LIBRARYN32_PATH 
ORACLE_SID=VPM15 
TWO_TASK=VPM15 
ORACLE_HOME=/app/ora817 
PATH=/app/ora817/bin:$PATH 
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TNS_ADMIN=/app/oracle 
ORA_NLS33=/app/ora817/ocommon/nls/admin/data  

New Security Process 

Cumulative Fixes PTF5 

Free Text PTF5 

Application Function Data 
Group

Command Engineer Manager Administrator

VPM BOM x ChangeModelUUID x x x

OS UB OS UB OS UB OS UB
IX UB97001 HP UB96995 SG UB97017 SU UB97005

IX UB96988 HP UB97003 SG UB97018 SU UB97008

IX UB96994 HP UB97004 SG UB97013 SU UB96996

IX UB96999 HP UB96991 SG UB97009 SU UB97007

IX UB96990 HP UB96992 SG UB97016 SU UB97010

IX UB97000 HP UB96989 SG UB97014 SU UB96998

IX UB96997 HP UB96987 SG UB97012 SU UB97011

Admin
z HC88765: A UNIX user name starting with a numeric character results in an error 

message and VPM does not start.  
z HC86936: After starting VPM, Start Tools/Execute/CATIA Mouse behavior set up 

by CATIA becomes invalid. 
-> Now there is a new setting file for VPM: xxxxxVPM.user  

z HC88523: Undocumented VPM profile variables global_*  
z HC88760: After adding VPM ENV, abend S0006 occurs when a model is loaded 
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into 4DNAV.  

AFL z HC86426: In the Action panel, an insufficient message appears when a subscribe 
selection is made.  

z HC88614: Running AT0EXPND results in the abend RC=139  
z HC86994: Customize the Action Status in AP203.Vaction (with DBCS) but this only 

results in a crash.  

BOM z HC85102: There is a problem when updating the document in VPM.  
z HC87463: The CATRACE files are empty on the Sun OS.  
z HC88067: When a VPM session is opened the command CATCDMA -C VPMENV 

generates an error: ERROR CONNECT SQLCODE -1403.  
z HC85744: On Sun, there is an abend when the Add Object function is used with 

more than 36 Parts.  
z HC88195: There is a problem with a function duplicate on a Part with a V5 

document.  
z HC86184: When deleting Parts and/or models, error 110 is not explicit.  
z HC86056: MBCS works on the VPM Access Panel but not in the PSN. To activate 

this functionality, use: export SBCS_DBCS_Text=1  
z HC88198: VPM abends S0004 and S0011 occur when changing the positioning in 

CATIA.  
z HC84774: The viewer specified by Open a graph session cannot be started.  
z HC86215: When only one side on "Between option" is selected the whole instance 

is displayed.  
z HC88119: When Tools/Transfer Lock is selected, an error occurs.  
z HC88262: The checked-out user name should appear on a warning panel.  
z HC88284: The data with associated to associate/new document is not displayed.  
z HC88286: The defined column cannot be displayed in the Create & Save panel.  
z HC88489: The zone filter does not work with filter by identification.  
z HC88203: VPM crashes at getvalue when the value has 24 characters: 

segmentation fault coredump and RC 139  
z HC73411: A search for all components in the PSN cannot be interrupted.  
z HC88472: The rename operation fails resulting in Object already exists in spite of 

the fact that the model is the only one for the Part.  
z HC71777: The C_REVISION value in the Create & Save panel can be modified.  
z HC82805: Search with field  
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PTF6 Update 
REMEMBER to rebuild the user exits!  

User exit sample resides under $CATIA/code/sample  

New Object Deletion Commands for P & O Data Import/Export  

CFG z HC88559: Adding a comment to a link in a configuration results in the model being 
displayed twice.  

z HC85844: It is possible to delete a category although it is contained in a rule.  
z HC85746: Abend S06 occurs with a proposed effectivity function.  
z HC86406: Abend S011 occurs in the menu list of Entity Instance.  
z HC86056: The name is displayed garbage on the Define effectivity windows of 

Config.  
z HC87120: Replacing several Parts with an effectivity produces an error and results 

in garbage.  

MML z HC88077: An abend occurs before the MML graph has opened.  

Multisite z HC87939: In P&O, the replication of profiles does not work.  
z HC88344: The Import/Export function for a public process does not work in the 

P&O.  
z HC88343: Replication of the privileges associated with the user does not work.  

PSN z HC76567: Available memory space gradually decreases when saving a .pst file.  
z HC76920: Available memory space gradually decreases when opening a .psn file.  
z HC77097: Locate First Selected Part does not work. Message: Not any localized 

item  
z HC87824: Environment names containing the underscore character ’VW_E’ results 

in error messages when expanding a PSN.  
z HC89109: Expansion of the ASM PSN with more than one Part is no longer 

possible in PTF4 in an environment containing the underscore character.  

STEP z HC84648: There is a VPM / STEP transfer problem.  
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As of VPM 1.5 PTF 6, the People & Organization import/export utility supports a new set of commands for deleting objects.  

Import 

Language Keywords 

The following keywords were added to the standard language keywords to define the syntax of deletion commands:  

  

Language Syntax Rules 

In the following syntax rule table, the special symbols are:  

  

Keyword Meaning

%SITE a SITE object

%ORG an ORGANIZATION object

%PERSON a PERSON object

%ROLE a ROLE object

%PROFILE a PROFILE object

%PROCESS a PROCESS object

%
DATAGROUP a DATAGROUP object

%PRIVILEGE a PRIVILEGE object

{} stands for a list of possible values

| options value separator

[] stands for optional field
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Import Example 

Here is a sample import file usable as input to the import tool:  

*mode REPLACE 
*ddl EXECUTE GENERATE 
*separator , 

$ can be used to specify a null value

, attribute separator (can be modified using the *separator keyword)

Keyword Syntax

%SITE id

%ORG id

%PERSON id

%ROLE name,org

%PROFILE project,environment,name

%PROCESS PROCESSGROUP,name,$

%PROCESS EXTERN,function,command

%
DATAGROUP ORG,id

%
DATAGROUP USER,id

%
DATAGROUP CLUSTER,name

%PRIVILEGE PERSON,id,$,process,data_in,data_out

%PRIVILEGE ROLE,name,org_id,process,data_in,data_out

Page 132 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



*null $ 
 
// Deletion of privilege 
%PRIVILEGE ROLE;ROLETST;ORGTST;Extern.FunctionTST.CommandTST;PGTST;$  

// Deletion of process group "PGTST", 
// and process "Extern.FunctionTST.CommandTST" 
%PROCESS ProcessGroup;PGTST;$ 
%PROCESS Extern;FunctionTST;CommandTST  

// Deletion of data group defined for user "USRTST", 
// and cluster "CLUSTERTST" 
%DATAGROUP USER;USRTST 
%DATAGROUP CLUSTER;CLUSTERTST  

// Deletion of role "ROLETST[ORGTST]" 
%ROLE ROLETST;ORGTST  

// Deletion of person "USRTST" 
%PERSON USRTST  

// Deletion of organization "ORGTST" 
%ORG ORGTST  

// Deletion of site "SITETST" 
%SITE SITETST  

// Deletion of profile "VPMENVTST" defined for environment "VPMENV" 
%PROFILE CATSAMPLE;VPMENV;VPMENVTST  

Executing the Import Command 

Files containing deletion commands are managed like regular files by the VPMPeopleImport utility. 
For details, see the ENOVIAVPM Installation & Administration Guide.  

Export 

VPMPeopleImport does not support the generation of deletion commands as it does for standard creation/update commands. When the 
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import/export mechanism is used for replicating People & Organization structures between several VPM installs, it is the responsibility of 
the VPM administrator to create and complete the file containing the deletion commands, according to the corresponding delete 
operations he or she performs in the graphical administration tool VPMPeopleEdit.  

Applicative Containers 

To manage additional DMU data in VPM you require the table DOC_CONTAINER. In addition, the following actions described below must 
be performed for each environment on the VPM side. Only three declaration parameters are needed on the V5 side and no extra mapping 
is necessary. Also, a repository must be defined for long field storage (see the example of the VPMENV profile below). The prerequisite 
VPM and CATIA/DMU levels required for applicative containers are 1.5 PTF6 and V5R8SP2 respectively.  

Structure of the Table VPMENV.DOC_CONTAINER 

$COID CHAR(8)
$COMPID CHAR(8)
S_NAME VARCHAR(80)
S_TYPE VARCHAR(80)
S_UID VARCHAR(30)
C_REVISION CHAR(3)
C_MATURITY CHAR(16)
C_VERSION INTEGER
C_COMPID_DATA CHAR(8)
C_COMPNAME_DATA VARCHAR(18)
C_SOFT_VER VARCHAR(80)
C_LAST_REPOSITORY VARCHAR(80)
C_INTFORM INTEGER
C_TYPE_REP VARCHAR(80)
C_RESPONSIBLE CHAR(8)
C_CREATE TIMESTAMP
C_CREATE_USER CHAR(8)
C_LASTMOD TIMESTAMP
C_LASTMOD_USER CHAR(8)
C_ORG_RESPONSIBLE CHAR(10)
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Creating the Table VPMENV.DOC_CONTAINER 

We recommend you use the general PTF migration procedure described in VPM MIGRATION. In the file 
$CATIA/vpm/reffiles/DBMS/VpmMigrationHistory.txt you will find the command streams to use for migrations upto PTF6. To migrate from 
PTF5 to PTF6, the command streams VPINSTS101 and VPINSTS102 (delivered in the directory $CATIA/vpm/reffiles/DBMS) are needed 
for creation and grant purposes regarding the table VPMENV.DOC_CONTAINER and the additions to the CDM data dictionary.  

VPMENV Profile 

The lines below must be present in your VPM profile. This is an example of the PVPMENV file delivered in the directory 
$CATIA/vpm/reffiles/DBMS:  

 ASSIGN 'SELECT S_NAME, S_TYPE, C_REVISION, C_MATURITY, C_LASTMOD FROM DOC_CONTAINER' TO 
"GLOBAL_$RESULTS_CONTAINER";  

 ASSIGN 'SELECT S_PART_NUMBER, S_CHG_NUM, S_TYPE, PART_DESCRIPTION, C_PART_VERSION, C_MATURITY, 
C_RESPONSIBLE, C_LASTMOD FROM PART_LIST; 

 SELECT S_NAME, S_TYPE, C_REVISION, C_LASTMOD FROM DOC_CONTAINER' TO "GLOBAL_$QUERY_CONTAINER";  

 ASSIGN 'SELECT S_PART_NUMBER, S_CHG_NUM, S_TYPE, C_PART_VERSION, C_MATURITY, PART_DESCRIPTION, 
C_LASTMOD FROM PART_LIST; 

 SELECT S_NAME, S_TYPE, C_REVISION, C_MATURITY, C_LASTMOD FROM DOC_CONTAINER' TO 
"GLOBAL_$RESULT_CONTAINER";  

 ASSIGN 'PART, MODEL, DOCUMENT, CONTAINER, PLOT, CAD' TO "GLOBAL_$LIST_QUERIES";  

 ASSIGN 'PART_LIST, CATIA_MODEL, DOCUMENT, DOC_CONTAINER, CATIA_PLOT, DOCCAD' TO "GLOBAL_$LIST_DELETE";  

 ASSIGN 'SYNONYM("Containers")' TO "GLOBAL_$FORMAT_DOC_CONTAINER"; 
 ASSIGN 'SYNONYM("Name")' TO "GLOBAL_$FORMAT_DOC_CONTAINER.S_NAME"; 
 ASSIGN 'SYNONYM("Type")' TO "GLOBAL_$FORMAT_DOC_CONTAINER.S_TYPE"; 
 ASSIGN 'SYNONYM("Rev")' TO "GLOBAL_$FORMAT_DOC_CONTAINER.C_REVISION"; 
 ASSIGN 'SYNONYM("Maturity")' TO "GLOBAL_$FORMAT_DOC_CONTAINER.C_MATURITY"; 
 ASSIGN 'SYNONYM("Date")' TO "GLOBAL_$FORMAT_DOC_CONTAINER.C_LASTMOD";  
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 ASSIGN 'SELECT S_PART_NUMBER, PART_DESCRIPTION, C_PART_VERSION FROM  PART_LIST; 
 SELECT C_NICKNAME, S_TYPE_REP, C_REVISION FROM CATIA_MODEL; 
 SELECT S_TYPE_REP, S_NAME, D_PATH, C_REVISION, C_MATURITY FROM DOCCAD; 
 SELECT S_FORMAT, S_NAME, D_PATH, C_REVISION, C_MATURITY FROM DOCUMENT; 
 SELECT S_NAME, S_TYPE, C_REVISION, C_MATURITY FROM DOC_CONTAINER; 
 SELECT C_NAME, DESCRIPTION, CURR_VAL, D_PATH, C_MATURITY FROM FEATSAMP' TO "GLOBAL_$GRAPH_NAVIG";;  

 ASSIGN 'AR' TO "GLOBAL_$FROZENMATURITY_DOC_CONTAINER"; 
 ASSIGN 'AC, AA, AR, CE' TO "GLOBAL_$AUTHORIZEDVALUES_DOC_CONTAINER.C_MATURITY";  

 ASSIGN 'DBLFAIX.UNIX PATH $HOME/db/' TO "GLOBAL_$CONTAINER_ACCESS_METHOD";  

PSN (libLV0XCDMA.a) 

The libVX0CDMA.a library must be recompiled (catpsninst.sh PSN.in) for the applicative containers to be visualized in a PSN. 
Here is an example of a PSN.in file:  

  

VPM Environment Declaration Parameters (CATCDMA.dcls) 

To open applicative containers from a PSN, the following declaration parameters must be added to the CATCDMA.dcls (or the 
USRENV.dcls):  

CATCDMA.METHOD_LIST(x).CATAB = ’DOC_CONTAINER’; 
CATCDMA.METHOD_LIST(x).TYPE = ’Reserved’; 
CATCDMA.METHOD_LIST(x).COMMAND = ’CATIAV5’; 

*DB CATCON
*ENV VPMENV
CATIA_MODEL
DOCUMENT
DOCV5
DOC_CONTAINER
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CATCDMA.METHOD_LIST(x).WHERE = ’Both’; 
CATCDMA.METHOD_LIST(x).ROLE = ’Tools’; 
CATCDMA.METHOD_LIST(x).TAG = ’CdmaPrincPanelOpenCATIAV5’;  

CATIA Environment Declaration Parameters 

The following environment variables must be set to 1 to activate the applicative containers. These settings can, for example, be added to 
the file CustoVpmToV5.sh:  

export INTEROP_CONTAINER_V5R8=1 
export Force_Container_In_PDM=1  
export CATDMUDataInPDMNameCusto=1  

Customizing Expand Behavior 

Note that the new expand behavior customization capabilities described in the section Customizing=>Customizing the VPM Session of the 
ENOVIAVPM User’s Guide will not be available until 1.5 PTF7.  

Saving a Graph Session 

z Be aware of the following problem when saving a graph session: 
1. You paste a new child to a Part  
2. You cut or replace the new child before the paste has been committed to the database.  
3. You save the graph session into a file.  
4. The file will include the cut or replaced child, and the child will be displayed when the graph session file is opened.  

z Impossible to commit into the database modifications registered in a graph session file: 
1. Make some changes to a Product Structure graph (paste, cut, etc.)  
2. Save the graph to a file without committing the changes.  
3. Close the graph window and discard the changes.  
4. Open the graph session file.  
5. Make other changes.  
6. Save work to the database.  
7. The changes included in the file are listed but you cannot check them for commitment. 

The new changes made after the graph file was opened are listed as usual and you can check them for commitment.  
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CATCfgInterfaces.cpp 

The API CATCfgInterfaces.cpp needs a complete login with user and role, otherwise security management will prevent the expand of the 
root part. For the same reason, LV0EXPND will no longer be available and is replaced with AT0EXPND.  

Problem on Solaris when generating the PSN Library 

Declaration Parameters 

z To use the Start With operator as the default for advanced queries, see catcdma.QUERY.OPERATOR_START_WITH  

Compare with Database Command 

The Compare with Database command does not take into account:  

z what is displayed (a collapsed branch will be compared)  
z the configuration filter (a filtered part will be compared)  
z the CSB filter (a filtered Part will be compared).  

However, the links of deleted Parts (in the database) are compared.  

The technology the command is based on does not allow the correction of these bugs. The command therefore has to be deactivated. 
This is how we advise you to proceed:  

1. Let us assume you want to compare graph A with the database.  
Create a new graph. The root must belong to graph A, but it is not necessarily the root part.  

2. Apply the desired CSB and configuration filters.  
3. Expand and collapse the desired branches.  
4. Compare the two graphs.  

Prerequisite Interoperability PTFs 

For CATIA 424-1, the following PTFs are prerequisite:  
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z HC84033: It is impossible to manage document revision using DMUSLF.  
z HC84902: The File=>Save command in CATIA updates frozen Parts.  
z HC85860: The cgr stored in datalinks is not updated after the V4 model is modified.  
z HC85938: Unable to store model using DBLFCAT  
z HC85967: Unable to store a model with DBLFCAT  
z HC87012: When executing the File=>Save command, VPM cannot be found to save a model. Error occurred in Japanese 

environment.  
z HC89784: Standard DS traces cause trouble in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation fault. DBLDRW entry issued.  
z HC89158: When you version a Part, the tolerances are not updated.  

Cumulative Fixes PTF6 

OS UB OS UB OS UB OS UB
IX UB97759 HP UB97794 SG UB97815 SU UB97776

IX UB97758 HP UB97803 SG UB97818 SU UB97774

IX UB97792 HP UB97806 SG UB97763 SU UB97780

IX UB97788 HP UB97797 SG UB97812 SU UB97770

IX UB97765 HP UB97808 SG UB97811 SU UB97773

IX UB97764 HP UB97800 SG UB97805 SU UB97771

IX UB97760 HP UB97798 SG UB97766 SU UB97767

IX UB97790 HP UB97796 SG UB97813 SU UB97778

IX UB97787 HP UB97795 SG UB97816 SU UB97772

IX UB97786 HP UB97802 SG UB97814 SU UB97768

IX UB97793 HP UB97762 SG UB97809 SU UB97779

IX UB97791 HP UB97801 SG UB97807 SU UB97777

IX UB97789 HP UB97804 SG UB97817 SU UB97775

IX UB97761 HP UB97799 SG UB97810 SU UB97769

IX UB97785 HP SG SU
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Free Text PTF6 

Action z HC88861: There is a problem with the user exit 
CATVpmAFUsrMethod::CheckUserCondition  

z HC90108: Generation of the user exit library LIBVX0AFUSR.A failed with the 
sample source file CatVPMAFUsrMethod.cpp  

z HC89643: STEP file AP203.VAction with Chinese characters  

Admin z HC77699: Duplicating a Part with more than forty models is impossible. We have 
no access to the Yes, No or Duplicate buttons. 
--> Now it is possible to modify the resource CdmaMessageRepDuplicate in 
CATDMDlgCDMAMessage  

z HC82805: Search with field  
z HC90055: When migrating from VPM 1.2 TO 1.5 the command streams 

VPINSTS9_1 and VPINSTS9_2 are not listed.  
z HC90581: CATCfgInterfaces.h expand does not find all the models  
z HC90073: The catcdma.VPM.MML.SYNCHRONISE.* declaration parameter 

series is missing although it is documented.  
z HC90465: There is a CATIA abend S11 when we use the DBLFAIX repository 

type in VPM. 
!! A correction is needed on both the VPM and CATIA sides. For the CATIA PTF, 
please track the APAR HC90465 !!  

z Script MS_conf_migr_DB2.clp mandatory before update_EXT.clp  

BOM
z HC84166: The opening of the PSN stops at the Part model without opening the 

model.  
z HC86200: A Part cannot be created after copying attributes of a Part from another 

environment.  
z HC88578: The results of the interference analysis are differentiated when 

performed on one or more models.  
z HC89165: The depth expand limit is set back to manual although the declaration 

parameter catcdma.PSN.DEPTH_PERSISTENCY is set to TRUE.  
z HC89346: Extract query with a * in the value.  
z HC89374: The deep Part table of a class that exists in the first stage status is 

pasted to a suitable Part and two graphs are compared.  
z HC88755: There is an abend if the DBLFCAT access method is used for the 
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document creation.  
z HC89558: The Get All Components menu item lists all Parts in the environment.  
z HC89657: Copying the PSN is not possible when using Select Object.  
z HC88991: There is a synchronization problem when a generate twins model a 

CATPart.  
z HC89679: Replace->from Clipboard : Depth expand limit-> Any does not work.  
z HC89848: The order of attributes in the Rename panel is taken into account by 

VPMA but not by the PSN Rename panel.  
z HC89499: Rename KO with two Apply’s.  
z HC90249: The declaration parameter catcdma.GRAPH_ICON().ACTION can be 

set to FILTEROUT but the value FILTERIN does not work in the context menu.  
z HC90458: PSN Associate New Part does not work if the Part_List alias is different 

from the Part. Associate New Doc results in an abend S0006.  
z HC89697: There is incorrect behavior for a new version in advanced mode.  
z HC86755: The behavior between an advanced and an intermediate query is 

different.  
z HC89635: The wrong lines are in the display when resetting a filter.  
z HC90654: There is a VPM abend S11 when registering a V5 CATPart via Quick 

Import.  
z HC91312: The wrong filter is the result when a collapsed graph and Open 

Clashes/Show in PSN are used.  
z HC89648: An error is caused by the Chinese "synonym" in the PSN.  
z HC91320: A model is created in the public org by default.  
z HC90596: Impossible to open a tree in static mode after setting the declaration 

parameter for the C_COUNT attribute.  

CFG z HC89198: Options in use can be removed from the Option dictionary.  
z HC89265: In the PSN a comment is lost.  
z HC89914: An abend S0011 occurs when using Cut with Existing Effectivity.  
z HC89811: There is a problem with the function NewVersionOtherPartNumber with 

a SetConfigurable by API.  
z HC90502: There is a problem with effectivities on a range containing infinity.  
z HC90536: The corporate dictionary is removed by AT0CLNCFG - Clean Run.  
z HC89883: Wrong return with a GetTaskCaller function in the user exit 

CATDMUsrMethod.  
z HC90849: There is a wrong modification flag when C_COMMENT is updated.  
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PTF7 Update 

Multisite z HC87938: Multisite: Replication of deleted objects is not possible in the P&O.  
z HC89996: There is a problem with the Multisite function using DBLFCAT: The 

model is not recovered after import.  

P&O z HC90483: The association of a profile with a role in P&O is ignored when the 
environment name is Product.  

z HC89775: There is no output for registered data even if it performs the P&O 
export.  

z HC90388: A cut operation in the PSN overwrites the database Part.  
z HC90498: VPMPeopleImport fails with error: Invalid STEP21 file format when 

importing rows into P&O.  
z The MultiCAD server password is often rejected.  
z The Address field is not displayed in Organization.  
z The e-mail field is not displayed in Person.  
z The privilege VPM.BOM.OpenRepresentation is now available in the casual 

license.  
z The new privilege VPM.Action.Use 

--> Update your privileges with VPMDataManager.  
z The new privilege VPM.CFG.CleanAssembly 

--> Update your privileges with VPMDataManager.  

Publish z HC89667: For cluster management there is no scrollbar on large lists. 
--> You have to modify CATVpmDlgCondition as follows: 
ContainerMain.PageStandard.FrameStandard.ComboAttribute.Style 
= "DropDown"; 
ContainerMain.PageStandard.FrameStandard.ComboAttribute.Style 
= "20";  

User 
Exits

z Method queue() added in the API CATVpmUsrReplication.  
z New API CATDMUsrMethod::ConfigHandlerVisibilityControl  

VPM NT z HC87642: VPM interoperability: Action creation failed with nothing keyed in the 
description.  
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REMEMBER to rebuild the user exits!  

User exit sample resides under $CATIA/code/sample  

Versioning 

A versioning problem has been detected which occurs when the following three conditions are fulfilled:  

z a Part has an associated model or document 
AND  

z the C_ORDER column is present in the PART_LIST and CATIA_MODEL or DOCxxx tables 
AND  

z the C_ORDER column is the last of the non C_ columns in the PART_LIST table.  

The error 20708 then terminates the versioning operation.  

To prevent this from happening, before starting VPM, enter:  

export CATComputeUserValuesBeforeWrite=NO  

Interrupt Panel 

Purpose: 
Enables a user to stop expand execution before its normal termination. This can be useful if the result is much larger than expected by the 
user.  

Limitations: 
The expand can be interrupted only at the end of each level. Therefore the user may sometimes have to wait more than a minute before 
the expand actually stops.  

An expand with multiple configuration handlers cannot be interrupted (the panel is not displayed).  

Activation: 
Add the following lines to your declaration file:  
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CATCDMA.VPM.EXPAND.INTERRUPTABLE : LOGICAL ; 
CATCDMA.VPM.EXPAND.INTERRUPTABLE = TRUE ;  

Enhanced Object Expand 

The expand capability has been enhanced for optimum organization and management of the different types of objects you have to deal 
with. To activate this new functionality, add the following variable to the .dcls file:  

CATCDMA.VPM.EXPAND.PTF : INTEGER; 
CATCDMA.VPM.EXPAND.PTF = 7 ;  

Setting the variable CATCDMA.VPM.EXPAND.PTF to 7 results in a new button called Settings being displayed in the PSN window, next to 
Manual and Any. This button displays a new window allowing expand customization. This window lists all environments and tables that 
may appear in the expand.  

For each table the user can select one of the following options:  

z Always 
Table data will always be included in the expand  

z Never 
Table data will never be included in the expand  

z Using Activator 
Table data can be included in the expand using an activator.  

In addition, in the case of the options Always et Using Activator the user can define a condition to filter, for each table, the data to be 
included in the expand.  

Other options enable the selection of a specific color and icon for each node depending on the data type (i.e. the table) and the conditions 
on the attributes (a maximum of five conditions).  

The new window is described in "Customizing Expand Behavior" in the section "Customizing the VPM Session" in the ENOVIAVPM User’s 
Guide.  

Applicative Containers 
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CATIA Environment Declaration Parameters 

There is in fact only one environment variable that has to be set to 1 to activate the applicative containers:  

export INTEROP_CONTAINER_V5R8=1  

New Functionalities in the MML Graph 

z Graph presentation 
This item has been added to the Graph menu enabling the display of: 

{ straight links / square links  
{ packed / unpacked  
{ centered / indented.  

z Change UUID 
The  menu item has also been added to the MML graph (underneath Graph==>UUID Management). This functionality is already 
available in the Admin menu of VPMA but its addition to the MML graph will allow users to select models from different 
environments.   

Removal of the ACTION Item from the Objects Menu 

The ACTION item may disappear from the Objects menu when it is not used. The item is controlled by the privileges on the Action.Create 
and Action.Query processes. If users do not have both these privileges, they cannot access any Action and the ACTION item is removed. 
This is activated by means of the declaration variable CATCDMA.VPM.ACTION set to TRUE.  

Potential Performance Enhancement (VPM1.5 PTF5) 

Expand PSN Tree in VPM1.5 PTF5 

Note that when working with the dictionary in memory the following steps are to be done on both VPM and CATIA:  

1. Edit the file CATCDM.dcls by replacing the line: 

DB2  
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catcdm.DBCONN.DB2.MODULE = ’JD061DIB’ 
with: 
catcdm.DBCONN.DB2.MODULE = ’JD062DIM’;  

ORACLE  

catcdm.DBCONN.ORACLE.MODULE = ’JD061DIB’ 
with: 
catcdm.DBCONN.ORACLE.MODULE = ’JD062DIM’;  

New Profile Variable 

The variable $MMLV5_NAVIG has been added to the profile enabling the customization of the attributes displayed in MML V5 boxes.  

User Exits 

A new user exit named ComputeUserValuesBeforeWrite has been added. It is called during the creation process of BOM objects, 
before the older user exit ComputeValuesBeforeWrite. It is different from ComputeValuesBeforeWrite in that it is called before 
checking the presence of the object in the database. It is thus possible to provide it with extra significant attributes that are kept hidden 
from the end user but that are mandatory for both object checking and creation.  

Online Documentation 

To access the online documentation from VPM (help on item, etc.), the setting VPM_SEARCH_PATH must be modified.  

For releases up to VPM 1.5 PTF 5, run the following command (to be entered on one line):  

VPMSettings –a –n VPM_SEARCH_PATH –v 
$$VPM_ACTION_PARAMETER:$$VPM_AFL_STATUS_GRAPH:$$VPM_AFL_LOG 
_PATH:$$VPM_AFL_METHOD_PATH:$VPM/reffiles:$CATDocView:$CATD 
ocView/online/:$CATDocView/online/vm1ug:$CATDocView/online/ 
vm1ad:$CAT_CUST:$HOME  
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As of VPM 1.5 PTF 6, run the following command (to be entered on one line):  

VPMSettings –a –n VPM_SEARCH_PATH –v  
$$VPM_ACTION_PARAMETER:$$VPM_AFL_STATUS_GRAPH:$$VPM_AFL_LOG 
_PATH:$$VPM_AFL_METHOD_PATH:$VPM/reffiles:$CATDocView:$CATD 
ocView/online/:$CATDocView/online/vm1ug_E2:$CATDocView/onli 
ne/vm1ad_E2:$CAT_CUST:$HOME  

Note: The above examples use the default value of the settings, so you may have to modify it beforehand to take into account specific 
customizations; the relevant path items relating to the documentation are those containing the string $CATDocView.  

Propagation of Volumes to Multiple Environment Roots 

Volumes are now propagated to all the specified environments, independently of the CATIA/CDM/VPM projects. 
Make sure you set the declaration parameter CATCDMA.CSB.VOLUME.ENVIRONMENTS to ALL.  

BOM API 

The BOM API CATDMUsrInstance was enhanced with the following methods:  

z CreatePart: Part object creation  
z CreateRepresentation: representation (model, document) object creation  
z Delete: Part, model, representation object deletion  
z GetValues: get the values of any attribute of an object  
z Query: query object(s) in the database.  

Multisite 

Multisite now provides a new capability. Metadata can now be exported and imported in XML format. 
This has no impact on current multisite functionalities. The only impact is during export and import.  

Multisite Customization 
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1. Preventing the Transfer of Locked Objects to Another Site 

The check is performed when declaring and setting to TRUE the declaration parameter 
CATCDMA.VPM.MULTISITE.TRANSFER.CHECK_LOCKS. The default behavior i.e. when the declaration parameter is undeclared is 
to allow the transfer of locked objects.  

This parameter modifies the behavior of the command Admin/Replication/Transfer to site... in the main panel.  

The transfer is cancelled when a lock is found on the root part or any of its representations.  

  

2. Authorizing the Queuing of Remote Objects 

This means requesting the synchronous/asynchronous replication of objects belonging to another site. The check is performed when 
declaring and setting to FALSE the declaration parameter CATCDMA.VPM.MULTISITE.EXPORT.CHECK_SITE.  

The default behavior (i.e. when the declaration parameter is left undeclared) is not to allow the replication request of remote objects.  

The declaration parameter modifies the behavior of the commands Admin/Replication/Add to queue... and 
Admin/Replication/Replicate... in the main panel.  

The transfer is authorized even though the object (a part, or the part a representation is attached to) belongs to a site that is not the 
current site.  

  

3. Authorizing the Deletion of Remote Objects 

This means deleting the local copy of a remote complex object that cannot be otherwise modified.  

This can be done on Part objects using the command Admin/Replication/Delete remote object... in the main panel.  

This command is made available by declaring and setting to TRUE the declaration parameter 
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CATCDMA.VPM.MULTISITE.DELETE_REMOTE.  

Single Sign-On 

The following is a description of the VPM-specific customization to be implemented to use a single sign-on (or "external login").  

To activate the single sign-on plug-in in VPM, run the command:  

VPMSettings -a -n VPM_EXTERNAL_LOGIN -v YES  

The following environment variables must also be set:  

z CATLoginServletHost  
z CATLoginServletPort  
z CATLoginServletURI  

They reference the server host name, the port to be used for HTTP connection, and the servlet to be run on it, respectively.  

If data encryption is enabled on the server, the following variables must also be set to point to the correct library and encryption/decryption 
methods:  

z CATLoginCryptLibrary  
z CATLoginCryptFunction  
z CATLoginUncryptFunction  

Note: To use built-in 64-bit encoding provided by VPM, set these variables as follows:  

CATLoginCryptLibrary=VX0SCEXT 
CATLoginCryptFunction=encodeBase64Password 
CATLoginUncryptFunction=decodeBase64Password  

Declaration Parameters 
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z To enable correction of graph session problems, see catcdma.VPM.GRAPHSESSION.C_COUNT  

Multisite 

New Naming Algorithm for Tar Files 

z The new naming consists of concatenation of environment, COID and sequence number.  
z Old tar files are readable.  
z The import mechanism no longer depends on the tar file name.  

To change the naming, use the declaration parameter:  

CATCDMA.VPM.MULTISITE.NAMING : INTEGER;  

/*  

0 ==> OLD_NAMING  as before ptf7  

1 ==> NAME FORMAT is CAENV_coidhexa_seqno  

2 ==> NAME is pure random   

*/  

CATCDMA.VPM.MULTISITE.NAMING = 0 ;  

Optimizing to Copy Longfields into the Tar File 

This is intended for longfields stored in files, to improve performance and robustness.  

To run the new PTF7 behavior, use the declaration parameter:  

CATCDMA.VPM.MULTISITE.EXPORT.LFCOPY  : LOGICAL; 
CATCDMA.VPM.MULTISITE.EXPORT.LFCOPY  = TRUE;  
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Export/Import Logging 

If you want to use logging, run the script MS_LOG_DB2.clp for DB2 or MS_LOG_Oracle.sql  for Oracle.  

To enable logging, use the declaration parameter:  

CATCDMA.VPM.MULTISITE.LOGGING  : LOGICAL; 
CATCDMA.VPM.MULTISITE.LOGGING  = TRUE;  

Configuration 

Updating Configuration Handlers from Dictionary Rules 

The aim of this improvement is to provide the possibility to update the contents of the configuration handlers with regards to the dictionary 
changes (essentially to the rules). 
For example, if users have created new rules in the dictionary of a product that has existing configuration handlers, they can update,  in a 
single step, all the existing configuration handlers by applying rules to them. 
If any conflict appears when applying rules to configuration handlers, this will interrupt the operation without modifying any of them.  

AT0MIGDICO Batch 

The aim of this batch is to migrate the option dictionary of the configuration management from ENOVIAVPM 1.2 to ENOVIAVPM 1.3 (or 
newer level). 
This creates ENOVIAVPM 1.3 categories in the dictionary corresponding to ENOVIAVPM 1.2 option types.  

Configuration Database Cleaner for ENOVIAVPM 

The aim of this batch is to clean the configuration database of:  

z inconsistencies between different configuration objects  
z useless data (garbage)  

This cleaning process should correct certain potential VPM crashes and increase performance (assembly expand, for example).  
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New Security Process 

Prerequisite Interoperability PTFs 

For CATIA 424-1, the following PTFs are prerequisite:  

z HC83200: MML type model to model => entity to entity migration: Action required.  
z HC83814: There is no extraction of passing planes on VPM.  
z HC83996: Error 744 when reading a dr model from the PSN graph.  
z HC84033: It is impossible to manage document revision using DMUSLF.  
z HC84902: The File=>Save command in CATIA updates frozen Parts.  
z HC85860: The cgr stored in datalinks is not updated after the V4 model is modified.  
z HC85938: A model cannot be stored using DBLFCAT.  
z HC85967: A model cannot be stored using DBLFCAT.  
z HC86219: There is no way to redirect the /tmp.  
z HC86785: Chamfer FD&T dimensioning is split into two when in the VPM assembly context.  
z HC87012: When executing the File=>Save command, VPM cannot be found to save a model. An error occurred in the Japanese 

environment.  
z HC87510: The Merge function does not follow the security process.  
z HC87755: There is a performance problem loading the FD&T function on an assembly coming from VPM.  
z HC87890: No trace file is generated in the QP035AMP output + DMUSLF problem  
z HC87969: The 4DNav tesselation batch failed with a VPM database.  
z HC89158: When you version a Part, the tolerances are not updated.  
z HC89710: Assembly tolerancing becomes inactive after Part versioning in VPM.  
z HC89784: Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation fault. DBLDRW entry 

issued.  
z HC90047: An abend occurs when opening a V5 model in V4.  

Application Function Command Engineer Administrator Purpose

VPM BOM BackupManagement x x Manages the 
Backup 
Management 
panel in VPM.
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z HC90465: There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.  
z HC91265: The compute structure does not work with the GFMNOD catgeo.  
z HC91296: Box zoning does not work Project-comprehensive  
z HC91642: A twin model cannot be opened in CATIA V4 after a new version.  
z HC91658: Backup management for saved versions of CATIA models.  
z HC92272: The QP035AMP process is triggered when saving a model on HP.  

Cumulative Fixes PTF7 

Free Text PTF7 

OS UB OS UB OS UB OS UB
IX UB98821 HP UB98822 SG UB98840 SU UB98817

IX UB98819 HP UB98828 SG UB98839 SU UB98825

IX UB98830 HP UB98837 SG UB98832 SU UB98823

IX UB98820 HP UB98826 SG UB98841 SU UB98816

IX UB98815 HP UB98818 SG UB98824 SU UB98827

IX UB98836 HP UB98814 SG UB98829 SU UB98834

IX UB98833 HP UB98831 SG UB98835 SU UB98838

Action z HC90452: There is an abend S006 when I click on Action 1 to see the proposed 
effectivity.  

z HC90530: Although part P1 is configured as having range type only, the date type 
effectivity is propagated on the link P1-P2.  

z HC91419: There is an abend S006 when a link is created in the PSN with only 
privilege on Action: Action query.  

z HC91912: Only one choice is required in the status list for a complex query on an 
Action.  

Admin z HC91362: Help files cannot be displayed in Netscape.  
z HC89539: An abend occurs in VPM when more than 19 Part attributes are 

defined in the profile.  
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z HC91887: Error messages from CDM triggers are not correctly displayed.  
z HC91954: VPM settings are not saved ABS2.  
z HC92547: Save Clash Data / REPOSITORY_APPDATA is not taken into account. 

BOM z HC90420: There is a problem with Save graph session after Filter in.  
z HC90561: Old data stays in the Search word field for a simple query of VPMA in 

spite of clearing it.  
z HC90967: There is a problem when opening a .psn created from a PSN expand 

with a configuration with date.  
z HC92069: Static graphs do not work well with Filter by identification.  
z HC82237: When the Highlight in PSN option is selected the response time is 

unacceptable.  
z HC77599: After a hazardous operation the PSN panel cannot be closed.  
z HC90268: VPM crashes when a model is launched in a large PSN.  
z HC90824: Traces when displaying color in the PSN using a user exit.  
z HC91865: Entries cannot be renamed or deleted in a client custom table in cust 

spec environment.  
z HC90709: There is an icon problem in the PSN when using a user exit.  
z HC90679: Refresh Color icon fails in the PSN.  
z HC91314: There is an abend S0011 when doing a cut in the Context menu of the 

PSN depressing Ctrl when performed a second time.  
z HC87586: There is an error when using the batchpack-userid.log file.  

CATCDMA z HC91036: VPM goes down after a volume filter.  

CFG z HC91325: How can Get Config options be removed from the VPM query panel.  
z HC90946: The Set configurable operation in the PSN is extremely slow on the 

Oracle database.  
z HC91825: When selecting the link effectivity of a Part and its parents which are 

not the elements whose Replace was done, an abend occurs.  
z HC90667: When saving a .psn file in a user quotas nearly or completely full, the 

file is incomplete or empty.  
z HC91795: The expand works differently in Advanced mode.  
z HC92308: There is a problem with a PSN expand with option and milestone 

configuration.  

Interoperability z HC91599: A user exit is not called when moving Parts in CATIA V5.  
z HC92132: CATPart loading from the PSN is inconsistent (after an Associate in the 
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PTF8 Update 
REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample.  

Connection Module Generation Problem with Oracle and IRIX 

To solve this problem, modify the lkora shell script as follows:  

1. Replace: 

#############################################################################  
## MAIN  

PSN).  
z HC92328: Constraints are lost when an assembly is versioned.  

MML z HC91099: A line in MMLSynch.sh is not in the right place.  
z HC91472: There is a problem synchronizing MML links with a batch. Caution! 

CATIA V4 PTFs are needed: 
422-1 : HC90954 
424-1 : HC83200 
424-2 : HC90954  

P & O z HC92316: Using the P&O privilege ACTION_USE instead of ACTION_EDIT 
results in a system abend when saving the PSN after any kind of modification.  

z HC91333: The VPMLoginSession method does not work properly.  
z HC90804: There is a coredump when a CATPart is opened from VPM Access 

using CATIA V5R7 SP5. There is no problem opening the CATPart from the PSN 
window.  

z HC91409: VPM crashes when you try to print the result of the P&O person tab.  

PSN z HC86436: There is a problem saving the PSN graph after applying a Filter in.  
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#############################################################################  

with:  

ratrap_oracle_include ()  
{  
[[ $TRACE_VPM -ge 1 ]] && set -x  
II="-I "  
for mot in $*  
do  
case $mot in  
-I) continue ;;  
*)  
if [[ -d $mot ]] ; then  
TEMPO=$TEMPO$II$mot" "  
# echo TEMPO=$TEMPO  
fi  
;;  
esac  
done  
ORA_INCLUDES=$TEMPO  
#echo ORA_INCLUDES=$ORA_INCLUDES  
} # end of ratrap_oracle_include  
#############################################################################  
## MAIN  

#############################################################################  

  

2. Replace: 

if [[ $os = IRIX ]] ;then  
ratrap_oracle dbcsta  
ratrap_oracle dblsas  
ratrap_oracle dbindb  
ratrap_oracle orindb  
ratrap_oracle orxsta  

fi  

with:  
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if [[ $os = IRIX ]] ;then  
ratrap_oracle_include $ORA_INCLUDES  
ratrap_oracle dbcsta  
ratrap_oracle dblsas  
ratrap_oracle dbindb  
ratrap_oracle orindb  
ratrap_oracle orxsta  
fi  

User Exits 

The user exit GetReplaceCustomParts has been added in PTF8.  

It is called when the custom replace is activated in the PSN (see Product Structure Navigator Customization below the and header file 
CATDMUsrMethod.h for details).  

Login Customization 

This file describes how to customize the login process of VPM in order to both check and modify the user/password provided by the end 
user when starting VPM. 
It is thus possible, for example, to replace the input password entered by a user with another one stored in an external dictionary, so the 
end user never actually uses a "real" database password, and cannot access the database through command-line tools such as db2 or 
sqlplus.  
The solution is based on a user exit which is called at login time, after the user has entered his or her id and password and before the 
application connects to the database.  
The database connection will actually be opened with the user/password provided by the user exit. That user/password will then be used 
for the duration of the following VPM session.  

Requirements 

VPM must be run in server-authenticated mode.  

Customization 

You must rebuild the library VX0SCEXT (e.g. the UNIX file named libVX0SCEXT.so on Sun systems, and so on).  

Page 157 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



Note: The default library provided in standard installations cannot be used here as is. It implements an more complex external login check 
based on the use of a remote web server, such as WebSphere. See Single Sign-On for details.  

The library must contain a C function with the following signature:  

extern "C" int CATVpmSCGetExternalUser(const char* iApplication, 
char** ioUserId , 
char** ioPassword )  

This function will be called at login time by VPM when the user has typed in his or her user and password. 
The argument iApplication contains the application that is currently being accessed. At the present time, that can be either VPM for 
the standard VPM interactive application or various batches and tools, or VPMAdmin when starting the P&O administration tool (e.g. 
VPMPeopleEdit). 
The arguments ioUserId and ioPassword contain the user and password provided by the user. 
The value contained in these variables may be modified by the method, so VPM will actually use a different user and/or password to 
connect to the database, as explained above.  

Note: when modifying the value of the user or the password, memory allocation and de-allocation should be performed by the operators 
new and delete.  

The method should return 0 indicating success (i.e. the user/password typed in are valid and accepted) or any other value if the user 
and/or password are rejected. 
The sample file CATVpmSCGetExternalUser.cpp provided with the installation contains a basic implementation of the method that 
reads the output user and password in environment. Refer to the file itself for details.  

Building and Linking the Library 

The shell makeVX0SCEXT.sh is provided for building the library.  

Type in:  

makeVX0SCEXT.sh <dir>  

where <dir> is the directory containing the source file(s). Once the build and link perform successfully, the library libVX0SCEXT.so is 
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created in the current directory.  

Run-time Environment Customization 

Once the run-time environment is set, type in:  

VPMSettings –a –n VPM_EXTERNAL_LOGIN –v YES  

to activate the external login code in VPM.  

Type in the following:  

export STEPLIB=<dir>:$STEPLIB 
export LD_LIBRARY_PATH=$STEPLIB  

where <dir> is the directory where the library libVX0SCEXT.so is located.  

Versioning Customization 

When versioning a Part, the representations that are copied from the previous Part to the new one keep the same user and organization 
as the source representations.  

It is now possible to modify this behavior by assigning the duplicated representations to the current VPM user and organization. This is 
done by setting the declaration parameter CATCDMA.VPM.VERSION.REVISION.KEEP_RESPONSIBLE to FALSE.  

PSN Customization 

The PSN is enhanced with a new "custom replace" command. In addition to the standard replace commands allowing a Part to be 
replaced with the one stored in the clipboard or with another of its versions, it is possible to provide the list of candidate Parts through a 
dedicated user exit. 
The custom replace is activated by setting the declaration parameter CATCDMA.PSN.REPLACE_CUSTOM to TRUE. 
A new Replace/Part custom… will then be available from the contextual menu of Part objects. 
The user exit called by VPM to get the list of candidate parts is:  

Page 159 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



CATDMUsrMethod::GetReplaceCustomParts  

These Parts will be displayed in a list so users can choose which one they want to replace their Part with. 
Refer to the user exit header for further information on how to use this method.  

PSN Session 

z In a PSN, settings can be defined for object display and filter. These settings are stored with the PSN session, and applied when it is 
read. Otherwise, the current settings are applied, and the filtering can be totally different from those that were applied to the graph 
when it was saved.  

z In the Load graph session window, the Report option, when selected, generates a report recalling the options (file name, 
All/Selected instances, Static/Dynamic, Viewer), and potential problems or events that occurred during graph expansion, i.e. a Part 
that was not found or that was replaced due to a move subsequent to the session save. This report is automatically displayed, and 
can be displayed later from the Session info window.  

z In dynamic mode, the parts come from the database. A part that was selected or collapsed may have been replaced, or moved since 
the session was saved. But you still want the new part to be selected or replaced. To allow that, the identification algorithm that is 
used in the compare graph is used for the expansion of the graph.  

AT0EXPND 

XML 

The Portal is able to generate XML files describing an assembly, files that DELMIA can read. To simplify the generation of these files, it is 
possible to generate them using AT0EXPND. XML is a new savemode. It works only from a Part, selected with its COID, COMPID and 
environment. A config handler can be specified, but no CSB filter (DELMIA is supposed to work with the complete product. You only have 
to specify the configuration). Some settings need to be made with VPMSettings:  

IPD_CGR_OUTPUT_DIR: CGR directory 
IPD_EXPORT_REPOSITORY: xml file directory 
CGR_BATCH_AUTO_EXPORT=YES: for CGR generation  

PSN Session as Input 

AT0EXPND can read a PSN session, with the following new parameters:  
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z PSNfile: name of the PSN session  
z readmode: DYNAMIC or STATIC.  

With this mode, the CSB filter, the config handler and the root part are managed through the PSN session, so they cannot be defined as 
arguments.  

Format 

In the BOMFILE savemode, it is possible to specify the format, html or text, as with the Print part list interactive command of the PSN.  

Report 

As in interactive mode, it is possible to generate a report when a PSN session is read. Its name is the same as the session, but its 
extension is txt.  

Selecting Attributes in the Result Window 

By default, the list of the attributes displayed in the VPMAccess window is hard-coded. However, you can also define the list with the 
profile for the VPMADM environment, by means of the GLOBAL_$RESULT_ACTION variable.  

Example  

/* DEFINITION OF SQL VIEWS */  

/* ONE TABLE DIALOGUE VIEWS */  

/* MULTIPLE TABLES DIALOGUE VIEWS */  

/* FORMAT VARIABLES */  

ASSIGN ’SELECT "secondary_id", "action_type", "priority", "owner", "organization", 
"start_date" , "end_date", "status", "description" FROM "Action"’ 
TO "GLOBAL_$RESULT_ACTION";  

/* MISCELLANEOUS VARIABLES */  
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ASSIGN ’ACTION’ TO "GLOBAL_$LIST_QUERIES";  

ASSIGN ’2002 05 13 11 41 44 000000’ TO "GLOBAL_C_LASTMOD";  

ASSIGN ’MMS’ TO "GLOBAL_C_LASTMOD_USER";  

ASSIGN ’FIN DU CS’ TO "GLOBAL_FIN";;  

STEP Import Declaration Parameters 

z catcdma.*.IMPORT  
z catcdma.STEP.MODE.REP.IMPORT  

Online Documentation 

To access the online documentation from VPM (help on item, etc.), the setting VPM_SEARCH_PATH must be modified.  

For releases up to VPM 1.5 PTF 5, run the following command (to be entered on one line):  

VPMSettings –a –n VPM_SEARCH_PATH –v 
'VPM_ACTION_PARAMETER:$$VPM_AFL_STATUS_GRAPH:$$VPM_AFL_LOG 
_PATH:$$VPM_AFL_METHOD_PATH:$VPM/reffiles:$CATDocView:$CATD 
ocView/online/:$CATDocView/online/vm1ug:$CATDocView/online/ 
vm1ad:$CAT_CUST:$HOME'  

As of VPM 1.5 PTF 6, run the following command (to be entered on one line):  

VPMSettings –a –n VPM_SEARCH_PATH –v  
'VPM_ACTION_PARAMETER:$$VPM_AFL_STATUS_GRAPH:$$VPM_AFL_LOG 
_PATH:$$VPM_AFL_METHOD_PATH:$VPM/reffiles:$CATDocView:$CATD 
ocView/online/:$CATDocView/online/vm1ug_E2:$CATDocView/onli 
ne/vm1ad_E2:$CAT_CUST:$HOME'  

Note: The above examples use the default value of the settings, so you may have to modify it beforehand to take into account specific 
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customizations; the relevant path items relating to the documentation are those containing the string $CATDocView.  

Applicative Containers 

The applicative containers created have to be opened in the same context as they were created. For example, if a container is saved 
under a Part, this Part must be the root Part of the PSN you use to open this container.  

Prerequisite Interoperability PTFs 

For CATIA 424-1, the following PTFs are prerequisite:  

z HC83200: MML type model to model => entity to entity migration: Action required.  
z HC83814: There is no extraction of passing planes on VPM.  
z HC83996: Error 744 when reading a dr model from the PSN graph.  
z HC84033: It is impossible to manage document revision using DMUSLF.  
z HC84902: The File=>Save command in CATIA updates frozen Parts.  
z HC85860: The cgr stored in datalinks is not updated after the V4 model is modified.  
z HC85938: A model cannot be stored using DBLFCAT.  
z HC85967: A model cannot be stored using DBLFCAT.  
z HC86219: There is no way to redirect the /tmp.  
z HC86785: Chamfer FD&T dimensioning is split into two when in the VPM assembly context.  
z HC87012: When executing the File=>Save command, VPM cannot be found to save a model. 

An error occurred in the Japanese environment.  
z HC87510: The Merge function does not follow the security process.  
z HC87755: There is a performance problem loading the FD&T function on an assembly coming from VPM.  
z HC87890: No trace file is generated in the QP035AMP output + DMUSLF problem  
z HC87969: The 4DNav tesselation batch failed with a VPM database.  
z HC89158: When you version a Part, the tolerances are not updated.  
z HC89710: Assembly tolerancing becomes inactive after Part versioning in VPM.  
z HC89784: Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation fault. DBLDRW entry 

issued.  
z HC90047: An abend occurs when opening a V5 model in V4.  
z HC90465: There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.  
z HC91265: The compute structure does not work with the GFMNOD catgeo.  

Page 163 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



z HC91296: Box zoning does not work Project-comprehensive  
z HC91642: A twin model cannot be opened in CATIA V4 after a new version.  
z HC91658: Backup management for saved versions of CATIA models.  
z HC92272: The QP035AMP process is triggered when saving a model on HP.  
z HC93920: It is not possible to build a profile using VERPROF.  

Cumulative Fixes PTF8 

Free Text PTF8 

OS UB OS UB OS UB OS UB
IX UB99769 HP UB99768 SG UB99771 SU UB99779

IX UB99770 HP UB99772 SG UB99785 SU UB99808

IX UB99773 HP UB99774 SG UB99786 SU UB99815

IX UB99775 HP UB99780 SG UB99787 SU UB99818

IX UB99776 HP UB99783 SG UB99790 SU UB99821

IX UB99777 HP UB99793 SG UB99791 SU UB99822

IX UB99778 HP UB99794 SG UB99792 SU UB99823

IX UB99781 HP UB99795 SG UB99797 SU UB99824

IX UB99782 HP UB99796 SG UB99798 SU UB99825

IX UB99784 HP UB99801 SG UB99799 SU UB99826

IX UB99789 HP UB99802 SG UB99800 SU UB99827

IX UB99805 HP UB99809 SG UB99830 SU UB99828

IX UB99806 HP UB99810 SG UB99804 SU UB99829

IX UB99814 HP UB99811 SG UB99807 SU UB99830

IX UB99816 HP UB99819 SG UB99812 SU UB99831

IX UB99817 HP UB99820 SG UB99813 SU UB99832
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Action z HC92219: In the Action Editor panel, the display of some attributes is truncated at 
random.  

z HC93539: There is no error message after validating an Action.  

Admin z HC94675: A local administrator cannot connect to VPM.  
z HC92571: Constraints are not stored in VPM when the global repository is set to 

DBLFCAT. LF00001 works. DMUSLF is involved.  
z HC93480: The custom master table is still referenced attached to Part_List.  

CSB Admin z HC94132: There is an error regarding voxel size in the VPM Installation and 
Administration Guide.  

BOM z HC92837: When ’<’ or ’between’ is used, the advanced filter produces different 
results.  

z HC92722: In the PSN, the Associate Model method is not well managed.  
z HC93829: An attribute not authorized on C_ORDER when there is a new revision 

on PTF7.  
z HC94671: A Part pasted in the PSN cannot be displayed.  
z HC93029: There is a CPU loop on a duplicate with DB2.  
z HC92348: The filter produces wrong results.  
z HC94677: Filtering on Parts that have been pasted does not work.  
z HC94682: An effectivity in the Info-Link panel cannot be selected.  
z HC92108: The BOM print of the PSN in html format does not give the attributes.  
z HC80406: There is a problem of superimposed windows when VPM is used with 

CATIA.  
z HC93397: There is a problem opening a PSN with selected instances after 

modifying the position of a model selected in the PSN.  
z HC94689: There is a problem when the volume of a Part in the PSN is requested if 

the declaration parameter catcdma.VPM.EXPAND.PTF is activated.  
z HC93418: The Replace from clipboard does not work properly.  
z HC94062: The setup of the declaration parameter S_TYPE_REP is not reflected in 

the Zone Filter result.  
z HC94686: The Never function of the filtering container is inoperative.  
z HC94668: PSN filtering does not apply to an opened PSN.  
z HC93301: The model without the P&O read permission can be loaded into CATIA 

from the VPM/PSN tree.  
z HC93271: A VPM1.5PTF5 / D5_41 / Catia 424R1 document cannot be loaded.  
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PTF9 Update 

Installation 

if the AIX installed C++ RunTime is 5.0.2, it must be the 5.0.2.7 otherwise the first problem encountered is an abend during installation.  

REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample.  

IMPORTANT! 
CATIA PTFs: New Prefix 

For many years, CATIA PTFs were made up of the prefix UB, followed by a five-digit number. As all possible numbers have now been 
used, it is necessary to adopt a new prefix: UH.  

The CATINST procedure is however unable to install any PTF delivery whose prefix is UH (and not UB). The following messages appear:  

Error message: 
An error occurred: 

z HC93941: When applying the Associate model function to a model moved from the 
clipboard, an SDAI error occurs.  

z HC93456: When modifying ownership in VPM Access in a Part selection, the 
commit is only done at the end of the list.  

CFG z HC93854: VPM crashes when a multi-attribute is used in an instance attribute 
query.  

Multisite z HC92750: There is a problem when a site transfer is made on a Part that is already 
in the queue with the Complete status.  
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CATUnitToc: incorrect FIX id: UHnnnnn 
CATInstToc: Init of line number 1 from control/UHnnnnn.code. 
toc failed 
WFTOCENC: control/UHnnnnn.code.toc: Bad file 
WFIS01704 - Invalid toc format: code/UHnnnnn ignored  

The CATINST procedure includes a test on the file prefix but only UB files are recognized, not UH files.  

The UBs correcting this problem are as follows:  

  

You do not need to build a configuration as the corrective UB unload is sufficient. When unloading this corrective, you should be aware 
that the selection within a list is not possible if at least one UH is already unloaded. In this particular situation, you are requested to select 
the PTF for this APAR keying in its identifier.  

WARNING!  
The signature for the user exit CATDMUserMethod::OpenObject has changed. 

Formerly it was: void OpenObject(const char *iViewer, const int iNbObj, ObjID *iObj) 
and is now: Error OpenObject(const char *iViewer, const int iNbObj, ObjID *iObj)  

Applicative Containers: PSN (libLV0XCDMA.a) 

Note that in the section PSN (libLV0XCDMA.a) of the PTF6 section about applicative containers, an example of a PSN.in file is given 
including the table name DOCV5. Note that this name is only provided as an example of a table and does not actually exist.  

Managing Table Objects: DOC_CONTAINER (Applicative Containers) 

OS UB OS UB OS UB OS UB
IX UB99906 HP UB99909 SG UB99912 SU UB99915
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To proceed with a revision of DOC_CONTAINER or to ensure duplication of a DOC_CONTAINER when versioning a Part including a 
DOC_CONTAINER, do the following:  

In the profile  

1. ASSIGN ’SELECT S_NAME, S_TYPE FROM DOC_CONTAINER’ TO "GLOBAL_$INSERTS_DOC_CONTAINER"; 
ASSIGN ’DOC_CONTAINER’ TO "GLOBAL_$LIST_NO_CREATE";  

2. Add DOC_CONTAINER to GLOBAL_$LIST_INSERT.  

In the database  

1. Drop the index VPMENV.DOC_CONTAINER2.  
2. Create the unique index VPMENV.DOC_CONTAINER2 on VPMENV.DOC_CONTAINER (S_TYPE, S_UID, S_NAME, C_REVISION)  
3. Commit.  

V4/V5 Multiselection 

When making different types of representation selections (V4 models, V5 documents, etc.), make sure you have declared common 
viewers for these objects.  

Graph Session 

When creating and reading graph sessions for trees with, at any level, V4 and V5 objects under the same Part, make sure you have 
declared common viewers for these objects.  

Prerequisite Interoperability PTFs 

For CATIA 424-1, the following PTFs are prerequisite:  

z HC66598: Tools->Open Editor: If the editor window size is increased no text can be written.  
z HC81497: The MML_SOL link is desynchronized after a save.  
z HC82073: Some errors are detected by the cleaner if the GSM model is loaded from VPMA and CATIA results in an abend at save.  
z HC82887: There is a warning when opening a model.   

Page 168 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



z HC83200: MML type model to model => entity to entity migration: Action required.  
z HC83814: There is no extraction of passing planes on VPM.  
z HC83996: Error 744 when reading a dr model from the PSN graph.  
z HC84033: It is impossible to manage document revision using DMUSLF.  
z HC84902: The File=>Save command in CATIA updates frozen Parts.  
z HC85180: Some volumes in the tree are wrongly propagated.  
z HC85372: There is a problem in the catcsbad.   
z HC85860: The cgr stored in datalinks is not updated after the V4 model is modified.  
z HC85938: A model cannot be stored using DBLFCAT.  
z HC85967: A model cannot be stored using DBLFCAT.  
z HC86219: There is no way to redirect the /tmp.  
z HC86590: The Identify Loaded Models results are partial in the PSN.  
z HC86785: Chamfer FD&T dimensioning is split into two when in the VPM assembly context.  
z HC87012: When executing the File=>Save command, VPM cannot be found to save a model. 

An error occurred in the Japanese environment.  
z HC87755: There is a performance problem loading the FD&T function on an assembly coming from VPM.  
z HC87890: No trace file is generated in the QP035AMP output + DMUSLF problem  
z HC87969: The 4DNav tesselation batch failed with a VPM database.  
z HC88222: There is a problem with a New Version function in DB2.  
z HC89043: There is a QP035AMP crash when a file contains more than 1000 models.  
z HC89158: When you version a Part, the tolerances are not updated.  
z HC89303: There is a core dump with a union on two empty spacemaps.  
z HC89307: There is a core dump when loading the model with a MML on the manufacturing type.  
z HC89784: Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation fault. DBLDRW entry 

issued.  
z HC90047: An abend occurs when opening a V5 model in V4.  
z HC90206: A DMUSLF user exit does not reference the type of model created.  
z HC90465: There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.  
z HC91296: Box zoning does not work Project-comprehensive  
z HC91642: A twin model cannot be opened in CATIA V4 after a new version.  
z HC91658: Backup management for saved versions of CATIA models.  
z HC91750: Save All with VPM and CATIA model  
z HC92272: The QP035AMP process is triggered when saving a model on HP.  
z HC92618: E3D CDMA Parts cannot be accessed if the VPM (or CDM) environment exceeds five characters.  
z HC92705: After closing a 4DNav session started from VPM, it cannot be restarted.  
z HC93487: A model with a voxel size of 5mm cannot be stored in VPM.  
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Cumulative Fixes PTF9 

Free Text PTF9 

OS UH OS UH OS UH OS UH
IX UH00408 HP UH00393 SG UH00404 SU UH00405

IX UH00390 HP UH00398 SG UH00392 SU UH00406

IX UH00395 HP UH00407 SG UH00401 SU UH00394

IX UH00396 HP UH00399 SG UH00402 SU UH00397

IX UH00403 HP UH00400 SG UH00389 SU UH00391

Action z HC91796: The visualization of an Action proposed effectivity is too restrictive.  
z HC95195: There is an abend S0011 after promoting an Action to be completed.  
z HC94544: There is a problem with the Publish/Subscribe functions and secondary 

ID actions.  

Admin z HC94405: catcdma.VPM.CFGDB.QUERY is not declared.  
z HC95573: The user exit GetInputListOfValues() gives an incorrect return code 0 

for static INT IsVPMSessionInteractive() where it should be a 1.  
z HC96666: A STEP AP203 / AP214 export from VPM produces CatParts with illegal 

characters.  

APIs and User 
Exits

z User exit to control operation on rules / packages / matrix  
z User exit to control operation on milestones  
z API to modify the visibility of an existing configuration handler  
z Add visibility parameter to CATCfgInterfaces::CreateConfigHandler  
z API to get action history used to configure a link  
z API to get Set Configurable types on a Part  

BOM z HC81880: When loading models, if you activate the contextual menu, the current 
session is locked.  

z HC90926: Unnecessary information [1] is also pasted into the Part Number field 
when Relation->Get All Components is used.  

z HC92722: Associating the model in the PSN is not well managed.  
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z HC92948: There is an abend S004 after opening a model in CATIA from the PSN.  
z HC94062: The setup of the S_TYPE_REP declaration is not reflected in the Zone 

Filter result.  
z HC94491: The XCAD server does not calculate the .cgr, 3dmap and .model files.  
z HC94494: The user exit AuthorisedDuplicatedRepresentations does not return an 

error message.  
z HC94689: There is a problem when we request the volume of a Part in the PSN if 

the setting catcdma.VPM.EXPAND.PTF is activated.  
z HC94668: PSN filtering does not apply to an opened PSN.  
z HC94698: The Multisite import/export daemon does not support datalinks.  
z HC94960: New children in the PSN are not displayed.  
z HC95671: The Save Graph Session and Open Graph Session operations do not 

take care of the default configuration set.  
z HC95713: Short or long messages do not come out with AfterCommitUserAction.  
z HC96031: VPM interoperability: Malfunction of Identify Loaded Models in the PSN 

- Error 20356 - 1 model has not been found.  
z HC73378: VPM and ws are locked when selecting a new function in the main 

panel with a new value in the Simple Query field.  
z HC89560: There is a S0010 crash when a Part is moved outside the Set Current 

scope.  

CFG z HC95938: Lost configuration handler when new version  

ITVPMCV5 z HC95551: New versions of Assembly drawings lose links.  
z HC96027: VPM crashes when opening from the PSN an assembly with a fix 

together constraint.  

ITVPMNT z HC95509: There is a severe performance problem when loading an assembly from 
VPM NT to CATIA V5.  

Miscellaneous z Open .psn saved as document into VPM 
Flag: 
catcdma.GRAPHSESSION.DOC : LOGICAL ; 
catcdma.GRAPHSESSION.DOC = TRUE;  

z Add Companion access to the VPM help menu  
z Add User Galaxy access to the VPM help menu  

MML z HC91780: V5 interoperability: Incorrect MML after a new revision  
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PTF10 Update 
REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample.  

Compare with Database Command 

You will remember that the Compare with Database command did not take into account:  

z what is displayed (a collapsed branch will be compared)  
z the configuration filter (a filtered part will be compared)  
z the CSB filter (a filtered Part will be compared).  

This has been corrected and this now works in a similar fashion to the Compare graph function.  

z HC93018: VPM1.5 PTF5 - ChangeModelUUID  

NT Server z Define effectivity  
z Edit effectivity  
z Config analysis  
z Branch analysis  
z Child analysis  
z Parent analysis  
z Commit with history  
z Modification status (on action)  

PSN z Automatically display report on commit failed 
Flag: 
catcdma.VPM.COMMIT.ERROR_AUTO_REPORT : LOGICAL ; 
catcdma.VPM.COMMIT.ERROR_AUTO_REPORT = TRUE;  

STEPITFE z HC95924: VPM STEP Import prereqs: 
catcdma.STEP.OVERWRITE.REP.IMPORT=TRUE  

z HC95928: VPM STEP Import cannot write V5 doc with D_PATH not null  
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This means that there are now two comparison modes: links or leaves.  

Security Process 

C++ Compiler Prerequisites 

Under AIX, the following C++ compiler levels are not supported: xlC.rte 5.0.2.4, 5.0.2.5 and 5.0.2.6.  

New Declaration Parameters 

z catcdma.VPM.OPT_GRAPH.HIDE_REJECTED_MNGT  
z catcdma.VPM.EXPAND.INQMARK  
z catcdma.VPM.CFGDB.MAX_ARG  

New Trigger Version to Optimize the Expand 

A new version of database triggers to maintain C_COUNT is provided. 
Delete triggers have been improved to compute the exact number of the remaining sons for a Part.  

Updating Tables 

For each environment play the update1_EXT script sql .  

Application Function Command Engineer Administrator Product 
Engineer

Purpose

VPM BOM BackupManagement x x x Manages the 
Backup 
Management 
panel in 
VPM.
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DB2 

1. Run the DB2 script update1_EXT.clp which is in $HOME/InstallVPM/reffiles/DBMS/ddl of the VPM administrator before replacing 
VPMENV with the environment name and VPMADM with the VPM administrator name.  

Oracle 

1. Run the Oracle  script update1_EXT.sql which is in $HOME/InstallVPM/reffiles/DBMS/ddl of the VPM administrator before replacing 
VPMENV with the environment name and VPMADM with the VPM administrator value.  

Script Update 1_EXT.sql 

When migrating to PTF10, the script update 1_EXT.sql must be modified as follows:  

The line:   

grant execute on VPMENV.EXT_PKG to public ;  

must be added after creating the package VPMENV.EXT_PKG. 
When the scripts update1_EXT.sql and update_FEATURE.sql are launched, you must be connected to VPMENV.  

Minimizing the Required Memory on the Database Server during the Expand 

There are two declaration parameters to control needed memory on the Database Server (for example APP_CTL_HEAP_SZ for the UDB 
server).  

z for Product Structure queries: 
catcdma.VPM.EXPAND.INQMARK : INTEGER ;  

z for configuration queries: 
catcdma.VPM.CFGDB.MAX_ARG  : INTEGER ;  

These declaration parameters control the number of values in queries such as: WHERE $COID IN (?,?, ...). 
You can change these default values, but if you do so, exercise caution. 
If you use a larger number, you minimize the number of queries on the server but you need more server memory. 
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If the number you choose is below 75 you need less memory on the server but you increase the number of queries.  

The default values are as follows:  

z catcdma.VPM.EXPAND.INQMARK = 250 ;  
z catcdma.VPM.CFGDB.MAX_ARG = 200 ;  

To minimize APP_CTL_HEAP_SZ on a UDB 7.2 server you can set CATCDMA.VPM.CFGDB.MAX_ARG to 100.  

Performance Improved When Saving DMU V5 Applicative Containers 

Performance when saving DMU V5 applicative containers in VPM has been enhanced.  

To implement this, you must set the following declaration parameters:  

  

To avoid incompatibility, make sure the VPM declaration parameter is correctly set.  

STEP_NAME 

Just as for any non-persistent attribute, i.e. not originating from the database, it is imperative that you first of all regenerate the 
cdma.express file by means of the shell catpsninst.sh .  

Backup Management 

Backup management implementation requires the following APARs:  

  

z in VPMcatcdma.VPM.PERFO_CONTAINER_V5=TRUE;
z in V5  export CV5_VPM_PERFOCONT=1;
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ComputeUserValueBeforeWrite 

To activate the user exit ComputeUserValueBeforeWrite, you must export the following variable:  

export CATComputeUserValueBeforeWrite=YES  

This variable is set to NO by default.  

Prerequisite Interoperability PTFs 

CATIA 424-1  

The following PTFs are mandatory:  

AIX HC97527
HP HC97528
SG HC97529
SUNHC97530

no 
APAR Description

HC66598 Tools->Open Editor: If the editor window size is increased no text can be written.

HC83814 There is no extraction of passing planes on VPM.

HC84902 The File=>Save command in CATIA updates frozen Parts.

HC86590 The Identify Loaded Models results are partial in the PSN.

HC86219 There is no way to redirect the /tmp.

HC88222 There is a problem with a New Version function in DB2.
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The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

HC89784 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation 
fault. DBLDRW entry issued.

HC91642 A twin model cannot be opened in CATIA V4 after a new version.

no 
APAR Function Description

HC87969 4DNAV The 4DNav tesselation batch failed with a VPM database.

HC92705 4DNAV After closing a 4DNav session started from VPM, it cannot be restarted.

HC95918 4DNAV Models move incorrectly in 4DNav.

HC83996 AUXVIEW2 Error 744 when reading a dr model from the PSN graph.

HC89307 CATMFG There is a core dump when loading the model with an MML on the manufacturing 
type.

HC85180 CSB Some volumes in the tree are wrongly propagated.

HC85372 CSB There is a problem with the catcsbad.

HC87890 CSB + 
SAVE No trace file is generated in the QP035AMP output + DMUSLF problem

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models.

HC91296 CSB Box zoning does not work Project-comprehensive

HC92272 CSB The QP035AMP process is triggered when saving a model on HP.

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM.

HC85860 DATABASE The cgr stored in datalinks is not updated after the V4 model is modified.

HC92618 E3D E3D CDMA Parts cannot be accessed if the VPM (or CDM) environment exceeds 
five characters.

HC86785 FD&T Chamfer FD&T dimensioning is split into two when in the VPM assembly context.

There is a performance problem loading the FD&T function on an assembly 
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CATIA 424-2  

The following PTFs are mandatory:  

HC87755 FD&T coming from VPM.

HC89158 FD&T When you version a Part, the tolerances are not updated.

HC83200 MML MML type model to model => entity to entity migration: Action required.

HC82887 OPEN There is a warning when opening a model.

HC90047 OPEN An abend occurs when opening a V5 model in V4.

HC84033 SAVE It is impossible to manage document revision using DMUSLF.

HC85938 SAVE A model cannot be stored using DBLFCAT.

HC85967 SAVE A model cannot be stored using DBLFCAT.

HC87012 SAVE When executing the File=>Save command, VPM cannot be found to save a 
model. 
An error occurred in the Japanese environment.

HC87890 CSB + 
SAVE No trace file is generated in the QP035AMP output + DMUSLF problem

HC90206 SAVE A DMUSLF user exit does not reference the type of model created.

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.

HC91658 SAVE Backup management for saved versions of CATIA models.

HC91750 SAVE Save All with VPM and CATIA model

HC82073 SKIN Some errors are detected by the cleaner if the GSM model is loaded from VPMA 
and CATIA results in an abend at save.

HC81497 SOLIDE The MML_SOL link is desynchronized after a save.

HC89303 SOLIDE There is a core dump with a union on two empty spacemaps.

no APAR Description
HC89784 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation 

fault. DBLDRW entry issued. 
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The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

HC91639 Standard DS traces cause problems. The delivery for UB97943, UB97941, UB97942, 
UB97944 is incomplete. 

no 
APAR Function Description

HC92705 4DNAV After closing a 4DNav session started from VPM, it cannot be restarted. 

HC95918 4DNAV Models do not move correctly. 

HC89307 CATMFG There is a core dump when loading the model with a MML on the manufacturing 
type. 

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models. 

HC89303 CSB There is a core dump with a union on two empty spacemaps. 

HC91296 CSB Box zoning does not work Project-comprehensive 

HC92046 CSB VPM/CATIA lock in the spacemap. 

HC92272 CSB The QP035AMP process is triggered when saving a model on HP. 

HC93336 CSB VPM/CATIA lock in the spacemap (part 2). 

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM. 

HC97304 CSB The spacemap filter does not work properly with a model. 

HC98203 CSB Modification on CSB volume algorithm 

HC90454 MML Change UUID also keeps the link to the original version of the model. 

HC90047 OPEN An abend occurs when opening a V5 model in V4. 

HC95245 OPEN V5->V4 interoperability: V4 delivery for compatibility with V5 command Send To  

HC90206 SAVE A DMUSLF user exit does not reference the type of model created. 

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM. 

HC91658 SAVE Backup management for saved versions of CATIA models. 

HC91750 SAVE Save All with VPM and CATIA model 
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Cumulative Fixes PTF10 

Free Text PTF10 

OS UH OS UH OS UH OS UH
IX UH00724 HP UH00720 SG UH00731 SU UH00717

IX UH00734 HP UH00722 SG UH00729 SU UH00716

IX UH00737 HP UH00719 SG UH00730 SU UH00715

IX UH00721 HP UH00727 SG UH00733 SU UH00718

IX UH00735 HP UH00732 SG UH00725 SU UH00714

Action z HC96872: An SDAI error and an abend S004 occur with an advanced query on an 
Action.  

z HC96382: An Action cannot always be transferred correctly.  

Admin z HC95273: The CatDMUsrSelect class does not result in the correct result when an 
SQL select statement is executed using the Group By function.  

z HC97429: The DBLFCAT repository does not work correctly.  

BOM z HC91970: There is a problem with the panel result of More...  
z HC95374: Applying a query in VPMAccess results in an abend.  
z HC96541: A query on VPM Actions does not work if the criterion is an 

Organization.  
z HC96861: A Graphics PSN session crashes VPM.  
z HC97021: There is an error when Associate New Model is used in a PSN if a view 

exists on PART_LIST.  
z HC97332: New document revisions and new model revisions cannot be created on 

a customized environment.  
z HC97390: Wrong C_COUNT values affect the PSN expand.  
z HC97485: An abend occurs when a Part attribute of the Date type is defined in the 

profile for instance management.  
z HC97104: In the rename panel of the PSN, attributes are not updated after the first 

rename.  
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PTF11 Update 
REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample.  

Multisite 

New XML Capabilities 

A new version of the command file is provided in $VPM/reffiles/DBMS/VPMENV_V2.xml  

For more information, read $VPM/reffiles/DBMS/multisite_XML_guide.txt  

Export  

z column filtering 
For each table you can choose columns to be exported.  

z representation filtering 
You can have filtering on representation tables and the $EXT_LF table.  

z HC97906: A delimiter field is missing in the Print Part list in the PSN.  

CFG z HC96463: There is a problem with the date less than or equal to 01/01/1970 on the 
link executing certain functions such as Replace.  

z HC96773: VPM crashes when the PSN is opened on a configuration with certain 
functions such as Replace and operators such as AND.  

Multisite z HC97173: XML multisite import does not import categories or options.  

P&O z HC96184: Privilege creation results in an abend S0011 when at least two data 
groups are pasted after a search in the data group tab page.  

PSN z HC96896: Opening a PSN graph does not respect the collapsed branches with the 
collapsed brothers on a father function.  
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Import  

z column filtering 
For each table you can choose columns to be imported. 
You cannot filter mandatory columns.  

Warning! Multisite Representation Filtering with XML 

The $EXT_LF table must be the last "ontable" entry in the command file related to the "db" VPMProduct.  

Warning! Multisite Logging with DB2 

You have to recreate logging tables using the script $VPM/reffiles/DBMS/ddl/MS_LOG_DB2.clp. 
Before doing this, replace VPMADM with the VPM Administrator value.  

New Declaration Parameters 

z catcdma.VPM.MML.CATIA_V5  
z catcdma.VPM.MML.CATIA_V5_RELEASE_VALIDITY  

ENOVIA VPM - SAP R/3 Interoperability 

The VPM-SAP interoperability product has been enhanced in PTF11 to support:  

z a multi-VPM environment  
z mapping between VPM BOM (link information) and SAP BOM  
z automatic synchronization of VPM Parts/models/documents from SAP materials/documents  
z direct access to SAP material master data from PSN.  

New SAP transports have to be applied (delivered in $VPM/startup/VPMSAP1.5/Transports). The files for modification of VPM tables are 
in the directory $VPM/startup/VPMSAP1.5/ddl.  

The script $VPM/code/command/vpm2sap.sh describes all the UNIX variables to set for run-time.  
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For a Future PTF: Changes to Existing Declaration Parameters 

z catcdm.DBLFAIX_ALGO  
z catcdma.STORAGE.LF_METADATA  

catcdm.DBLFAIX_ALGO 

The setting DELETE_RR is strongly recommended on both CATIA V4 and ENOVIAVPM.  

WARNING! DELETE_RR will be hardcoded in a future PTF and its behavior at Create & Save time will be as follows:  

z for a commit: 
{ the new representation is kept and is usable  
{ the old representation is deleted or renamed based on catcdm.DBLFAIX_OLD_SUFFIX .  

z for a rollback: 
{ the new representation is deleted or renamed based on catcdm.DBLFAIX_OLD_SUFFIX and is unusable  
{ the old representation is kept as is and is usable.  

Remember that a new file must be written at the time of each Create & Save. If the file already exists a 152 error is returned.  

The vpm c++ methods ComputeValuesBeforeWrite (which keeps the values in the PART_LIST and CATIA_MODEL or DOCxxx columns) 
and CheckLFBeforeWrite (which returns the access method name and data) of the user exit source CATDMUsrMethod.cpp enable you to 
compute the invariant portion of the file name (based on S_PART_NUMBER, C_NICKNAME, ...). CATDMUsrMethod.cpp is compiled and 
link-edited using makeLV0XUSR.sh .  

The DMUSLF user exit allows you to compute the variable portion of the file name (counter, random value). 
DMUSLF is part of the L2USEREX module link-edited with the shared shell. 
The DMUSLF user exit exists on both ENOVIAVPM and CATIA V4 but to activate it on the ENOVIAVPM side specify:  

CATCDMA.CALL_TO_DMUSLF_FOR_DOCUMENT=’YES’  

catcdma.STORAGE.LF_METADATA 

The setting TRUE is strongly recommended on both CATIA V4 and ENOVIAVPM.  
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WARNING! TRUE will be hardcoded in a future PTF and its behavior at Create & Save time will be as follows:  

z The longfield is written before the metadata to shorten DBMS locks so a select from PART_LIST or CATIA_MODEL inside DMUSLF 
will not retrieve anything during the first write.  

Be aware that:  

z the orchmod user exit enables you to change (the owner and) the authorizations of a longfield file  
z it is part of the OB071USX which is built using the oruecl shell  
z it exists on both CATIA V4 and ENOVIAVPM  
z it is called: 

{ just after the close write time  
{ just before the rename or delete time  

z a sample written in c is delivered.  

For a Future PTF: Enhancement Required by Customer and DS Access Methods 

The following concerns customers using any access method overwriting the longfield during the save operation.   

To support the rewriting of a longfield (despite the illogicality of this operation since a rollback is not possible in such a case) on both 
CATIA V4 and ENOVIAVPM, a new declaration parameter is to be created:  

catcdm.dblfaix_algo=’DELETE_BM’;  

A new entry point must be implemented in all access methods: RENAME (to be added to existing init read, open read, read, close read, 
purge read, init write, ..., purge write, delete, generate new access method data). Customer access methods will have to implement 
RENAME but only if it is intended to use DELETE_BM. 
The algorithm for 'write a representation' will be:  

init write fic 
. if BM: - init write fic.new 
- if fic.new already exists: re-write 
open write 
write loop 
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close write 
purge write  
if commit: 
delete fic 
if BM: rename fic.new -> fic  
if rollback: 
if BM: delete fic.new 
else: delete fic  

Note that catcdm.DBLFAIX_OLD_SUFFIX remains valid.  

A PTF will be corequisite for CATIA model write since the code is executed in CATIA processes (HC99292 and HC99343).  

Recommended Interoperability PTFs 

CATIA 424-1  

The following PTFs are mandatory:  

The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

nº APAR Description
HC66598 Tools->Open Editor: If the editor window size is increased no text can be written.

HC84902 The File=>Save command in CATIA updates frozen Parts.

HC86590 The Identify Loaded Models results are partial in the PSN.

HC86219 There is no way to redirect the /tmp.

HC88222 There is a problem with a New Version function in DB2.

HC89784 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation 
fault. DBLDRW entry issued.

HC91642 A twin model cannot be opened in CATIA V4 after a new version.
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nº APAR Function Description
HC87969 4DNAV The 4DNav tesselation batch failed with a VPM database.

HC95918 4DNAV Models do not move properly.

HC98650 4DNAV The MfgProg function does not work for models opened from VPM.

HC83996 AUXVIEW2 Error 744 when reading a dr model from the PSN graph.

HC89307 CATMFG There is a core dump when loading the model with an MML on the manufacturing 
type.

HC85180 CSB Some volumes in the tree are wrongly propagated.

HC85372 CSB There is a problem with the catcsbad.

HC87890 CSB + 
SAVE No trace file is generated in the QP035AMP output + DMUSLF problem

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models.

HC91296 CSB Box zoning does not work Project-comprehensive

HC92272 CSB The QP035AMP process is triggered when saving a model on HP.

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM.

HC85860 DATABASE The cgr stored in datalinks is not updated after the V4 model is modified.

HC92618 E3D E3D CDMA Parts cannot be accessed if the VPM (or CDM) environment exceeds 
five characters.

HC86785 FD&T Chamfer FD&T dimensioning is split into two when in the VPM assembly context.

HC87755 FD&T There is a performance problem loading the FD&T function on an assembly 
coming from VPM.

HC89158 FD&T When you version a Part, the tolerances are not updated.

HC83200 MML MML type model to model => entity to entity migration: Action required.

HC82887 OPEN There is a warning when opening a model.

HC90047 OPEN An abend occurs when opening a V5 model in V4.

HC84033 SAVE It is impossible to manage document revision using DMUSLF.

HC85938 SAVE A model cannot be stored using DBLFCAT.

HC85967 SAVE A model cannot be stored using DBLFCAT.
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CATIA 424-2  

The following PTFs are mandatory:  

The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

HC87012 SAVE When executing the File=>Save command, VPM cannot be found to save a 
model. 
An error occurred in the Japanese environment.

HC87890 CSB + 
SAVE No trace file is generated in the QP035AMP output + DMUSLF problem

HC90206 SAVE A DMUSLF user exit does not reference the type of model created.

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.

HC91658 SAVE Backup management for saved versions of CATIA models.

HC91750 SAVE Save All with VPM and CATIA model

HC82073 SKIN Some errors are detected by the cleaner if the GSM model is loaded from VPMA 
and CATIA results in an abend at save.

HC81497 SOLIDE The MML_SOL link is desynchronized after a save.

HC89303 SOLIDE There is a core dump with a union on two empty spacemaps.

nº APAR Description
HC89784 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation 

fault. DBLDRW entry issued. 

HC91639 Standard DS traces cause problems. The delivery for UB97943, UB97941, UB97942, 
UB97944 is incomplete. 

HC91642 A twin model cannot be opened in CATIA V4 after a new version.

nº APAR Function Description
HC92705 4DNAV After closing a 4DNav session started from VPM, it cannot be restarted. 
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Cumulative Fixes PTF11 

HC95918 4DNAV Models do not move correctly. 

HC89307 CATMFG There is a core dump when loading the model with a MML on the manufacturing 
type. 

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models. 

HC89303 CSB There is a core dump with a union on two empty spacemaps. 

HC91296 CSB Box zoning does not work Project-comprehensive 

HC92046 CSB VPM/CATIA lock in the spacemap. 

HC92272 CSB The QP035AMP process is triggered when saving a model on HP. 

HC93336 CSB VPM/CATIA lock in the spacemap (part 2). 

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM. 

HC97304 CSB The spacemap filter does not work properly with a model. 

HC98203 CSB Modification on CSB volume algorithm 

HC90454 MML Change UUID also keeps the link to the original version of the model. 

HC90047 OPEN An abend occurs when opening a V5 model in V4. 

HC95245 OPEN V5->V4 interoperability: V4 delivery for compatibility with V5 command Send To  

HC90206 SAVE A DMUSLF user exit does not reference the type of model created. 

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM. 

HC91658 SAVE Backup management for saved versions of CATIA models. 

HC91750 SAVE Save All with VPM and CATIA model 

OS UH OS UH OS UH OS UH
IX UH01302 HP UH01333 SG UH01312 SU UH01311

IX UH01299 HP UH01314 SG UH01332 SU UH01317

IX UH01309 HP UH01318 SG UH01316 SU UH01319

IX UH01331 HP UH01308 SG UH01330 SU UH01307
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Free Text PTF11 

IX UH01313 HP UH01303 SG UH01300 SU UH01325

IX UH01296 HP UH01305 SG UH01328 SU UH01323

IX UH01329 HP UH01324 SG UH01326 SU UH01322

IX UH01320 HP UH01301 SG UH01310 SU UH01306

Admin z HC99010: The structure element Error.ShortMsg is badly evaluated in the API.  

BOM z HC97285: The Paste context results in an error when creating a document.  
z HC97874: Printing BOM from the PSN does not work properly when double quotes 

are used.  
z HC97320: The configuration history is wrong.  
z HC92709: The options of catcdm.DBLFLAIX_ALGO are not described.  
z HC98469: The Compare Graph function doers not work properly.  
z HC98026: The link name was lost in the BOM following a model move in CATIA.  
z HC96351: Instance attributes were lost following MODELS/MODIFY/TRANSLATE.  
z HC98977: PSN - Transformation stored BOM - MDL link.  
z HC98668: A second attempt at a STEP export of a Part + model using the same 

name results in an S0006 abend.  
z HC96368: The data does not check out successfully.  
z HC97797: The attribute C_lastmod is not modified after a rename in VPMA.  
z HC70242: The message ’Problem in the method copy’ when using Tab Char.  
z HC97902: PSN Replace from clipboard: There is a problem after Filter by Volume.  

CFG z HC98829: From the Action, removing a link created by the Replace function, does 
not delete the link, only the effectivity.  

DBAccess z HC98900: The first model of a multifolio Part is deleted.  

Install z HC98900: The non-declared parameter catcdma.STORAGE.LF_METADATA is not 
defined in /site/dec/catcdma.dcls .  

Interop z HC98769: A File/Save of a model cannot be performed after abend and warm start 
in CATIA.  

z HC98236: Delivery of VPM 1.5 interface with SAP  
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PTF12 Update 
REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample.  

  

Action Creation: Warning! 

A problem has been found during Action creation. It occurs on all operating systems but ONLY on the Oracle database. (It does not 
happen on DB2.)  

Scenario 

1. Launch ENOVIAVPM.  
2. Object: Action  
3. Create & save an Action.  
4. Search for all Actions, you can see your new Action.  
5. Object: Part  
6. Search for one Part.  
7. Object: Action  
8. Search for all Actions, you can no longer see the Action created in step 3.  

ITVPMCV5 z HC98251: Double-clicking twice on a CATPart results in a loop.  
z HC98166: Wrong positioning when saving a V5 assembly to VPM.  

Multisite z HC99080: There is a problem when we do a Pub/Sub on events with replication on 
two sites in two steps.  

z HC98156: There is an IXF import crash at random.  
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Corrective Action 

A patch is already available with the appropriate installation procedure. 
Please contact L1 for further instructions.  

  

DBFLCAT 

If you use DBLFCAT as a repository method, to delete the .model, you must add the following line in your declaration file (usually 
CATCDM.dcls):  

CATCDM.DBCONN.ORACLE.MODULE = ’JD055CAT’;  

  

New Declaration Parameters 

z catcdma.PSN.REPLACE_CUSTOM  

 

Configuration 

z To add LAST_MODIFIER_ID and LAST_UPDATE_DATE to categories, options and rules in the dictionary manager: 
CATCDMA.VPM.OPT_DICO.SHOW_LAST_MOD = TRUE (LOGICAL)  

z To save the last products used (for options, milestones and config-handlers) in a file,  
check the corresponding option in File->Settings / Configuration  

z To display more info about Actions in configuration parameter panels (Edit Configuration, etc.) customize attributes using the 
resource file CATVPMDlgCfgList (default = action name + action description)  

z To add a rapid selection field in the dictionary graph (by keying in the options): 
CATCDMA.VPM.OPT_GRAPH.RAPID_SELECT_MNGT = ’STANDARD’ or ’SMART’ (STRING)  
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where ’STANDARD’ allows you to select, in the graph,  the key-in options in the graph (a simple option or an expression such as 
option1 & option2 & ... ) and ’SMART’ enables the highlight in the graph during key-in options with the possibility to select by keying 
in only the beginning of the option name.  

z The existing date, range and milestones (if any) are propagated when you add a new row in the info-link panel.  
z To manage the Define effectivity function on models, documents and features: 

CATCDMA.VPM.EXPAND.CONFIGURABLE_REPS = TRUE (LOGICAL) 
CATCDMA.VPM.EXPAND.CONFIGURABLE_FEATURES = TRUE (LOGICAL)  

z To add Copy effectivity and Paste effectivity to the Configuration contextual menu to copy the existing effectivity defined on a link to 
another one: 

CATCDMA.VPM.COPY_PASTE_EFF = TRUE (LOGICAL)  

WARNING!  

z Paste effectivities becomes Extend available modifications from clipboard  
z Delete pasted effectivities becomes Remove extended modifications.  

Instances 

z To update impacted instances after replacing with a version of the same Part on the intermediate level: 
CATCDMA.VPM.INSTANCE.UPDATE_MOVE_REPLACE = TRUE (LOGICAL)  

z To copy the defined instances after the versioning of a root Part: 
CATCDMA.VPM.INSTANCE.UPDATE_NEW_VERSION = TRUE (LOGICAL)  

z There is an enhancement on open instances in the PSN.  

  

Disconnect Mechanism at VPM Transaction Closure 

There is a new mechanism which closes the database connection at the end of each VPM transaction. To implement this add the 
following CATIA declaration parameter:  

CATCDM.END_TRANSACTION_RELEASE_CONNECT : LOGICAL ;  
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The default value is FALSE (i.e. the same behavior as for the previous version). The setting TRUE closes the DB connection at the end of 
each transaction. A reconnect is done automatically at the first call which starts a database transaction.  

  

Launching VPMInstall.sh 

Before launching VPMInstall.sh, once the administrator has been updated, modify the script $CAT_CUST/code/bin/VPMInstall_chech.sh 
by replacing:  

if [ -f "$HOME/JD061DB2 ] ; then 
(line 1990)  

with:  

if [ -f "$HOME"/JD061DB2 ] ; then  

 

Optimizing VPM with UDB Version 7.2 Fixpack 7 

To change the UDB server settings:  

db2set DB2_INLIST_TO_NLJN=YES  

There are two declaration parameters to set the UDB/DB2 query optimization level:  

z for product structure queries: 
CATCDMA.VPM.EXPAND.DB2_QUERY_OPTIMIZATION_LEVEL : INTEGER ;  

z for configuration queries: 
CATCDMA.VPM.CFGDB.DB2_QUERY_OPTIMIZATION_LEVEL INTEGER ;  

Recommended Values  
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z CATCDMA.VPM.EXPAND.DB2_QUERY_OPTIMIZATION_LEVEL = 5 ;  
z CATCDMA.VPM.CFGDB.DB2_QUERY_OPTIMIZATION_LEVEL = 7 ;  

For Other Queries 

The query optimization level is done with the following declaration parameter:  

CATCDMA.VPM.DEFAULT.DB2_QUERY_OPTIMIZATION_LEVEL : INTEGER ;  

Remember other expand optimization possibilities.  

There are two declaration parameters to check required memory on the database server (for example APP_CTL_HEAP_SZ for the UDB 
server):  

z for product structure queries: 
CATCDMA.VPM.EXPAND.INQMARK : INTEGER ;  

z for configuration queries: 
CATCDMA.VPM.CFGDB.MAX_ARG : INTEGER ;  

These declaration parameters check the number of values in queries such as WHERE $COID IN ( ?,?, ...). You can change these default 
values, but exercise great caution if you decide to do so. 
If you use a larger number, you minimize the number of queries on the server but you need more memory on the server. 
If you use a number lower than 75, you need less memory on the server but you increase the number of queries.  

The default values are:  

z CATCDMA.VPM.EXPAND.INQMARK = 250 ;  
z CATCDMA.VPM.CFGDB.MAX_ARG = 200 ;  

 

New Multisite XML Tag in the Command File 
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There is a new optional "specials" tag. It is used at export to convert special characters.  

 

Recommended Interoperability PTFs 

CATIA 424-1  

The following PTFs are mandatory:  

specials information item

specialstext  ::=  '' | * | collist | '--'  (collist) 
collist ::= colname , ( collist )* | colname 
colname ::= string

char and varchar columns which can contain characters to be converted: & , < and >

Remarks: 
Used only for columns which can contain such characters 

Example: 
<specials>C_NICKNAME </specials> 

nº APAR Description
HC66598 Tools->Open Editor: If the editor window size is increased no text can be written.

HC84902 The File=>Save command in CATIA updates frozen Parts.

HC86590 The Identify Loaded Models results are partial in the PSN.

HC86219 There is no way to redirect the /tmp.

HC88222 There is a problem with a New Version function in DB2.

HC89784 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation 
fault. DBLDRW entry issued.

HC91642 A twin model cannot be opened in CATIA V4 after a new version.
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The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

nº APAR Function Description
HC87969 4DNAV The 4DNav tesselation batch failed with a VPM database.

HC95918 4DNAV Models do not move properly.

HC98650 4DNAV The MfgProg function does not work for models opened from VPM.

HC83996 AUXVIEW2 Error 744 when reading a dr model from the PSN graph.

HC89307 CATMFG There is a core dump when loading the model with an MML on the manufacturing 
type.

HD00127 CDM CDM interoperability: UB98558 breaks DATABASE + WRITE + EXT_OBJ

HC85180 CSB Some volumes in the tree are wrongly propagated.

HC85372 CSB There is a problem with the catcsbad.

HC87890 CSB + 
SAVE No trace file is generated in the QP035AMP output + DMUSLF problem

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models.

HC91296 CSB Box zoning does not work Project-comprehensive

HC92272 CSB The QP035AMP process is triggered when saving a model on HP.

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM.

HC85860 DATABASE The cgr stored in datalinks is not updated after the V4 model is modified.

HC92618 E3D E3D CDMA Parts cannot be accessed if the VPM (or CDM) environment exceeds 
five characters.

HC86785 FD&T Chamfer FD&T dimensioning is split into two when in the VPM assembly context.

HC87755 FD&T There is a performance problem loading the FD&T function on an assembly 
coming from VPM.

HC89158 FD&T When you version a Part, the tolerances are not updated.

HC83200 MML MML type model to model => entity to entity migration: Action required.

HC82887 OPEN There is a warning when opening a model.
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CATIA 424-2  

The following PTFs are mandatory:  

HC90047 OPEN An abend occurs when opening a V5 model in V4.

HC84033 SAVE It is impossible to manage document revision using DMUSLF.

HC85938 SAVE A model cannot be stored using DBLFCAT.

HC85967 SAVE A model cannot be stored using DBLFCAT.

HC87012 SAVE When executing the File=>Save command, VPM cannot be found to save a 
model. 
An error occurred in the Japanese environment.

HC87890 CSB + 
SAVE No trace file is generated in the QP035AMP output + DMUSLF problem

HC90206 SAVE A DMUSLF user exit does not reference the type of model created.

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.

HC91658 SAVE Backup management for saved versions of CATIA models.

HC91750 SAVE Save All with VPM and CATIA model

HC98768 SAVE VPM interoperability: File/Save cannot be performed on a model after an abend 
then a warm start in CATIA.

HC82073 SKIN Some errors are detected by the cleaner if the GSM model is loaded from VPMA 
and CATIA results in an abend at save.

HC81497 SOLIDE The MML_SOL link is desynchronized after a save.

HC89303 SOLIDE There is a core dump with a union on two empty spacemaps.

nº APAR Description
HC89784 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation 

fault. DBLDRW entry issued. 

HC91639 Standard DS traces cause problems. The delivery for UB97943, UB97941, UB97942, 
UB97944 is incomplete.
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The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

 

nº APAR Function Description
HC92705 4DNAV After closing a 4DNav session started from VPM, it cannot be restarted. 

HC95918 4DNAV Models do not move correctly. 

HC89307 CATMFG There is a core dump when loading the model with a MML on the manufacturing 
type. 

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models. 

HC89303 CSB There is a core dump with a union on two empty spacemaps. 

HC91296 CSB Box zoning does not work Project-comprehensive 

HC92046 CSB VPM/CATIA lock in the spacemap. 

HC92272 CSB The QP035AMP process is triggered when saving a model on HP. 

HC93336 CSB VPM/CATIA lock in the spacemap (part 2). 

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM. 

HC97304 CSB The spacemap filter does not work properly with a model. 

HC98203 CSB Modification on CSB volume algorithm 

HC90454 MML Change UUID also keeps the link to the original version of the model. 

HC90047 OPEN An abend occurs when opening a V5 model in V4. 

HC95245 OPEN V5->V4 interoperability: V4 delivery for compatibility with V5 command Send To  

HC90206 SAVE A DMUSLF user exit does not reference the type of model created. 

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM. 

HC91658 SAVE Backup management for saved versions of CATIA models. 

HC91750 SAVE Save All with VPM and CATIA model 

HC98768 SAVE VPM interoperability: File->Save cannot be performed on a model after an abend 
then a warm start in CATIA.
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Cumulative Fixes PTF12 

 

Free Text PTF12 

OS UH OS UH OS UH OS UH
IX UH01628 HP UH01629 SG UH01630 SU UH01627

IX UH01631 HP UH01632 SG UH01633 SU UH01634

IX UH01637 HP UH01636 SG UH01639 SU UH01635

IX UH01645 HP UH01640 SG UH01641 SU UH01638

IX UH01647 HP UH01642 SG UH01648 SU UH01643

IX UH01650 HP UH01644 SG UH01649 SU UH01646

ADMBASE z HC99320: When using the option Update Representations we get the message 
ACC RUNTIME: ERROR 215 FROM SHL_FINDSYM.  

z HC99317: Acc runtime error when using VPMStart.sh kill_XCAD we get the 
message ACC RUNTIME: ERROR 215 FROM SHL_FINDSYM.  

AFL z HC99816: After an Action transfer, the organization is not immediately updated.  

BOM z HC98469: The Compare graph function does not work properly.  
z HC99192: Saving the PSN and effectivities is not possible.  
z HD00617: The reading of the dynamic PSN is not compliant.  
z HC99655: The option PSN_NO_SORT does not work.  
z HC99913: Authorized Cut does not show a pop-up.  
z HC99605: The declaration parameter 
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PTF13 Update 

catcdma.VPM.REVISION.KEEP_RESPONSIBLE is not documented.  
z HC98434: There is an ergonomic problem with the Rename function.  
z HD00056: An abend occurs during a cut/copy/paste in the PSN.  
z HC99934: Replace Where Used causes a catcdma.VPMA.SEL_WU error.  
z HC99643: There is a wrong date value after Edit Instance in the PSN.  
z HC98949: C_COMMENT is lost after translating a model in CATIA.  
z HD00408: The print result in HTML fails to open Netscape.  
z HC92709: The options of catcdm.DBLFLAIX_ALGO are not described.  
z HC90512: VPM hangs on startup.  
z HD00814: There is a problem when saving a .psn created from a PSN expand with 

a configuration where the date is set to infinity.  
z HD00545: When we filter a PSN by volume, save it in a .psn and recall it 

dynamically, we get too many Parts.  
z HD00034: The VPM filter cannot be used in batch mode.  

ITVPMCV4 z HC98757: A problem occurs when creating a new version having a CATIA V5 
document and its associated model.  

z HC98616: The associativity between the model and the CATPart is lost when the 
XCAD server crashes.  

ITVPMCV5 z HC98574: VPM interoperability: Versioning a with contextual link and a constraint 
link does not work properly  

z HD00321: VPM interoperability: The comment in the XML message for error 20612 
is wrong.  

z HD00070: VPM interoperability: The short and long messages are not displayed in 
the incident report panel of CATIA V5.  

MML z HC97629: VPM interoperability: MML stays linked to the old version after a new 
version has been created.  

P&O z HC98186: Tools-> Execute CATIA V5 is available even if the user does not have 
the privilege to launch CATIA V5.  

z HC98196: Print BOM PSN: There is a problem with the null value for numeric 
attributes.  
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REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample. 

 

WARNING! 
for ENOVIAVPM 1.5 (PTF11 / PTF12 / PTF13) / CATIA V5R10 (GA / SP1 / SP2 / SP3) users only 

Problem Description 
When opening a V5 Part or doing a Create&Save on a V5 document from VPM, the current user and password are visible in the console 
as part of a xml file. This happens when using server authentification. When using system authentification, the user is also visible and the 
password space is reserved in quotation marks. 

Corrective Action 
A patch is already available for PTF11, PTF12 and PTF13 with the appropriate installation procedure. 
Contact L1 for further instructions. 

 

WARNING! 
In order to install VPM 1.5 PTF13 on ALL platforms: 
After launching catinst but before launching VPMInstall.sh (-oracle / -db2),  
go into the VPM Administrator files (and the VPM user files) $HOME/.profile (dot profile) 
and $HOME/.dtprofile (dot dtprofile) and replace all occurrences of /home/catadm with the value $HOME. 
Log off then log on again and launch VPMInstall.sh (-oracle / -db2). 

 

WARNING! 
Do not, under any circumstances, put any customized library fixes or development modules into your VPM STEPLIB directory (usually 
$CAT_CUST/code/steplib/$OS) unless expressly requested to do so in the official documentation or by the VPM maintenance or 
development team. This is because the directory is shared with CATIA V4 and interaction between VPM and CATIA V4 may therefore be 
unpredictable. 
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Clash Management 

As of PTF13, to:  

z delete a clash, you must declare the CLASH table in the variable GLOBAL_$LIST_DELETE in the profile  
z modify a clash, you must declare the CLASH table in the variable GLOBAL_$LIST_UPDATE in the profile.  

  

Publish/Subscribe 

Feature Support 

Features are now supported by the Publish/Subscribe mechanism. The following events are available:  

z check-in  
z check-out  
z promote  
z demote  
z write  
z rename.  

Features are also made available in Publish/Subscribe cluster management, so it is possible to create implicit subscriptions for features.  

Note that the events must be inserted in the database before the support is complete. This is done by means of the DLL scripts 
update8_PUSSUB.clp and update8_PUSSUB.sql, which can be executed by the post-install shell VPMPostInstall.sh.  

 
Interoperability 

Communication Time-Out 
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The time-out used by VPM when starting other applications through the inter-process communication layer (XCO) such as CATIA, can be 
overridden by setting the declaration parameter catcdma.VPM.XCO.TIMEOUT to the desired value (in seconds).  

Note that setting it to a low value can make VPM (which expects an answer from the application) react faster if a problem occurs while 
starting the application (such as a licensing problem). However, if the application takes longer to start than that value, it can lead VPM to 
assume that the execution was unsuccessful and therefore return an error.  

  

Security 

New Security Process 

The VPM.BOM.ExportBOMToSpecXml process is now available for the Administrator license. It is used to control access to the BOM to 
SpecXML export mechanism, for use between VPM (the NT server) and SmarTeam. 

  

Multisite 

Replication Tools 

The VX0REPLS replication server now supports the option -noabort which, when activated, results in it ignoring possible replication errors 
and proceeding with subsequent requests, if any.  

 

Public APIs 

z CATDMUsrInstance  
The Duplicate method is now available in the BOM API CATDMUsrInstance in order to duplicate a Part object. The two modes 
available in VPM (full duplication of the Part, its assembly links and representations, or duplication of the Part and its assembly links 
only) are supported. For details, see the API documentation.  
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z CATVpmUsrReplication  
The Queue method of the replication API CATVpmUsrReplication now supports object transfer, e.g. replication with transfer of the 
site ownership to the destination site. For details, see the API header.  

 

Configuration 

Configuration Database Migration from 1.5PTFx to 1.5PTF13 

DATABASE MIGRATION TO PTF 13 IS MANDATORY!!! 
There is a new script available to migrate the configuration database to 1.5 PTF13: update6_CONFIG. 
If the script update7_CONFIG has already been executed in the database, it must be re-executed after update6_CONFIG to regenerate 
the table views. 

PSN Commit Performance 

Increase commit performances in PSN when committing modifications under a configured Part.  

Miscellaneous 

z The CFG.CleanAssembly process must now be associated with a data group.  
z Add security checks in some configuration APIs: SetConfigurable, UnsetConfigurable, CreateDictionary, DeleteDictionary, 

RemoveCategoryFromDictionary, AddOptionToDictionary, RemoveOptionFromDictionary  
z Add some configuration APIs: Create/Delete Milestones/Program and GetPlannedEffForAction  

 

Updating the C_COUNT Default Value 

Due to an Oracle regression it is necessary to update the default value of C_COUNT after its creation:  

If you have run the script update1_EXT, just use the following command: 
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alter table VPMENV."PART_LIST" modify C_COUNT default ’N:N:U:UUUUUUUU:UUUUUUUU’;  

If you have not yet run update1_EXT, replace: 

alter table VPMENV."PART_LIST" add C_COUNT varchar(30) default ’N:N:U:UUUUUUUU:UUUUUUUU’; 

with: 

alter table VPMENV."PART_LIST" add C_COUNT varchar(30) default ’N:N:U:UUUUUUUU:UUUUUUUU’; 
alter table VPMENV."PART_LIST" modify C_COUNT default ’N:N:U:UUUUUUUU:UUUUUUUU’; 

 

BOMFILE 

The list of attributes is defined by the profile variable GLOBAL_$BOM_NAVIG. If the variable is not defined for the object, the following 
attributes are listed:  

z all attributes beginning with S_  

z C_REVISION  

z C_PART_VERSION  

z C_NAME (as of PTF11)  

z C_MATURITY  

z EXPORT_ID  

 

Recommended Interoperability PTFs 
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CATIA 424-1  

The following PTFs are mandatory:  

The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

nº APAR 
for AIX

Description

HC66598 Tools->Open Editor: If the editor window size is increased no text can be written.

HC84902 The File=>Save command in CATIA updates frozen Parts.

HC86590 The Identify Loaded Models results are partial in the PSN.

HC86219 There is no way to redirect the /tmp.

HC88222 There is a problem with a New Version function in DB2.

HC89786 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation 
fault. DBLDRW entry issued.

HC91642 A twin model cannot be opened in CATIA V4 after a new version.

HC99292 Synchronization of VPM and CATIA for the declaration parameter catcdm.DBLFAIX_ALGO

HC98768 VPM interoperability: File->Save cannot be performed on a model after an abend then a warm 
start in CATIA.

HC99343 Synchronization of CATIA and VPM for the declaration parameter 
catcdma.STORAGE.LF_METADATA: Parameter deleted

HD01297 VPM interoperability: A File->Save cannot be performed on a model with the DBLFCAT 
access method.

nº APAR 
for AIX

Function Description

HC87971 4DNAV The 4DNav tesselation batch failed with a VPM database.
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HC95918 4DNAV Models do not move properly.

HC98650 4DNAV The MfgProg function does not work for models opened from VPM.

HD01228 4DNAV A VRML document cannot be opened with 4DNav from the PSN.

HC83996 AUXVIEW2 Error 744 when reading a dr model from the PSN graph.

HC89308 CATMFG There is a core dump when loading the model with an MML on the manufacturing 
type.

HD00127 CDM CDM interoperability: UB98558 breaks DATABASE + WRITE + EXT_OBJ

HC85180 CSB Some volumes in the tree are wrongly propagated.

HC85372 CSB There is a problem with the catcsbad.

HC87890 CSB + 
SAVE No trace file is generated in the QP035AMP output + DMUSLF problem

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models.

HC91298 CSB Box zoning does not work Project-comprehensive

HC92275 CSB The QP035AMP process is triggered when saving a model on HP.

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM.

HC85860 DATABASE The cgr stored in datalinks is not updated after the V4 model is modified.

HC92618 E3D E3D CDMA Parts cannot be accessed if the VPM (or CDM) environment exceeds 
five characters.

HC86788 FD&T Chamfer FD&T dimensioning is split into two when in the VPM assembly context.

HC87759 FD&T There is a performance problem loading the FD&T function on an assembly 
coming from VPM.

HC89159 FD&T When you version a Part, the tolerances are not updated.

HC83200 MML MML type model to model => entity to entity migration: Action required.

HC82890 OPEN There is a warning when opening a model.

HC90047 OPEN An abend occurs when opening a V5 model in V4.

HC84035 SAVE It is impossible to manage document revision using DMUSLF.

HC85938 SAVE A model cannot be stored using DBLFCAT.

HC85967 SAVE A model cannot be stored using DBLFCAT.
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CATIA 424-2  

The following PTFs are mandatory:  

HC87012 SAVE When executing the File->Save command, VPM cannot be found to save a 
model. 
An error occurred in the Japanese environment.

HC87890 CSB + 
SAVE No trace file is generated in the QP035AMP output + DMUSLF problem

HC90206 SAVE A DMUSLF user exit does not reference the type of model created.

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.

HC91658 SAVE Backup management for saved versions of CATIA models.

HC91751 SAVE Save All with VPM and CATIA model

HD02268 SAVE VPM interoperability: There is an SQLERROR -407 when a model is saved using 
VPM after an update version.

HC82087 SKIN Some errors are detected by the cleaner if the GSM model is loaded from VPMA 
and CATIA results in an abend at save.

HC81501 SOLIDE The MML_SOL link is desynchronized after a save.

HC89303 SOLIDE There is a core dump with a union on two empty spacemaps.

nº APAR 
for AIX

Description

HC89786 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 segmentation 
fault. DBLDRW entry issued. 

HC91641 Standard DS traces cause problems. The delivery for UB97943, UB97941, UB97942, 
UB97944 is incomplete.

HC99292 Synchronization of VPM and CATIA for the declaration parameter catcdm.DBLFAIX_ALGO

HC98768 VPM interoperability: File->Save cannot be performed on a model after an abend then a warm 
start in CATIA.
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The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

HC99343 Synchronization of CATIA and VPM for the declaration parameter 
catcdma.STORAGE.LF_METADATA: Parameter deleted

HD01297 VPM interoperability: A File->Save cannot be performed on a model with the DBLFCAT 
access method.

nº APAR 
for AIX

Function Description

HC92706 4DNAV After closing a 4DNav session started from VPM, it cannot be restarted. 

HC95918 4DNAV Models do not move correctly. 

HC89308 CATMFG There is a core dump when loading the model with a MML on the manufacturing 
type. 

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models. 

HC89303 CSB There is a core dump with a union on two empty spacemaps. 

HC91298 CSB Box zoning does not work Project-comprehensive 

HC92046 CSB VPM/CATIA lock in the spacemap. 

HC92275 CSB The QP035AMP process is triggered when saving a model on HP. 

HC93336 CSB VPM/CATIA lock in the spacemap (part 2). 

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM. 

HC97314 CSB The spacemap filter does not work properly with a model. 

HC98203 CSB Modification on CSB volume algorithm 

HC90454 MML Change UUID also keeps the link to the original version of the model. 

HC90047 OPEN An abend occurs when opening a V5 model in V4. 

HC95245 OPEN V5->V4 interoperability: V4 delivery for compatibility with V5 command Send To  

HC90206 SAVE A DMUSLF user exit does not reference the type of model created. 

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM. 
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Cumulative Fixes PTF13 

 

Free Text PTF13 

HC91658 SAVE Backup management for saved versions of CATIA models. 

HC91751 SAVE Save All with VPM and CATIA model 

HD02268 SAVE VPM interoperability: There is an SQLERROR -407 when a model is saved using 
VPM after an update version.

OS UH OS UH OS UH OS UH
IX UH02383 HP UH02396 SG UH02389 SU UH02370 

IX UH02388 HP UH02401 SG UH02382 SU UH02384 

IX UH02386 HP UH02405 SG UH02376 SU UH02385 

IX UH02381 HP UH02400 SG UH02371 SU UH02367 

IX UH02391 HP UH02398 SG UH02374 SU UH02368 

IX UH02394 HP UH02399 SG UH02372 SU UH02373 

IX UH02377 HP UH02403 SG UH02378 SU UH02380 

IX UH02395 HP UH02402 SG UH02379 SU UH02392 

IX UH02390 HP UH02397 SG UH02393 SU UH02366 

IX UH02375 HP UH02404 SG UH02387 SU UH02369 

Admin z HD00176: The name link between two Parts after a STEP export by batch does not 
appear correctly.  

z HD01030: The description of the AfterCommitUserAction method is wrong.  
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z HD01137: There is a YACC stack overflow in VPMENV_PART_LIST when 
VPMExchangesInst.sh is run.  

AFL z HD00276: There is an Action creation problem.  
z HD01083: Updating the Action object causes a VPM crash.  

BOM z HC90799: The rename after More Information does not work correctly.  
z HC97480: A S0011 abend occurs when a large assembly is pasted into the PSN 

with expand manual set.  
z HC99843: Deleting the DOCCAD table with two PSN windows open causes a VPM 

abend.  
z HD00495: The links are broken on the positioning matrix after using the Replace 

where used option.  
z HD00751: Tools/New version with a different part number results in an incorrect 

PSN tree.  
z HD01148: Tools/New revision has not been available since the migration 140 to 

150 PTF9.  
z HD01245: There is no security for VPM clash management.  
z HD01879: The components highlighted in the structure display are incomplete after 

performing VPM PSN Identify Changes.  
z HD02216: The positioning is lost after changing C_COMMENT.  
z HD02342: There is a VPM abend when defining option and categories from the 

PSN for a new version.  
z HD02415: VPM interoperability: The CATIA V5 window is launched as not visible if 

the VPMA window is minimized.  
z HD02433: The API CATDMUsrInstance::CreateNewRevision(...) for a Part object 

does not create the associated representations.  
z HD02451: Compare graph with base: There is a problem with the added links.  

CFG z HD00454: The new options cannot be seen unless a restart is performed.  
z HD02333: The Include Query function does not work in a filter by identification.  

Install z HD00185: RECAPP_ORACLE: Test: Argument expected. Affected script: 
VPMInstall_Check.sh  

Interop z HD01359: There is a VPM timeout when starting CATIA.  

ITVPMCV5 z HD00573: VPM interoperability: All applicative data (3D annotation, group, camera, 

Page 211 of 238Program Directory VPM1.5 - PTF16

30.09.2003file://U:\Vpm15-Doku\VPM15PTF16.html



PTF14 Update 
REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample.  

 

WARNING! 
Do not, under any circumstances, put any customized library fixes or development modules into your VPM STEPLIB directory (usually 
$CAT_CUST/code/steplib/$OS) unless expressly requested to do so in the official documentation or by the VPM maintenance or 
development team. This is because the directory is shared with CATIA V4 and interaction between VPM and CATIA V4 may therefore be 

fitting) which was generated in DMU cannot be saved in VPM.  
z HD01114: VPM interoperability: The Attach graph icon display is wrong if a PSN is 

opened from CATIA V5.  

MML z HC97629: VPM interoperability: MML stays linked to the old version after the 
creation of a new version.  

z HD02949: VPM crashes when the MML graph is opened.  

Multisite z HD00967: A global XML replication cannot be performed.  
z HD01017: The BOM is inconsistent (different) after an XML export-import.  

P&O z HD00851: VPM_SECURITY_MODE = STANDARD prevents the P&O from using the 
cluster-type data group.  

z HD00962: PSN: A dynamic open for a .PSN file does not work if the configuration 
filter contains the Add proposed effectivity option.  

z HD01250: When importing data with a VPMPeopleImport tool, the privilege 
specifying the cluster data group cannot be imported.  

PSN z HD00952: BOM: It is impossible to open a .psn from a read-only directory.  
z HD01325: VPM crashes when the Compare with base function is used with the 

leaves option.  
z HD01991: The time it takes to open a PSN in dynamic mode / selected instances 

has greatly increased since PTF9.  
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unpredictable. 

 

Action 

Action display in VPMAccess is controlled by means of the profile. The list of the attributes displayed is already set with the 
GLOBAL_$RESULT_ACTION variable. From now on, attribute display is set with the GLOBAL_$FORMAT variable. For example, for the 
secondary_id attribute: 

ASSIGN ’SYNONYM("Id"), MAX(32)’ 
TO "GLOBAL_$FORMAT_ACTION.secondary_id";;  

 

Multisite 

Customers using ENOVIAVPM distributed multisite capabilities are strongly recommended to use only the XML-based exchange 
mechanisms. 

 

Security Process 

 

Recommended Interoperability PTFs 

Application Function Command NT Client

VPM BOM MoveInstance x
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CATIA 424-1  

The following PTFs are mandatory:  

The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

APAR (AIX) Description
HC66598 Tools->Open Editor: If the editor window size is increased no text can be written.

HC84902 The File=>Save command in CATIA updates frozen Parts.

HC86590 The Identify Loaded Models results are partial in the PSN.

HC86219 There is no way to redirect the /tmp.

HC88222 There is a problem with a New Version function in DB2.

HC89786 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 
segmentation fault. DBLDRW entry issued.

HC91642 A twin model cannot be opened in CATIA V4 after a new version.

HC99292 Synchronization of VPM and CATIA for the declaration parameter 
catcdm.DBLFAIX_ALGO

HC98768 VPM interoperability: File->Save cannot be performed on a model after an abend then a 
warm start in CATIA.

HC99343 Synchronization of CATIA and VPM for the declaration parameter 
catcdma.STORAGE.LF_METADATA: Parameter deleted

HD01297 VPM interoperability: A File->Save cannot be performed on a model with the DBLFCAT 
access method.

APAR (AIX) Function Description
HC87971 4DNAV The 4DNav tesselation batch failed with a VPM database.

HC95918 4DNAV Models do not move properly.

HC98650 4DNAV The MfgProg function does not work for models opened from VPM.
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HD01228 4DNAV A VRML document cannot be opened with 4DNav from the PSN.

HC83996 AUXVIEW2 Error 744 when reading a dr model from the PSN graph.

HC89308 CATMFG There is a core dump when loading the model with an MML on the 
manufacturing type.

HD00127 CDM CDM interoperability: UB98558 breaks DATABASE + WRITE + EXT_OBJ

HC85180 CSB Some volumes in the tree are wrongly propagated.

HC85372 CSB There is a problem with the catcsbad.

HC87890 CSB + 
SAVE

No trace file is generated in the QP035AMP output + DMUSLF problem

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models.

HC91298 CSB Box zoning does not work Project-comprehensive

HC92275 CSB The QP035AMP process is triggered when saving a model on HP.

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM.

HC85860 DATABASE The cgr stored in datalinks is not updated after the V4 model is modified.

HC92618 E3D E3D CDMA Parts cannot be accessed if the VPM (or CDM) environment 
exceeds five characters.

HC86788 FD&T Chamfer FD&T dimensioning is split into two when in the VPM assembly 
context.

HC87759 FD&T There is a performance problem loading the FD&T function on an assembly 
coming from VPM.

HC89159 FD&T When you version a Part, the tolerances are not updated.

HC83200 MML MML type model to model => entity to entity migration: Action required.

HC82890 OPEN There is a warning when opening a model.

HC90047 OPEN An abend occurs when opening a V5 model in V4.

HC84035 SAVE It is impossible to manage document revision using DMUSLF.

HC85938 SAVE A model cannot be stored using DBLFCAT.

HC85967 SAVE A model cannot be stored using DBLFCAT.

HC87012 SAVE When executing the File->Save command, VPM cannot be found to save a 
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CATIA 424-2  

The following PTFs are mandatory:  

model. 
An error occurred in the Japanese environment.

HC87890 CSB + 
SAVE

No trace file is generated in the QP035AMP output + DMUSLF problem

HC90206 SAVE A DMUSLF user exit does not reference the type of model created.

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.

HC91658 SAVE Backup management for saved versions of CATIA models.

HC91751 SAVE Save All with VPM and CATIA model

HD02268 SAVE VPM interoperability: There is an SQLERROR -407 when a model is saved 
using VPM after an update version.

HC82087 SKIN Some errors are detected by the cleaner if the GSM model is loaded from 
VPMA and CATIA results in an abend at save.

HC81501 SOLIDE The MML_SOL link is desynchronized after a save.

HC89303 SOLIDE There is a core dump with a union on two empty spacemaps.

APAR (AIX) Description
HC89786 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 

segmentation fault. DBLDRW entry issued. 

HC91641 Standard DS traces cause problems. The delivery for UB97943, UB97941, UB97942, 
UB97944 is incomplete.

HC99292 Synchronization of VPM and CATIA for the declaration parameter 
catcdm.DBLFAIX_ALGO

HC98768 VPM interoperability: File->Save cannot be performed on a model after an abend then a 
warm start in CATIA.

HC99343 Synchronization of CATIA and VPM for the declaration parameter 
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The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFS associated with commonly used functions such as SOLIDE:  

catcdma.STORAGE.LF_METADATA: Parameter deleted

HD01297 VPM interoperability: A File->Save cannot be performed on a model with the DBLFCAT 
access method.

APAR (AIX) Function Description
HC92706 4DNAV After closing a 4DNav session started from VPM, it cannot be restarted. 

HC95918 4DNAV Models do not move correctly. 

HC89308 CATMFG There is a core dump when loading the model with a MML on the manufacturing 
type. 

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models. 

HC89303 CSB There is a core dump with a union on two empty spacemaps. 

HC91298 CSB Box zoning does not work Project-comprehensive 

HC92046 CSB VPM/CATIA lock in the spacemap. 

HC92275 CSB The QP035AMP process is triggered when saving a model on HP. 

HC93336 CSB VPM/CATIA lock in the spacemap (part 2). 

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM. 

HC97314 CSB The spacemap filter does not work properly with a model. 

HC98203 CSB Modification on CSB volume algorithm 

HC90454 MML Change UUID also keeps the link to the original version of the model. 

HC90047 OPEN An abend occurs when opening a V5 model in V4. 

HC95245 OPEN V5->V4 interoperability: V4 delivery for compatibility with V5 command Send To  

HC90206 SAVE A DMUSLF user exit does not reference the type of model created. 

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM. 

HC91658 SAVE Backup management for saved versions of CATIA models. 

HC91751 SAVE Save All with VPM and CATIA model 
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Cumulative Fixes PTF14 

 

Free Text PTF14 

HD02268 SAVE VPM interoperability: There is an SQLERROR -407 when a model is saved 
using VPM after an update version.

HD03461 OPEN VPM interoperability: Problem loading V4 model save with DBLFAIX

OS UH OS UH OS UH OS UH

IX

UH02800 
UH02797 
UH02791 
UH02788 
UH02804 
UH02790 
UH02810 
UH02813

HP

UH02812  
UH02784 
UH02795 
UH02787 
UH02803 
UH02806 
UH02789 
UH02802

SG

UH02785 
UH02805 
UH02796 
UH02798 
UH02792 
UH02793 
UH02786 
UH02808

SU

UH02783 
UH02801 
UH02782 
UH02809 
UH02811 
UH02799 
UH02794 
UH02807

ADMBASE z HD03884: Missing VPM_ENTITY and VPM_LINK cause an error in VPM.  

Admin z HD03278: API: Check out does not return the proper context.  
z HD02188: The behavior of STEP import for a frozen link for the modified VPM 

structure is inconsistent.  
z HD03867: There is a VPM crash if CATIA_MODEL is eliminated from the 

declaration file.  
z HD03067: The wrong values are returned by the API call 

GetOptFromDictionary.  
z HD03030: CATDMUsrMethodContext::GetEnvironment: GetEnvironment 
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returns an empty string.  
z HD03173: Error.IER=1 for CATDMUsrMethod::AuthorizedMove is not usable.  
z HD04307: SaveGraphSession cannot use the /tmp for SaveGraphSession. 

Declaration parameter catcdma.PSN.GRAPHSESSION documented.  
z HC98788: There is a rollback problem.  

AFL z HD03830: It is possible to define the top range lower than the bottom range for 
a proposed effectivity.  

BOM z HD03056: CATHIS is kept following the deletion of a NewRevision that was 
renamed.  

z HD03285: An abend S0006 occurs when overwriting a model at STEP export.  
z HD02927: The user exit dictionary control is only called once during an 

ownership change.  
z HD03512: There is an invalid setting when using CATIA V4 and VPM 1.5.  
z HD01753: Subscribe replication does not work if a subscription type is 

Organization.  
z HD03163: There is a problem with the contextual menu customized in the PSN.  
z HD04200: Behavior is wrong when a STEP import of a modified link is 

performed.  
z HC95459: The right-hand scrollbar is in the wrong position.  
z HD04049: When selecting a configuration handler with too many options an 

error message appears.  

CFG z HD03399: The configuration is wrong after a link is removed.  

ITVPMCV5 z HD04240: VPM/ DMU interoperability: There is an error 16258 when trying to 
version with a different Part number a Part which contains an applicative 
container.  

z HD04203: VPM interoperability: There is a VPM crash at a Create & Save on a 
V5 Part with DBLFAIX.UNIX PATH if the directory does not exist.  

z HD04500: 3d com enables the association of models with released Parts.  
z HD04879: VPM interoperability: Links in the PSN remain pink although the 

immediate commit has failed.  

P&O z HD02830: The process group does not display the added process.  

PSN z HD02822: There is an abend S0004 for a context copy in PSN when a .psn file 
is opened with a selected/highlighted Part.  
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PTF15 Update 
REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample.  

 

WARNING! 
Do not, under any circumstances, put any customized library fixes or development modules into your VPM STEPLIB directory (usually 
$CAT_CUST/code/steplib/$OS) unless expressly requested to do so in the official documentation or by the VPM maintenance or 
development team. This is because the directory is shared with CATIA V4 and interaction between VPM and CATIA V4 may therefore be 
unpredictable. 

 

WARNING! Missing Headers! 

A problem has been found (i.e. errors are displayed) when compiling user exits. 

Explanation 

Before the construction of the new VPM API documentation (delivered on PTF15), many ".h" files (header files) which were not usable by 
customers were removed. 
During this operation, some mistakes were made i.e. headers were removed because they were unusable but were still referenced in the 
other remaining headers. 

z HD04294: VPM role restriction is not respected by 3d com (DB view).  

System z HC89803: V5 performance is poor in the simplified Chinese code page ZH_CN . 

VPMA z HD03308: The .txt generated with the Print function from VPM Access is 
unusable.  
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Symptoms 

When compiling user exits, errors occur due to the missing headers.  
 

How to Fix the Problem 

To fix the problem, on top of the PTF15, ask IBM for the correcting tar file, and install it as follows: 

cd $VPM/PublicInterfaces 
tar -xvf missingHeaders.tar 

 

Installation 

1. A problem has been identified when performing a from-scratch installation of VPM 1.5 PTF15 on SGI systems only and using an 
Oracle database only.  
The installation process exits VPMDataManager prematurely, and it is not possible to execute VPM subsequently. 
To bypass the problem, proceed as follows: 

{ Log in as VPM administrator and run VPMInstall.sh -oracle  
{ Exit VPMInstall.sh  
{ Modify your lkora shell script (in $CAT_CUST/code/bin) with the following: 

PTOS="$SAMPLE/dblsas.o $SAMPLE/dbcsta.o $SAMPLE/orxsta.o" 
PTOS=$PTOS" $SAMPLE/orindb.o $SAMPLE/DBXSTR6.o $SAMPLE/DBXEXP6.o " 
PTOS=$PTOS" $CDMLIB/DBCOPR.o " 
PTOS=$PTOS" $CDMLIB/DBCSIN.o " 
PTOS=$PTOS" $CDMLIB/DBOALD.o " 
load=$dir_val/JD061SGB 
dbgeco  -c -s $SAMPLE/JD061SGB -p $PTOS \ 

 -o $load 
rc2=$? 
if [[ $os = HP-UX ]] ; then 
LD_ORACLE_OPT=" -L "$ORACLE_HOME/lib" -lclntsh -l:libcma.sl -ldld" 
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else 
LD_ORACLE_OPT=" -L "$ORACLE_HOME/lib" -lclntsh " 
fi 
####################### 
## for ORACLE 8 only ## 
####################### 
if [[ -f $ORACLE_HOME/orainst/inspdver ]] ; then 
save_ldoracleoptions=$ldoracleoptions 
fi 
ldoracleoptions=`echo $LD_ORACLE_OPT  | sed 's/\//\\\\\//g'` 
####################### 
## for ORACLE 8 only ## 
####################### 
if [[ $os != HP-UX ]] ; then 
if [[ -f $ORACLE_HOME/orainst/inspdver ]] ; then 
ldoracleoptions=$save_ldoracleoptions" "$ldoracleoptions 
fi 
fi 

sed "1,\$s/libgeo.a/libgeo.a $ldoracleoptions /" < \ 
./JD061SGB.ed > ./JD061SGB.ksh 
chmod +x ./JD061SGB.ksh 
rm -f ./JD061SGB.lk >/dev/null 
rm -f $load > /dev/null 2>&1 
./JD061SGB.ksh 
rc3=$? 
rc=`expr $rc1 + $rc2 + $rc3` 
fi 

exit $rc 

{ Go on with the installation.  

2. Another problem occurs when performing a from-scratch installation of VPM 1.5 PTF 15 on SUN systems only and using a DB2 
database only. 
The installation process exits VPMDataManager prematurely but all the operations linked to VPMDataManager are correctly 
performed and VPM can then work normally. 
The bypass is to export the following environment variable VPM_DB2_SQLCOLUMNS_NO=1  

Neither of these problems occurs when installing PTF15 as an upgrade on an existing installation, as long as existing connection modules 
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remain unchanged and are not rebuilt. 

 

Recommended Interoperability PTFs 

CATIA 424-1  

The following PTFs are mandatory:  

The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFs associated with commonly used functions such as SOLIDE:  

APAR (AIX) Description
HC66598 Tools->Open Editor: If the editor window size is increased no text can be written.

HC84902 The File=>Save command in CATIA updates frozen Parts.

HC86590 The Identify Loaded Models results are partial in the PSN.

HC86219 There is no way to redirect the /tmp.

HC88222 There is a problem with a New Version function in DB2.

HC89786 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 
segmentation fault. DBLDRW entry issued.

HC91642 A twin model cannot be opened in CATIA V4 after a new version.

HC99292 Synchronization of VPM and CATIA for the declaration parameter 
catcdm.DBLFAIX_ALGO

HC98768 VPM interoperability: File->Save cannot be performed on a model after an abend then a 
warm start in CATIA.

HC99343 Synchronization of CATIA and VPM for the declaration parameter 
catcdma.STORAGE.LF_METADATA: Parameter deleted

HD01297 VPM interoperability: A File->Save cannot be performed on a model with the DBLFCAT 
access method.
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APAR (AIX) Function Description
HC87971 4DNAV The 4DNav tesselation batch failed with a VPM database.

HC95918 4DNAV Models do not move properly.

HC98650 4DNAV The MfgProg function does not work for models opened from VPM.

HD01228 4DNAV A VRML document cannot be opened with 4DNav from the PSN.

HC83996 AUXVIEW2 Error 744 when reading a dr model from the PSN graph.

HC89308 CATMFG There is a core dump when loading the model with an MML on the 
manufacturing type.

HD00127 CDM CDM interoperability: UB98558 breaks DATABASE + WRITE + EXT_OBJ

HC85180 CSB Some volumes in the tree are wrongly propagated.

HC85372 CSB There is a problem with the catcsbad.

HC87890 CSB + 
SAVE

No trace file is generated in the QP035AMP output + DMUSLF problem

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models.

HC91298 CSB Box zoning does not work Project-comprehensive

HC92275 CSB The QP035AMP process is triggered when saving a model on HP.

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM.

HC85860 DATABASE The cgr stored in datalinks is not updated after the V4 model is modified.

HC92618 E3D E3D CDMA Parts cannot be accessed if the VPM (or CDM) environment 
exceeds five characters.

HC86788 FD&T Chamfer FD&T dimensioning is split into two when in the VPM assembly 
context.

HC87759 FD&T There is a performance problem loading the FD&T function on an assembly 
coming from VPM.

HC89159 FD&T When you version a Part, the tolerances are not updated.

HC83200 MML MML type model to model => entity to entity migration: Action required.

HC82890 OPEN There is a warning when opening a model.

HC90047 OPEN An abend occurs when opening a V5 model in V4.
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CATIA 424-2  

The following PTFs are mandatory:  

HC84035 SAVE It is impossible to manage document revision using DMUSLF.

HC85938 SAVE A model cannot be stored using DBLFCAT.

HC85967 SAVE A model cannot be stored using DBLFCAT.

HC87012 SAVE When executing the File->Save command, VPM cannot be found to save a 
model. 
An error occurred in the Japanese environment.

HC87890 CSB + 
SAVE

No trace file is generated in the QP035AMP output + DMUSLF problem

HC90206 SAVE A DMUSLF user exit does not reference the type of model created.

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.

HC91658 SAVE Backup management for saved versions of CATIA models.

HC91751 SAVE Save All with VPM and CATIA model

HD02268 SAVE VPM interoperability: There is an SQLERROR -407 when a model is saved 
using VPM after an update version.

HC82087 SKIN Some errors are detected by the cleaner if the GSM model is loaded from 
VPMA and CATIA results in an abend at save.

HC81501 SOLIDE The MML_SOL link is desynchronized after a save.

HC89303 SOLIDE There is a core dump with a union on two empty spacemaps.

APAR (AIX) Description
HC89786 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 

segmentation fault. DBLDRW entry issued. 

HC91641 Standard DS traces cause problems. The delivery for UB97943, UB97941, UB97942, 
UB97944 is incomplete.

HC99292 Synchronization of VPM and CATIA for the declaration parameter 
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The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFs associated with commonly used functions such as SOLIDE:  

catcdm.DBLFAIX_ALGO

HC98768 VPM interoperability: File->Save cannot be performed on a model after an abend then a 
warm start in CATIA.

HC99343 Synchronization of CATIA and VPM for the declaration parameter 
catcdma.STORAGE.LF_METADATA: Parameter deleted

HD01297 VPM interoperability: A File->Save cannot be performed on a model with the DBLFCAT 
access method.

APAR (AIX) Function Description
HC92706 4DNAV After closing a 4DNav session started from VPM, it cannot be restarted. 

HC95918 4DNAV Models do not move correctly. 

HC89308 CATMFG There is a core dump when loading the model with a MML on the manufacturing 
type. 

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models. 

HC89303 CSB There is a core dump with a union on two empty spacemaps. 

HC91298 CSB Box zoning does not work Project-comprehensive 

HC92046 CSB VPM/CATIA lock in the spacemap. 

HC92275 CSB The QP035AMP process is triggered when saving a model on HP. 

HC93336 CSB VPM/CATIA lock in the spacemap (part 2). 

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM. 

HC97314 CSB The spacemap filter does not work properly with a model. 

HC98203 CSB Modification on CSB volume algorithm 

HC90454 MML Change UUID also keeps the link to the original version of the model. 

HD05658 MODEL The cgr files stored by means of the DBLFAIX method are not put under datalink 
control.
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Cumulative Fixes PTF15 

HD05085 MODELS On an HP UNIX station, MODELS/MODIFY/REPLACE/TRANSLATE cannot be 
done on a CATPart.

HC90047 OPEN An abend occurs when opening a V5 model in V4. 

HC95245 OPEN V5->V4 interoperability: V4 delivery for compatibility with V5 command Send To  

HC90206 SAVE A DMUSLF user exit does not reference the type of model created. 

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM. 

HC91658 SAVE Backup management for saved versions of CATIA models. 

HC91751 SAVE Save All with VPM and CATIA model 

HD02268 SAVE VPM interoperability: There is an SQLERROR -407 when a model is saved 
using VPM after an update version.

HD03461 OPEN VPM interoperability: Problem loading V4 model save with DBLFAIX

OS UH OS UH OS UH OS UH

IX

UH03034 
UH03062 
UH03056 
UH03049 
UH03036 
UH03066 
UH03060 
UH03052 
UH03058 
UH03029 
UH03057 
UH03059 
UH03045

HP

UH03021 
UH03022 
UH03048 
UH03051 
UH03043 
UH03025 
UH03055 
UH03069 
UH03063 
UH03061 
UH03024 
UH03026 
UH03047

SG

UH03030 
UH03041 
UH03046 
UH03037 
UH03068 
UH03035 
UH03042 
UH03070 
UH03033 
UH03023 
UH03065 
UH03038 
UH03064

SU

UH03054 
UH03039 
UH03040 
UH03044 
UH03027 
UH03053 
UH03020 
UH03067 
UH03050 
UH03028 
UH03031 
UH03032
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Free Text PTF15 

Admin z HD02287: Tools + new version for assembly Parts is unstable.  

BOM z HD04478: Print Part List and 3rd button  
z HD04590: Models are no longer highlighted in a saved PSN graph.  
z HD04966: There are problems with N4D and Identify Load Models.  
z HD05774: Deleting then writing the same CATPart into VPM (associating a new 

document) using the DBLFAIX method results in an error. INFO_LF  
z HD04146: When a Part addition is followed by a move the Add is lost in the 

action.  
z HD05578: The Launch viewer option is inoperative with the Load Graph 

Session function.  

CATCDMA z HD05651: The cgr files stored by means of the DBLFAIX method are not put 
under datalink control.  

CFG z HD05550: CFG-AFL: The effectivity is not valid after a cut.  

Install z HD03783: The DB2 instance password is stored in a non-secured file.  

ITVPMCV z HD05639: VPM crashes after a save and modified positions in a mixed V4/V5 
Product Structure. An automatic commit activated.  

z HD05632: VPM interoperability: VPM crashes on instantiation of V4 models in a 
mixed structure.  

z HD05321: VPM interoperability: Impacts are KO in the PSN after versioning a 
published Part with the cache ON.  

z HD01855: VPM interoperability: VPM loops after loading a document from 
VPMA if a structure loaded from PSN is not completely loaded in CATIA.  

z HD05996: VPM interoperability: VPM crashes after identify from CV5.  
z HD04911: VPM must convert a UID to uppercase for user exits.  

P&O z HD02907: VPMPeopleEdit does not support Chinese.  

PSN z HD04250: VPM crashes when objects are selected for more than 50 levels.  
z HD05546: The declaration setting catcdma.SELOBJ_STORE_STATE=TRUE 
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PTF16 Update 
REMEMBER to rebuild the user exits!  

A user exit sample resides under $VPM/code/sample.  

 

WARNING! 
Do not, under any circumstances, put any customized library fixes or development modules into your VPM STEPLIB directory (usually 
$CAT_CUST/code/steplib/$OS) unless expressly requested to do so in the official documentation or by the VPM maintenance or 
development team. This is because the directory is shared with CATIA V4 and interaction between VPM and CATIA V4 may therefore be 
unpredictable. 

 

Migrating from a Previous Level 

 

Migrating to PTF16 

z Modify line 1402 of the shell $CAT_CUST/code/bin/Migrate_Prepare_files_Oracle.sh by adding, at the end of the file: 

$TBS_PUBSUB $TBS_INDEX 

z Modify line 1301 of the shell $CAT_CUST/code/bin/Migrate_Prepare_files_DB2.sh by adding, at the end of the file: 

froze VPM.  
z HD05573: When using Open a Graph Session with Query All Environments the 

associated representations are not selected.  
z HD05253: VPM crashes when the overview is used in the PSN.  
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$TBS_PUBSUB $TBS_PUBSUB  

 

Oracle and DB2 Replication Tools 

 

Publish/Subscribe 

Database Structure Modification 

In order to correct a defect concerning the publication of events via implicit subscriptions (see APAR HC90759), the structure of one of the 
Publish/Subscribe database tables must be modified.  

This modification is mandatory as of VPM 1.5 PTF16 when upgrading from earlier releases. It is done by means of the dll scripts 
update10_PUBSUB.clp and update10_PUBSUB.sql which can be executed via the post-install shell VPMPostInstall.sh. 

Important! See Data Migration below for information regarding the execution of the script update10_PUBSUB.sql. 

Security 

General Database Performance 

In order to improve database performance when making queries on role and privilege tables (which is typically done by VPM during the 
login when all the security attached to the user is loaded in memory), several indexes have been added to these tables for key search 
attributes. 
This update may be particularly useful for a database containing a lot of role and/or privilege objects, although it may impact 
administration tasks (slower insertions).  

This modification is optional. It is achieved by the dll scripts update3_PEOPLE.clp and update5_SECURITY.clp when using DB2, or 
update3_PEOPLE.sql and update5_SECURITY.sql when using Oracle, which can all be executed via the post-install shell 
VPMPostInstall.sh. 
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Data Migration 

Publish/Subscribe 

When migrating an existing VPM installation to VPM 1.5 PTF16, the scripts update10_PUBSUB.clp and update10_PUBSUB.sql may be 
processed correctly by the post-install utility, which generates an error during its execution by DB2 or Oracle. 

There are two ways of solving this problem:  

1. Modify the migration shell Migrate_Prepare_files_DB2.sh, by replacing line 1301: 

custom_scripts_files $scriptfile 

with: 

custom_scripts_files $scriptfile $TBS_PUBSUB \ 
$TBS_PUBSUB 

and Migrate_Prepare_files_Oracle.sh by replacing line 1402: 

custom_scripts_files $scriptfile 

with: 

custom_scripts_files $scriptfile $TBS_PUBSUB \ 
$TBS_INDEX 

2. Modify the script update10_PUBSUB.sql once it is processed, by replacing the command: 

create unique index "OWNER"."PUBLISHED_EVENT_I1" \ 
on "OWNER"."PUBLISHED_EVENTS" 
(PUBLISHER_OID , 
EVENT_OID , 
PUBLISHER_ITEM) tablespace ; 
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with: 

create unique index "OWNER"."PUBLISHED_EVENT_I1" \ 
on "OWNER"."PUBLISHED_EVENTS" 
(PUBLISHER_OID , 
EVENT_OID , 
PUBLISHER_ITEM) tablespace INDEX; 

OWNER and INDEX being the actual database owner and index tablespace, as specified during the install.  

 

Recommended Interoperability PTFs 

CATIA 424-1  

The following PTFs are mandatory:  

APAR (AIX) Description
HC66598 Tools->Open Editor: If the editor window size is increased no text can be written.

HC84902 The File=>Save command in CATIA updates frozen Parts.

HC86590 The Identify Loaded Models results are partial in the PSN.

HC86219 There is no way to redirect the /tmp.

HC88222 There is a problem with a New Version function in DB2.

HC89786 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 
segmentation fault. DBLDRW entry issued.

HC91642 A twin model cannot be opened in CATIA V4 after a new version.

HC99292 Synchronization of VPM and CATIA for the declaration parameter 
catcdm.DBLFAIX_ALGO

HC98768 VPM interoperability: File->Save cannot be performed on a model after an abend then a 
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The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFs associated with commonly used functions such as SOLIDE:  

warm start in CATIA.

HC99343 Synchronization of CATIA and VPM for the declaration parameter 
catcdma.STORAGE.LF_METADATA: Parameter deleted

HD01297 VPM interoperability: A File->Save cannot be performed on a model with the DBLFCAT 
access method.

APAR (AIX) Function Description
HC87971 4DNAV The 4DNav tesselation batch failed with a VPM database.

HC95918 4DNAV Models do not move properly.

HC98650 4DNAV The MfgProg function does not work for models opened from VPM.

HD01228 4DNAV A VRML document cannot be opened with 4DNav from the PSN.

HC83996 AUXVIEW2 Error 744 when reading a dr model from the PSN graph.

HC89308 CATMFG There is a core dump when loading the model with an MML on the 
manufacturing type.

HD00127 CDM CDM interoperability: UB98558 breaks DATABASE + WRITE + EXT_OBJ

HC85180 CSB Some volumes in the tree are wrongly propagated.

HC85372 CSB There is a problem with the catcsbad.

HC87890 CSB + 
SAVE

No trace file is generated in the QP035AMP output + DMUSLF problem

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models.

HC91298 CSB Box zoning does not work Project-comprehensive

HC92275 CSB The QP035AMP process is triggered when saving a model on HP.

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM.

HC85860 DATABASE The cgr stored in datalinks is not updated after the V4 model is modified.

HC92618 E3D E3D CDMA Parts cannot be accessed if the VPM (or CDM) environment 
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CATIA 424-2  

exceeds five characters.

HC86788 FD&T Chamfer FD&T dimensioning is split into two when in the VPM assembly 
context.

HC87759 FD&T There is a performance problem loading the FD&T function on an assembly 
coming from VPM.

HC89159 FD&T When you version a Part, the tolerances are not updated.

HC83200 MML MML type model to model => entity to entity migration: Action required.

HC82890 OPEN There is a warning when opening a model.

HC90047 OPEN An abend occurs when opening a V5 model in V4.

HC84035 SAVE It is impossible to manage document revision using DMUSLF.

HC85938 SAVE A model cannot be stored using DBLFCAT.

HC85967 SAVE A model cannot be stored using DBLFCAT.

HC87012 SAVE When executing the File->Save command, VPM cannot be found to save a 
model. 
An error occurred in the Japanese environment.

HC87890 CSB + 
SAVE

No trace file is generated in the QP035AMP output + DMUSLF problem

HC90206 SAVE A DMUSLF user exit does not reference the type of model created.

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM.

HC91658 SAVE Backup management for saved versions of CATIA models.

HC91751 SAVE Save All with VPM and CATIA model

HD02268 SAVE VPM interoperability: There is an SQLERROR -407 when a model is saved 
using VPM after an update version.

HC82087 SKIN Some errors are detected by the cleaner if the GSM model is loaded from 
VPMA and CATIA results in an abend at save.

HC81501 SOLIDE The MML_SOL link is desynchronized after a save.

HC89303 SOLIDE There is a core dump with a union on two empty spacemaps.
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The following PTFs are mandatory:  

The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFs associated with commonly used functions such as SOLIDE:  

APAR (AIX) Description
HC89786 Standard DS traces cause problems in VPM 1.5 PTF3. Vpmmdlbatch.sh 26295 

segmentation fault. DBLDRW entry issued. 

HC91641 Standard DS traces cause problems. The delivery for UB97943, UB97941, UB97942, 
UB97944 is incomplete.

HC99292 Synchronization of VPM and CATIA for the declaration parameter 
catcdm.DBLFAIX_ALGO

HC98768 VPM interoperability: File->Save cannot be performed on a model after an abend then a 
warm start in CATIA.

HC99343 Synchronization of CATIA and VPM for the declaration parameter 
catcdma.STORAGE.LF_METADATA: Parameter deleted

HD01297 VPM interoperability: A File->Save cannot be performed on a model with the DBLFCAT 
access method.

APAR (AIX) Function Description
HC92706 4DNAV After closing a 4DNav session started from VPM, it cannot be restarted. 

HC95918 4DNAV Models do not move correctly. 

HC89308 CATMFG There is a core dump when loading the model with a MML on the manufacturing 
type. 

HC89043 CSB There is a QP035AMP crash when a file contains more than 1000 models. 

HC89303 CSB There is a core dump with a union on two empty spacemaps. 

HC91298 CSB Box zoning does not work Project-comprehensive 

HC92046 CSB VPM/CATIA lock in the spacemap. 

HC92275 CSB The QP035AMP process is triggered when saving a model on HP. 
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CATIA 424-3  

The following PTFs are optional and should only be installed if you use the function involved. However, you are strongly advised to install 
the PTFs associated with commonly used functions such as SOLIDE:  

HC93336 CSB VPM/CATIA lock in the spacemap (part 2). 

HC93487 CSB A model with a voxel size of 5mm cannot be stored in VPM. 

HC97314 CSB The spacemap filter does not work properly with a model. 

HC98203 CSB Modification on CSB volume algorithm 

HC90454 MML Change UUID also keeps the link to the original version of the model. 

HD05658 MODEL The cgr files stored by means of the DBLFAIX method are not put under datalink 
control.

HD05081 MODELS MODELS/MODIFY/REPLACE/TRANSLATE cannot be done on a CATPart on 
an HP UNIX station.

HD05085 MODELS On an HP UNIX station, MODELS/MODIFY/REPLACE/TRANSLATE cannot be 
done on a CATPart.

HC90047 OPEN An abend occurs when opening a V5 model in V4.

HC95245 OPEN V5->V4 interoperability: V4 delivery for compatibility with V5 command Send To  

HD03461 OPEN VPM interoperability: Problem loading V4 model save with DBLFAIX

HD06786 OPEN The geometry of a specific CATPart is not displayed when trying to open it with 
the CATPart file format.

HC90206 SAVE A DMUSLF user exit does not reference the type of model created. 

HC90465 SAVE There is a CATIA abend S11 when using the DBLFAIX repository type in VPM. 

HC91658 SAVE Backup management for saved versions of CATIA models. 

HC91751 SAVE Save All with VPM and CATIA model 

HD02268 SAVE VPM interoperability: There is an SQLERROR -407 when a model is saved 
using VPM after an update version.

HD06829 SOLIDE An abend S0006 occurs in SOLIDE CREATE IMPORT on a V5 passive 
CATPart. 
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Cumulative Fixes PTF16 

 

Free Text PTF16 

APAR (AIX) Function Description
HD06829 SOLIDE An abend S0006 occurs in SOLIDE CREATE IMPORT on a V5 passive 

CATPart.

OS UH OS UH OS UH OS UH

IX
UH03342 
UH03343 
UH03341

HP
UH03344 
UH03339 
UH03336

SG
UH03347 
UH03345 
UH03346

SU
UH03337 
UH03340 
UH03338

Action z HD07112: The Action Validate function does not carry over options from the old 
link.  

z HD07249: Edit Configuration and Select Config Handler cause an abend in 
VPM1.5 PTF13.  

z HD05411: The Action Validate function is unstable.  

Admin z HD06763: Many header files are missing in /vpm/PublicInterface.  
z HD06882: There is an abend after calling a external routine from the 

VPMA/Document window. VPM ends with RC -> 139.  

AFL z HD06428: CATVpmAFUsrMethod::CheckUsrCondition is no longer called.  
z HD05966: There are available fields in Object->ACTION.  

BOM z HD01822: Segmentation fault (core dump) occurs when DBCS (Japanese) 
name Part as subscribe with mail is promoted.  

z HD02337: File / Settings / Display Character in trace levels are garbage.  
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z HD04780: An abend S0011 occurs during Open Graph Session.  
z HD06381: 3d com bypass customized security defined in the 

BOM_USER_EXIT  
z HD05442: A rename in the PSN window on a Part does not result in a published 

event.  
z HD02538: Opening a graph session in static mode is different from the PSN 

that has been saved.  
z HD06615: The behavior of the Open Graph Session function in static mode is 

abnormal on HP.  
z HD05890: VPMIDMU: In the PSN, on multiselection of a large number of 

documents containing Alternate Shape, the Open Alternate Shape panel is not 
displayed.  

z HC90759: The behavior of the Publish/Subscribe module in VPM1.5.0 is 
strange.  

z HD06377: Checking out a model freezes VPM.  

CFG z HD06464: There is an abend in VPM when the PSN is  expanded with a default 
configuration handler applied.  

CSB z HD06151: The volume filter using combined spacemaps is in error.  

ITVPMCV z HD06881: VPM crashes with a forced Extract Save if the user does not heed 
the warning message.  

z HD07079: The VPM message after Extract Save is not precise.  
z HD06666: A save from CATIA expands all nodes in VPM.  

PSN z HD05787: The PSN commit report is not managed correctly.  
z HD05806: When an Identify Model is done in CATIA, VPM crashes.  
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